Hotel Smart TV Solution

K SINC Server
User Guide

LYNK SINC Server is a web-based solution designed to construct widgets installed on TVs in hotel rooms. LYNK
SINC Server allows you to manage TVs conveniently. Remotely control the power supply, send messages, or update
firmware.
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Before getting started

Rules used in this user guide

Functions are described according to the following rules in this user guide.

Program and device names

Program and device names are written as follows in this user guide.
m LYNKSINC Server - LSS
m Hotel Smart TV — TV

Running a menu

m |nstructions on how to run a menu is as follows:
Select Network > Network Settings from the displayed network settings menu.
— You should select Network, and then select Network Settings.

m The information on how to run menus provided by the operating system such as those in Control Panel is for Microsoft
Windows 7.

Key terms used in LSS

LSS is a web-based solution designed to configure TV widgets.

Widgets on TVs in hotel rooms can provide guests with easy access to a range of information and applications. A widget appears
after a TV turns on. Widgets allow guests to watch TV, search hotel information and use TV applications. Widget format and
information provided in a widget can be customized according to the guest type.

LSS allows you to conveniently manage TVs. Manage TV channels, remotely control the power supply, or update firmware.

This section provides definitions of key terms when using LSS. Familiarize yourself with frequently used terms and definitions.
This will allow you to take advantage of the many useful functions in LSS.



= Widget: Refers to an application that allows a user to conveniently access a range of functions and information on a device.
TV widgets provide various information, including hotel facilities and neighborhood information, in the form of menus.

m  Project: Refers to a group of pages that construct a TV widget. A project consists of a main page and several menu pages.
m  Main page: Refers to a page that appears by default after a widget runs.

m  Menu page: Refers to a page that contains various information (menus) provided in a widget. A menu page can be accessed
by selecting a menu from the main page.

m Template: Refers to a pattern where the arrangement of menu sections and layout (text, image and video) sections is
predefined. Configure menu page settings using a variety of templates provided in LSS.

m  |ayout: Refers to a pattern, which is a component of a template, where the arrangement of image, video and text sections is
defined.

Note

For details on pages and components of a project, refer to the following:  » Project settings
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Main functions

Customizable TV widget configuration

m Arrange menus and pages in a widget as desired.

m Text, image, video and audio sources can be used to construct menus and pages in a widget.
m Resize and rearrange text boxes, images or video screens.

Remote TV management

m Send messages such as welcome messages and notices to TVs.

m  Remotely control the power supply to (turn on/off) TVs.

Managing IPTV channel groups

m (Create and distribute IPTV channel groups to TVs.

Grouped TV management depending on the occasion

= Conveniently manage TVs by grouping TVs to distribute a project to.

= Conveniently manage TVs by grouping TVs by task, such as sending a message or a firmware upgrade.
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Installation requirements

Operating system

m  Microsoft Windows 2008 Server (x86, x64)

m  Microsoft Windows 2012 Server (x64)

Note

+ The program can be installed on Windows 7 if it is used as a trial for small deployments.

« To use Microsoft Windows 2012 Server offline, you must enable .NET Framework 3.5 manually before installing LSS. For further information, refer
to the following: B Configuring the settings for NET Framework 3.5

Web browser

m  Chrome Browser

Network

m  Wired network

Port numbers

= TCP 80, 443, 444, 30000~30005
= UDP 30000~30005

Note

Keep the above ports open to ensure communication between the TV and LSS.
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Software

m Microsoft Visual C++ 2010 Redistributable Package (x86)

Note

To use LSS, make sure to install Microsoft Visual C++ 2010 Redistributable Package (x86). For further details on installation, refer to the
following: B> Installing Microsoft Visual C++ 2010 Redistributable Package (x86)

Development language

m PHP (Hypertext Preprocessor) 5

Web server

m Apache 2.2.x

Database

= CUBRID 9.2

Framework

= Codelgniter 1.7.2




Software installation

{7 Hotel Smart TV Solution LYNK SINC Server Setup

Welcome to the Hotel Smart TV Run the LSS install file.

Solution LYNK SINC Server Setup

This wizard will guide you through the installation of Hotel Read the InSta ” inStruCtlonS thOl‘Oug h |y, and C“Ck Next.
Smart TV Solution LYNK SINC Server.

Itis recommended that you dose al other applications
before starting Setup. This will make it possible to update
relevant system files without having to reboot your
computer.

Click Next to continue,

(& Hotel Smart TV Solution LYNK SINC Server Setup = X
License Agreement . . .
Bl v e erse s e e o st Ty s () Read the license agreement thoroughly, and click ACCEPT if you agree.

Press Page Down to see the rest of the agreement.

License Agreement for Software -

IMPORTANT. READ CAREFULLY: This License Agreement
("Agreement") is a legal agreement between you (either an indiidual or a
single entity) and Samsung Electronics Co., Ltd. for software owned by
Samsung Electronics Co., Ltd., which includes computer software and
may include associated media, printed materials, "online” or electronic
documentation ("Software”). BY CLICKING THE “ACCEPT  BUTTON
BELOW (OR IF YOU BY PASS OR OTHERWISE DISABLE THE -

If you accept the terms of the agreement, dick 1 Agree to continue. You must accept the
agreement to install Hotel Smart TV Solution LYNK SINC Server.

<_Back ‘[ ACCEPT ] ‘ DECLINE

(3 Hotel Smart TV Solution LYNK SINC Server Setup

LYNK SINC Server Install option

1£you wont o et he NG SN it e, st samaung SN < () Select a program type to install and click Next.

License]. If you just want to install Samsung Licensing kit, select (Samsung License].

@ [Samsung LYNK SINC +License]

[Samsung License]

<Back J[_next | [ oEcne




.
{3 Hotel Smart TV Solution LYNK SINC Server Setup =R

Select IP Configuration

Please select the IP address on which you want to configure server.

SelectIP Address: | 10,10,10,143 -

Select Protocol: @ HTTP © HTTPS
[ Domain Configuration

SINC domain name : | SInC .s-hospitalitysolution.net 80

Copyright: 2014(c) Samsung electronics co.Ltd, Allrights reserved,

<Back | Net | [ cECLNE

4 Select HTTP or HTTPS for the protocol, enter a domain name and port
information, and click Next.

Note

If you have enabled Domain Configuration, make sure to configure the DNS settings to
access the specified LYNK SINC URL.

.
(7 Hotel Smart TV Solution LYNK SINC Server Setup ==

Country Select option
Select your Location/Country from the drop down menu

Africa/Cairo - (UTC+02:00) ~
Affica/Casablanca - (UTC+00:00) F|
Africa/Harare - (UTC+02:00)

Africa/Johannesburg - (UTC+02:00)

Affica/Lagos - (UTC+01:00)

Africa/Morrovia - (UTC+00:00)

Affica/Nairobi - (UTC+03:00)

America/Argentina/Buenos_Aires - (UTC-03:00)

America/Bogota - (UTC-05:00)

America/Caracas - (UTC-04:30)
America/Chihuahua - (UTC-07:00)
America/Godthab - (UTC-03:00)

Americajla_Paz - (UTC-04:00)

Americajlima - (UTC-05:00)

America/Los_Angeles - (UTC-08:00)

America/Managus - (UTC-06:00) o

Copyright: 2014(c) Samsung electronics co.Ltd, Allrights reserved,

5 Select a city and time zone, then click Next.

Setup wil install Hotel Smart TV Solution LYNK SINC Server in the following folder. To install in
adifferent folder, dick Browse and select another folder. Click Install to start the installation.

Destination Folder

C: #totelTV] Browse...

Space required: 188.5MB
Space available: 33.4G8

Copyright 2013(c) Samsung electronics co.Ltd, Allrights reserved,

<Peck | mstal | [ DEQLNE

Next DECLINE
L )
- 3
(i Hotel Smart TV Solution LYNK SINC Server Setup | =
Choose Install Location . . .
Choose the folder in which to instal Hotel Smart TV Solution LYNK SINC Server, 3 6 Speclfy the install path, and click Install.

- ‘
CUBRID - InstalShield Wizard (===

CUBRID 9.2 for Windows

This wizard will help vou install CUBRID an wour system,
Remember that the database volumes created by previous
wersions of CUBRID are incompatible with CUBRID 9.2 If
you want to use CUBRID 5.2, migrate your data from
previous version

7 Read the CUBRID install instructions thoroughly, and click Next.

Note

CUBRID is an open source database management system (DBMS) developed by CUBRID.
CUBRID, which is required to use LSS, will also be installed.
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r
‘CUBRID - InstallShield Wizard ‘

:- §  Specify the CUBRID install path, and click Next.

Please enter a destination directory ta install CUBRID

J

< Back Next > Cancel

= J

‘CUBRID - InstallShield Wizard N ﬁ

. ( - 0 Read the CUBRID license agreement thoroughly, and select | accept the

T . terms of the license agreement if you agree. Click Next.
guryught [C] 2008-2013 Search Solution Corparation. All rights reserved by Search [
olution,

CUBRID is registered tademark of Search Solution Corporation.

CUBRID is licersed under the GNU GPL v2 or higher or BSD License according to it
respective components. For mare information, please refer to the CUBRID Web site
(hittp:# P, cubrid, org),

@) | accept the terms of the license agreement

(21 do not accept the terms of the license agieement

< Back I Mest > I Cancel

oD et e i - 10 Select Complete from the CUBRID install type, and click Next.

Choose a Setup Type.

Dessiiption
Instals Interface Diivers Instals CUBRID server. Command
line teols and Interface
diivers(OLE DE Frovider, ODBL,
JDEC, CAR)

< Back Mext > Cancel

| G i i ‘

Since CUBKID broker and server versions should mtch, please make sure that 11 Read compatibility information for CUBRID, and click Yes to continue.
you are running the same version if you operate them in separate machines.
Fer installation of CUBRID tecls like Query Browser, Manager and Web
Manager, please refer to http://www.cubrid.org/wiki_tools.

Do you want to continue?

- —
CUBRID - InstaliShield \Mzani‘

o s R 22 ( - 12 Click Next to start CUBRID installation.

Sefup has enough information to start copying the program files. If you want to reviews o
change any settings. click Back. If you are satisfied vith the seftings. click Next to begin
copying files.

Cunent Settings:

Destination Directory : CACUBRID\ =
Setup Type : CUBRID Server Components and Client Components

<Back [ Neds> | [ Cancel




Creating the sample database.

Do you want to create a sample 'demodb’ database?

- -

13 Click Yes to create a sample database.

CUBRID - InstallShield Wizard

InstallShield Wizard Complete

The InstallShield Wizard has successfully installed CUBRID
Click Firish to exit the wizard

<Back ]

14 Click Finish when the window appears confirming that the CUBRID
installation is complete.

Completing the Hotel Smart TV
Solution LYNK SINC Server Setup

Hotel Smart TV Solution LYNK SINC Server has been installed
on your computer.

Click Finish to dose this wizard,

@ Note

o lg\@hﬂiﬁl
6 cUBRID - 53011 o g - .
F— 15 When the CUBRID website page appears, close the page.
@ Hotel Smart TV Solution LYNK SINC Server Setup = . S

16 When LSS installation is complete, click Finish.

- Ifinstallation is complete, the LSS webpage will automatically appear.

To uninstall the program, go to Start > All Programs > Hotel Smart TV LYNK SINC > Uninstall.
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Installing Microsoft Visual C++ 2010 Redistributable Package (x86)

=it

Download Center

:”“_ S 1 Launch a web browser and go to the page (http://www.microsoft.com/
download/en/details.aspx?id=5555) to download the install file.

| . o

Click Download from the displayed page.

®
Microsoft recommends . . .
) Ifa prompt appears asking whether you want to install additional software
i Iiomiv— . ° or functions, click No thanks and continue.
a .. Kinect for Windows SDK v1.0 6]

deces.

Size: 2268 M.

B8 Microsoft

Download Center ] 3 Awindow will appear at the bottom of the web browser page asking if you
e S sem g want to install Microsoft Visual C++ 2010 Redistributable Package (x86).
mE Click Run.

1l Thank you for downloading

Microsoft Visual C++ 2010 Redistributable Package (x86)

If your download does not start after 30 seconds, Click here

(@ mstall Instructions

x

@ Ty ot coud harm yourcompute. [on ]| _sme |7 )

[ #, Microsoft Visual C+= 2010 86 Redistributable Setup A BRI
N e st e s o e o) 4 Read the terms and conditions thoroughly, and click the checkbox for I have

read and accept the license terms if you agree. Click Install.

MICROSOFT SOFTWARE LICENSE TERMS Ij
MICROSOFT VISUAL C++ 2010 RUNTIME LIBRARIES <
[7] I have read and accept the license terms.

Yes, send information about my setup experiences to Microsoft Corporation

For more information, read the Data Collection Policy.

-
#, Microzott Visual C-+ 2010 186 Redistributable Setup e

5 Click Finish when the window appears confirming that the installation is
complete.

Installation Is Complete

Microsoft Visual C++ 2010 x86 has been
. installed.

You can chedk for more recent versions of this package on
the Microsoft Visual Studic website.




To use the Microsoft Windows 2012 Server operating system when the Internet is not connected, you must enable .NET
Framework 3.5 manually before installing LSS.

On the Windows 2012 Server computer, click the Start button. Next, enter cmd in the run window at the bottom of the Start
menu, then press Enter on the keyboard.

Enter the following command in the command prompt window.

DISM /online /enable-feature /featurename:NetFX3 /all /Source:boot file path

B Administrator: Command Prompt - |0 s

i Ft Windows [Uersion 6.2.920@1
3 2012 Microsoft Corporation. All rights reserved.

tor>DISM sonline /enable-feature featurename:NetFX3 ~all /8o

Note

Ensure that a Windows boot file exists in the boot file path you entered.

After the command is running, install LSS.

o] Administrator: Command Prompt =0 s
icrosoft Windo Wersion 6.2.9200]
(c)> 2812 Mice t Corporation. All rights reserved.

rator>DISH sonline ~senahle-feature sfeaturename:NetFX3 sall /8o
ources\sxs

ment Image Servicing and Management tool
n: 6.2.9200.16384

i
operation completed successfully.

sislUsershAdninistrator)




Post-installation checklist

Launch a web browser, go to the LSS webpage, and check that the login page appears properly.

Note
The login page access address depends on the protocol selected when the software was installed.
« IfHTTP is selected: http://localhost/

If HTTPS is selected: https://sinc.s-hospitalitysolution.net:444

Samsung LYNK SINC

Check to make sure that you can log in properly.

7
Note
The super administrator account is registered in the program by default. Log in using the following super administrator account information.
+ ID:admin

Password: admin123
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Changing a password

1 Ifyoulog in for the first time after LSS is installed, a message appears advising you to change the password. Click OK.

Message from weh_

If this is your first time logging in Hotel LYMK SINC, please change your
password,

I

) Change the password.

Note

+Make sure to change the default password (admin123) which has been set for privacy during installation.

- For further details on how to change a password, refer to the following: > Editing my account info.

Activating the product license

When you run LSS for the first after install, you must perform the license activation process. For further details on registering a
license, refer to the following: B License management
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. AboutLSS

Launch a web browser, and go to the LSS webpage. The login page will appear.

Note
To access LSS from a computer where LSS is not installed, enter the IP address (http: / /LSS IP) for the computer where LSS is installed in the web

browser address bar.

User types

LSS users are classified as super administrators and general administrators. Super administrators and general administrators are
assigned different privileges for menus and functions. General administrators need approval from a super administrator to log in

to LSS.

Note

+ The super administrator privileges are only given to the admin account, which is registered by default when LSS is installed.

For details on privileges for administrators, refer to the following: ~ » Administrator menu
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Registering a general administrator

1 Click Sign Up on the login page.

) Enter the required account information in the displayed account registration page.

— Fields with * cannot be left blank.

Create User Account

- - | |

e Re-enter Password % ‘ |

0 Mobile Number ‘ |
0 Telephane Number ‘ |
Q- - | |
O ovener | |
O e | |
(10 JER

Enter a user ID.

0 Note

Enter 6-12 alphanumeric characters.

Enter a user name.

9 Note

Make sure it is between 3 and 30 characters long.

Enter a password.

9 Note

Enter 8-20 alphanumeric characters.

Q Enter the same password again.

Enter your cell phone number.

9 Note

Make sure the cell phone number consists of numbers an

nn

only. It must be 30 digits or shorter.
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Enter your landline phone number.

0 Note

Make sure the cell phone number consists of numbers and "-" only. It must be 80 digits or shorter.

Enter your email address.

0 Note

Make sure it is 50 characters or shorter.

Enter your department.

0 Note

Make sure it is 80 characters or shorter.

Enter your position.

9 Note

Make sure it is 10 characters or shorter.

Select a specific administrator role for the user.
(10) = Admin: Assign super administrator role.

= User: Assign general administrator role.

3 After entering the required information, click OK.
— To cancel registering a general administrator and go back to the login page, click Cancel.

- After approval from the super administrator, log in to the solution with the registered account.

Note

« Analternative way to register a general administrator is to use the Admin menu after logging in with a super administrator account. For details,
refer to the following:  » Adding a user

- For details on user approval, refer to the following: B Approving a user
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Simultaneous access restriction

It is not possible to access LSS with the same account from multiple computers simultaneously. If you attempt to log in from a
computer using an account that is already logged in from another computer, the following message window will appear.

The last usage information.

The last access time: 2013.07.17 17:14:59
The last access IP: 10.10.10.142
There is already a connection from ‘admin’.

Do you want to terminate the existing connection and open a new one ?
Editing works ongoing on the existing connection will be lost.

To disconnect from the previous computer and then connect to the current computer, click OK. To remain connected to the
previous computer, click Cancel.

@ Note

Note that tasks being performed on the current computer will not be saved if a new computer is connected.

Note

If you refresh LSS or click another menu on the current computer after connecting to a new computer, a disconnection message will pop up and
the login page will appear.



Main page
Log in to LSS to open the main page as follows:

"g Note

« Some functions in LSS are not accessible to general administrators. This is the reason some menus do not appear when a general administrator
is logged in.

« Descriptions in this user guide are based on the super administrator account in order to cover all functions in LSS.

Samsu“g LYNK SINC 1 [ 2012.A Type 2 W Engish (Main)

Hotel
Information

Attractions

Icon5 Icon6

App5 App6
< Up/Down ¢ Left/Right

&P Copyright(c) 2014 Samsung Electronics. Al Rights Reserved. Ver, A-CAR3GDSP-209.9.13

0 View the name of the project currently loaded in the 9 section of the LSS main page.

View the language currently used in menus and messages including the welcome message.

()

f»ﬂ Note

For details on configuring the language, refer to the following: B> Language settings

View the login date and time.

Log out.

Create, edit or delete a project. Import a project from a computer or export a project to a computer.

Distribute a project or a list of channels to a TV group. Withdraw a project or a list of channels that have been
distributed.

@ © © ©
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The LSS main menus are displayed.

Click a menu if you want to access a page of a specific menu.

Note

The Admin and Setup menus are only accessible to the super administrator. These menus will not appear when a general
administrator is logged in.

+ Click Home if you want to go to the main page. An alternative way to go to the main page is to click the program name at the
top left of the page.

. Clickm if you want to download the LSS user guide. The user guide is provided as a PDF file.

« For details on menus, refer to the following: ~ » More about the functions in LSS

Manage the menu pages of a project. Click [} / 2 to open or close the list.

The main page of the project currently loaded is displayed.

Note
« The main page of the currently loaded project contains the same widget main page that appears on TVs after a project is
distributed.

« Toaccess a page of a specific menu, select a menu from the menu bar at the top.
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3 Managing projects

Create, configure and distribute a project used as a TV widget.

Note

+ Touse a variety of languages in project menu pages, first make sure to add a project language to LSS. For details on adding languages, refer to
the following:  » Activating a menu language

+ To practice making and distributing a project, refer to the following:  » Tutorial

Making a project

Creating a project

1 Tocreate a project, click Project Management > New Project at the top left.

) Configure the settings required to create a project from the displayed window.



New Project

O Blank O Default

WEERD
AR RN

Widget 2011 [01] Widget 2012 [01] Widget 2012 [02]
! cis [ ==

Widget 2014 [A] Widget 2014 [B] Widget 2014 [E]

Orurple

v 0K

Enter a new project name.
0 Note
Make sure it is between 1 and 34 characters long.
Select a default metadata type.

= Blank: Select if you want to create a project with empty pages that contain no images or text.

9 = Default: Select if you want to create a project with pages that contain default images and text.
Note

Metadata refers to sources that construct a widget layout such as images, text, videos and audio.



Select a widget type.

Widget 2011 [01]: This is the default widget, which uses the same user interface and graphics as the TV
widgets released in 2011. You can create a maximum of seven user menus. User menus are provided in
bar format at the bottom of the main page of a project.

Widget 2012 [01]: This is the default widget, which uses the same user interface and graphics as the TV
widgets released in 2011. You can create a maximum of 15 user menus. User menus are provided in bar
format at the bottom of the main page of a project.

Widget 2012 [02]: This gallery widget displays user menus on the main page of a project similar to
pictures at an exhibition. You can create a maximum of 15 user menus.

Widget 2014 [Al: This gallery widget displays user menus on the main page of a project similar to pictures
at an exhibition. The widget provides basic menus as a menu bar at the top. You can use basic menus and
create a maximum of ten user menus.

Widget 2014 [B]: This gallery widget provides user menus and basic menus on the main page of a project
similar to a slideshow. You can use basic menus and create a maximum of ten user menus.

Widget 2014 [E]: Users that have a registered license and only use the IPTV function can use this widget
to distribute IPTV content to a TV.

"ﬂ Note

For details on user menus and basic menus, refer to the following:  » Menu structure

« For details on default widgets and gallery widgets, refer to the following: B Main page settings for the default widget,
Main page settings for the gallery widget

Select a theme to decide the style of the widget.

Available theme types vary depending on the selected widget type (default widget/gallery widget). In
0 addition to the themes provided by default in LSS, it is possible for users to create new themes by widget type.

f»ﬂ Note

For details on how to create themes, refer to the following:  » Making a theme

After configuring the required settings, click OK.

Click OK in the confirmation window if you want to create the project.

— The main page of the new project will be loaded on the screen.

— Configure the detailed settings for the main page and menu pages of the project.

f»ﬂ Note

For details on configuring the page settings of a project, refer to the following:  » Project settings
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Duplicating a project

Apply a new theme to the project currently loaded on the screen and create a duplicate project.
1 Toduplicate a project, click Project Management > Save as Project at the top left.

) Select a project name and theme from the project duplication window.
— Make sure the project name is between 1 and 34 characters long.

- Available theme types vary depending on the widget type of the original project (default widget/gallery widget).
3 After configuring the required settings, click OK.

4 Click OK in the confirmation window if you want to duplicate the project.
— The main page of the duplicated project will be loaded on the screen.
- Configure the settings for the main page and menu pages of the duplicated project.

- If a project with a page being edited is duplicated, changes in the page that have not been saved will only be applied to
the duplicate project.
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Loading/deleting a project

To delete or load a project saved in LSS into the screen, click Project Management > Load Project at the top left.

= Alist of projects will appear.

Load Project X

Total (5) e e
O | me | Title ~ | widgettype | Date . | GroupNamev | Load
> 2012_A Type Widget 2012 [01] 2012.01.19 05:44:01
o 4 2014_Type_A Widget 2014 [A] 2014.01.29 15:57:54
5] 3 2014_Type B Widget 2014 [B] 2014.01.29 11:30:03
(=] 2 2012_B_Type Widget 2012 [02] 2013.01.23 20:17:09 m
8] 1 DefaultHotel wiidget 2011 [01] 2012.01.18 17:49:55 m
1
==
&/
[$
Note

If no project has been distributed to TVs, a default project will be distributed. In the list of projects, default projects will display 2011 Default, 2012
Default, 2014 Default or 2011/2012 under Load.

« 2011 Default: This refers to a project distributed by default to TVs released in 2011.

+ 2012 Default: This refers to a project distributed by default to TVs released in 2012 or 2013.
2014 Default: Represents the default project distributed to TVs released in 2014 and after.

« 2011/2012: Represents the default project distributed to TVs released in 2011,2012 or 2013.

For details on specifying the default project, refer to the following:  » Basic settings for LSS




1 From the project list, select the checkbox of the project to be loaded on the screen.

) Click Load below the list.
— The project currently loaded on the screen displays Project Load under Load in the list.

— Itis not possible to load multiple projects simultaneously.

3 Click OK in the confirmation window if you want to load the project.

— The main page of the selected project will be loaded on the screen.

1 Select a project checkbox from the project list.

) Click Delete below the list.
— Itis possible to delete multiple projects simultaneously.
— The project currently loaded on the screen displays Project Load under Load in the list and cannot be deleted.

— Itis not possible to delete projects that have been distributed to TVs and are currently in use.

3 Click OK in the confirmation window if you want to delete the project.

— The selected project will be removed from the list.

Importing/exporting a project

To import a project saved on the computer to LSS or export a project saved in LSS to the computer, click Project Management >
Import/Export Project at the top left.

= Alist of projects will appear.

Total (6)
Project Ttie ﬁ
Check | Mo Title Widget Type Date
5 2014_Type_A 2014.01.20 15:57:54
5 2014_Type B 2014.01.29 11:30:03
4 2012 8_Type 2013.01.23 20:17:09
3 2012_A_Type 2012.01.10 05:44:01
2 DefaukHotel 2012.01.18 17:49:55
1




1 Click Import below the project list.

7 Inthe projectimport window displayed, enter a new name for the project that will be imported.

— Make sure the project name is between 1 and 34 characters long.
3 Click Upload to select a project to import.

4 After configuring the required settings, click OK.
— The selected project will be uploaded and added to the project list.

— To cancel importing a project and go back to the list, click Cancel.

1 From the project list, click Check for the project that will be exported.

— Itis not possible to export multiple projects simultaneously.

) Click Export below the project list.

— The selected project will be zipped.

3 Click Save in the window displayed at the bottom asking if you want to save the project.

— The selected project will be downloaded.

Project settings

Configure the settings for the main page and menu pages of a project loaded in LSS. This section shows the project menu
structure and describes how to configure the settings for the main page and menu pages.

Note

Itis not possible to change the settings for projects that have been distributed to TVs. Pages of a distributed project that are permitted by the super
administrator can be edited. For details, refer to the following:  » Managing user menus

Project menu settings

Manage menus, and edit menu pages.

To edit the menus of a loaded project, click Menu On at the top left.
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Menu structure

Menus are divided into user menus and basic menus.

Geoaoa
User Menu(18)

Hotel Informat... & ® 0
[+ Guestservice @O0

4 Dining @00
‘B Q00
Continental @@9
The Park View @@Q

4 5pa 000

[ Gym Q00

4 Activities 000

[*] Attractions @ @ ﬂ

sic Menu(16)

Bill o0
TV Channel o0
Setup 0
Flight Info o0
WIFI 0
Morning Calls o0
Messages 0
Weather ©0

Screen Mirroring @ e

Smart View o0

Apps 0
BT Player o0
Mobile Content... &)
Source 0
URL Launcher @ e

Channel List @ G

o Customize user menus so that necessary information can be provided to customers. Menus can be added or
deleted. Sub-level menus can be added or edited. User menus are accessible from any widget type.




Basic menus are provided as shortcuts and give room guests access to useful features related to TV channels and
9 the weather info service. In basic menus, adding and editing menus or sub-level menus are restricted. Basic menus
are accessible only from 2014 widget types.

User menus are in a three-level structure.

¥ Guest

47 Dining

Ariake

Continental

The Park View

Top-level user menus are displayed on the main page of the TV screen.
= Widget 2011 [01]: You can create a maximum of seven parent menus.
= Widget 2012 [01], Widget 2012 [02]: You can create a maximum of 15 user menus.
o = Widget 2014 [A], Widget 2014 [B]: You can create a maximum of 10 user menus.

"g Note

If the number of top-level menus on the main page exceeds six after additional top-level menus have been added, cIickl/l at
both ends of the menu bar to view or select a menu that is hidden.

9 Sub-menus are found under top-level menus. A top-level menu can have a maximum of 20 sub-menus.

(3] Lower sub-menus are found under sub-menus. A sub-menu can have a maximum of 20 lower sub-menus.
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Managing user menus

1 Tomanage user menus, click Menu On at the top left of the screen.

— The menu editor will appear.

¢ P=ceog)

ser Menu(21) Iﬂ
Hotel @ G
[l Guest 00
4[] Dining n @ 9
- [E Ariake @ g

- [E Continental @ 9
The Park View @ o

4[5 Spa 000

- [B Guerlain Spa @ 9
- B Guerlain Spa Proced @ 9

Guerlain Spa Progr @ 9

[ Activities o0
l Swimming Pool @ 9
Arcade @ 9
Bil +lola)

v 0
Apps 00

[*| Attractions @ 9

4 Surroundings @ 9

P Downtown @ 9

Setup Q0

Edit the selected user menu name.

0 Note

An alternative way to edit a menu name or change the font size is to cIickfor a menu name from the main page of a
project.




Edit a user menu.
. : Add a menu of the same level as the menu selected from the menu editor.
— To delete a menu, select a menu from the menu editor and click =
— Itis not possible to delete top-level menus provided by default.
. : Add a lower-level menu under the menu selected from the menu editor.
. a: Save an edited menu name.

. ﬂ / uz Move the selected menu in the menu editor.
View menu names and levels. Click a menu item if you want to go to a menu page.
Note
An alternative way to go to a menu page is to click a menu from the main page of a project.

Display or hide a menu or configure other settings.

. :Hide a menu. A hidden menu will not be displayed on the widget. To display a hidden menu on the
widget, click
. : Lock a project to prevent it from being edited. To unlock a project, click

. : Add an image file you want to insert in a menu when editing the Widget 2012 [02], Widget 2014 [A],
Widget 2014 [B] project (gallery widget). After an image file is added, the icon will change to /. Place
the mouse cursor on the changed icon if you want to preview the added file as a thumbnail.

Fﬁ Note

« Super administrator privileges are required to lock or unlock distributed projects to prevent them from being edited.
Distributed projects that are locked or unlocked are indicated by @ or @ respectively.

« Projects not distributed to TVs can be edited regardless of whether the function to edit pages is active or not.
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) Alternatively, right-click on a menu from the menu editor and edit the menu using the convenient context menus.

Add Menu

Rename

Active

Add Sub menu

Menu Lock

Menu up

Menu down

Delate
Add Menu Add a menu at the same level as the selected menu.
Rename Rename the selected menu.
Active Display or hide the selected menu on the widget.
Add Sub menu Add a lower-level menu under the selected menu.
Menu Lock Activate or deactivate the menu editing function.
Menu up Move the selected menu up.
Menu down Move the selected menu down.
Delete Delete the selected menu.

Note

If you right-click in a page set to a language other than the default editing language, the Rename function is only available. For details on
specifying the default language used to edit pages, refer to the following: B Specifying the default language used to edit menu pages
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Managing basic menus

1 To manage basic menus, click Menu On at the top left of the screen.

— The menu editor will appear.

?—fsceng)

User Menu(18)

Hotel Informat... () &0
¥ Guestserice (OO
[¥] Attractions Q00

#sic Menu(16) 0

Bill 0
TV Channel Q0
Setup ©0
Flight Info o0
WIFI Q0
Morning Calls Q0
Messages ©0
Weather o0

Screen Mirroring @ o

Smart View Q0

Apps ©0
BT Player o0
Mobile Content... || & €)
Source 0
URL Launcher 00

Channel List @ Q

(1) Edit the selected basic menu name.

Edit a basic menu.
(2] « [22: save an edited menu name.

. n / u: Move the selected menu in the menu editor.

0 View menu names. Click a menu item to go to the relevant menu page.
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Display or hide a menu or configure other settings.

« ©:Hide a menu. A hidden menu will not be displayed on the widget. To display a hidden menu on the
widget, click @.

e « ©:Locka project to prevent it from being edited. To unlock a project, click ©.

Note

«Super administrator privileges are required to lock or unlock distributed projects.

«  Projects not distributed to TVs can be edited regardless of whether the function to edit pages is active or not.

) Alternatively, right-click on a menu from the menu editor and edit the menu using the convenient context menus.

Add Menu

Rename

Active

Menu Lock

Menu up

Menu down
Add Menu Add a menu at the same level as the selected menu.
Rename Rename the selected menu.
Active Display or hide the selected menu on the widget.
Menu Lock Activate or deactivate the menu editing function.
Menu up Move the selected menu up.
Menu down Move the selected menu down.




Main page settings for the default widget

Access to configure the main page settings varies depending on the widget type (default or gallery widget) selected when
creating a project.

Default widget refers to the widget type Widget 2011 [01] or Widget 2012 [01] selected when creating a project. The main page
of a project is used as the main page of the TV widget.

Run a default widget to display the main page as shown below.

an @ " =)

E)

ATESHILLA
= | A

HESHILLA

- S |,

Hotel Guest v
Information Service Channel

Attractions

Icon6

App6
wn ¢ Left/Right [ Enter

Set the page type and background music.

Set the default image.

Set the logo image.

Set user menus.

@ 6 © © ©

Applications are displayed in this section.

f»ﬁ Note

Information above assumes you are using Widget 2012[01]. The displayed page can vary depending on the selected widget type.



Specify the default image used as the background for the main page.

1 dlick the pencil icon in the upper left corner of the default image section on the main page.

e 1 =3

) From the content list window displayed, click Apply next to the desired image file.

— Alternatively, click the desired image preview thumbnail.

fvﬁ Note

To use image files saved in a computer, refer to the following: B Uploading content

Edit image : Main image width=1280 px, height=400px

Contents List Filename Q]
No Type Contents Contents Size File Name Date o Apply
Width : 537
15 image Height : 368 TheParkView.jpg 2012.01.18 m
Siza : 73 KB
Width : 1280
14 image Height : 400 main_image.jpg 2011.03.15
Size : 163 KB
Width : 229
13 image Height: 28 text_logo.png 2011.03.03 m
Size : 3 KB
12 image downtown_detail2.png 2011.02.22 m
11 image surroundings_detsil1.png 2011.02.22 m
Size : 273 KB
« € 1234567 89% 10 » »




3 Click OK in the confirmation window if you want to select the image.

— The selected image will be set as the default image.




Specify the logo image displayed on the main page.

1 dlick the pencil image at the top right of the default image section on the main page.

e 1 =3

) From the content list window displayed, click Apply next to the desired image file.

— Alternatively, click the desired image preview thumbnail.

"g Note

To use image files saved in a computer, refer to the following: B Uploading content

Edit image : MainLogo width=270 px, height=70px

Contents List Fiename (a]
No Type Contents Contents Size File Name ~ Date & Apply
‘Width : 229
5 image Height: 28 text_logo.png 2011.02.22

Size : 3 KB
— =

Width : 354

L ) .
¢ mage gl "TEl Hent: 227 guestsendce imageb2png 2011.02.22
m#’ :E Size : 142 KB

[ Width ; 354
3 image Height : 227 guestservice_image03.png 2011.02.22 m
o Size : 181 KB

|
Width : 889
2 image . Height : 384 guestservice_spa.png 2011.02.22
\ Size : 500 KB
A=

‘Width : 889
1 image Height : 384  guestservice_dining.png 2011.02.22
Size : 572 KB

& € 12324567 &9 10




3 Click OK in the confirmation window if you want to select the image.

— The selected image will be set as the logo image.

i

BTESHILLA
.

Note

Click the pencil icon below the logo image section on the main page if you want to specify the logo image displayed on menu pages. The logo
image for menu pages can be configured using the same method as the one used for the main page.

e 1 =




Specify the top-level menu names in a project.

f»ﬁ Note

For details on the menu hierarchy, refer to the following: > User menu structure

1 Place the mouse cursor on a top-level menu name on the main page. Click the displayed pencil icon.

fvﬁ Note

+ For a project that uses Widget 2012 [01] as the widget type, you can create up to 15 root menus. Up to six top-level menus are displayed on a
single page. To view additional menus that are hidden, cIickn/ﬂ at both ends of the menu bar.

+ For details on adding top-level menus, refer to the following: B Managing user menus

e B 1

) Configure the required settings from the menu name settings window. Click OK.
— Font Size: Specify the menu text size (unit: pixels).
— Current Title: The current menu name is shown.

— New Title: Enter a new menu name.

Edit Menu X

Font Size 23 px IE‘

Current Title

New Title Hotel Infarmation

e [




— The menu name will be updated according to the entered settings.

e 7 =

i%"ESHlLLA
1
-

£ | Hotel Information Menu 2

Specify the main page type.

1 Select a type from the dropdown list at the top right of the default image section. Click OK.

Hotel Guest ™v
Information Service Channel

Attractions




— Select Type 1 if you want to display the TV application section.

&) Note
« LSS displays the application section only. The icons and names of actual applications installed on a TV can be viewed from the TV after a project
is distributed.

« Applications are arranged in the order shown on the TV. For details on how to rearrange applications, refer to the following:  » Changing the
arrangement of TV applications

e[| 1 =

Hotel Guest
Information Service Channel

Attractions

- Select Type 2 if you do not want to display the TV application section.

ezl P =

Hotel Guest v
Information Service Channel

Attractions




Specify the background music for the main page.

Note

Specified background music will repeat continuously while the main page is displayed.

1 Click Upload in the right corner above the default image section.

Hotel Guest v Attractions

Information Service Channel

) From the content list window displayed, click Apply next to the desired music file.

— Alternatively, click the desired music preview thumbnail.

f»ﬂ Note

To use music files saved on a computer, refer to the following: B Uploading content

Edit project main audio X
Contents List Filename @

No | Type Contents Contents Size File Name ~ Date . Apply

- -
3 audic Size :3.9MB  Sub_BGM.mp3 2013.07.17

"
2 audic Size : 8.0 MB  Menu_BGM.mp3 2013.07.17 m
Py
R ST — " %




Click OK in the confirmation window if you want to select the music.

— The selected music will be set as the background music for the main page.

R il ox n| Main BGM.mp3 ’!un

Hotel Guest ™v
Information Service Channel

Attractions




Main page settings for the gallery widget

Access to configure the main page settings varies depending on the widget type (default or gallery widget) selected when
creating a project.

Gallery widget refers to Widget 2012 [02], Widget 2014 [A], Widget 2014 [B], which is one of the widgets that can be selected
when creating a project. The main page of a project is used as the main page of the TV widget.

Note

+ The defaultimage, the menu names and the background music for the gallery widget main page can be configured using the same method as
the one used for the default widget. For details, refer to the following: ~ » Main page settings for the default widget

+ The gallery widget main page does not provide the menu used to specify the logo image and main page type. To use a logo image, use an
image containing a logo as the default image.

Main page layout of gallery widgets

Run a gallery widget to display the main page as shown below.

Q-

8 TV Channel +7 Flight Info = WIFI

Hotel Information W Attractions

Information about the hotel Description About Attractions

This is for Guest Services

(1) Set the background music.

(2) Set basic menus.
(3] Set user menus.
£ Note

+ Information above assumes you are using Widget 2014 [A]. The displayed page can vary depending on the selected widget type.

- IfWidget 2014 [B] is selected, drag a basic menu or user menu to relocate it. To resize a user menu, drag | "« found at the bottom right of the
menu.



Basic menus are provided as shortcuts and give room guests access to frequently used features related to TV channels and the

weather info service. Users can customize the names and activation status of basic menus and the provided default information.

Changing information by adding a sub-level menu is restricted. To preview a menu page shown to customers, click a menu from
the basic menu section of the main page.

Note

« Elements under a basic menu can be enabled or disabled using the menu editor found at the top left of the screen. For details, refer to the
following:  » Managing basic menus

+ Some of the basic menus may not be displayed on a single page. Click { / ¥ atboth ends of the basic menu section to view hidden menus.

@ 71V Channel @ Setup ~7 Flight Info

Hotel Information 4  Attractions
.

Information about the hotel Description About Attractions
This is for Guest Services

Help menu|

Bill Directly access the hotel bill info of room guests.

Directly access TV channel info.

TV Channel For details on configuring and editing channels, refer to the following:  » Managing IPTV
channel info.
Setup Directly access the select language window.

Access the view flight info window.

Flight Info To configure flight info provided to customers, refer to the following:  » Flight info
settings
Network(WIFI) Access the view network info window.

Directly access the wake-up call settings window. Customers can configure their wake-up

Morning Calls .
9 call settings.

Messages Access the message box.

Access the view weather info window.

Weather To configure weather info provided to customers, refer to the following: B Weather info
settings



Screen Mirroring

Smart View

Apps

BT Player

Mobile Content Sharing

Source

URL Launcher

Channel List

Access the screen mirroring window. Customers can display the screens of their Android
devices on room TVs.

Access the smart view window. Customers can download the smart view application.

Access the start TV application window. Customers can immediately start a downloaded TV
application.

Access the start Bluetooth window. Customers can play music by connecting their smart
devices such as cell phones and tablets via Bluetooth.

Select screen mirroring or smart view to display the selected feature window.
Display the input source page set from the server.

Directly connect to the specified URL as soon as a web browser is launched. The URL can be
set from the server.

Display the IPTV channel list page.

Specify the images for top-level menu icons in a project.

Note

For details on the menu hierarchy, refer to the following: > User menu structure

1 Place the mouse cursor on a top-level menu icon on the main page. Click the displayed pencil icon.

"g Note

+ Analternatively way to specify the menu icon images is to open the menu editor at the top left and click (£} next to a menu name.

« For projects that use the gallery widget type, it is possible to create six or more top-level menus. Up to five top-level menus are displayed on a

single page. To view hidden menus, click? / ) at both ends of the menu bar.

@ TV Channel 7 Flight Info

Help menu|




) From the content list window displayed, click Apply next to the desired image file.

— Alternatively, click the desired image preview thumbnail.

Note

To use image files saved in a computer, refer to the following: B Uploading content

Edit image : image width=271 px, height=260px

Contents List Fienams (]

No Type Contents Contents Size File Name + Date & Apply
Width : 271

30 image Height : 260  HOTEL_INFO_MENUBAR.jpg 2012.12.21
Size : 51 KB
Width : 271

29 image Height : 260 Network_menu_bar.jpg 2012.12.21
Size : 75 KB
‘Width : 271

20 image Height : 260  GS_MAIN_MENUBAR.jpg 20124221
Size : 60 KB
Width : 220

27 image Height : 166  GS_SPA_MENUBAR.jpg 2012.12.21
Size : 67 KB

e Width : 271

26 image - Height : 260 SETUP_MEMUBAR.jpg 20124221

Size : 48 KB

« € 12345678310 > »

3 Click OK in the confirmation window if you want to select the image.

— The selected image will be set as the menu icon image.




User menu page settings

To configure menu page settings, select a page template and layout.

A page template contains menus and pages. Select a page layout to arrange text, images and videos and add content files in the
page.

Available template types are as follows:

This template can be used in the default widgets Widget 2011 [01] and Widget 2012 [01].
Menu Type/Sub Type Select this type if you want to display menus on the left side of the TV screen and construct a
page on the right side.

Select this type if you want to display menus on the left side of the TV screen and arrange

Menu ListType/List Type selectable lists on the right side.

Select this type if you want to construct a page in full screen mode on the TV without
Full Type displaying menus. These templates are available for top-level menus only. If one of these
templates is selected, it is not possible to add a sub-level menu.

Select this type if you want to construct a TV channel selection page and a settings page. This
type can only be selected from a top-level menu.

Other Type
£) Note

This template does not appear in 2014 widget types.

Note

Displayed template choices vary depending on the menu level. For a top-level menu, it is possible to select all types of templates. For a sub-
menu, the Menu Type and Menu List Type templates can only be selected. The Menu Type template can only be selected for a lower sub-menu.

Displayed template names can vary depending on the widget type.

Components of layouts in a page can be used as follows:
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(1) Insert an image file.

(2) Insert a video file.

(3) Insert text.

Layouts by template

Types of layouts available for each template are as follows:

Note

Displayed layouts available for each template may vary depending on the widget type. In order to cover all layouts, widgets are configured and
described according to their function in this user guide.

Menu Type/Sub Type templates

Menu Contents Type Bill Type MyApp Type  Menu Video Type Menu Multi Type
T T H . ) -
(3 L T ] B i v v v PV
i - i = i = ~
T g T T EE 3’ H Q X E BT T or
T T T N T i T I BT
® o ® o ® ® i ® ® o ® o ®

Select the Menu Contents Type layout if you prefer a structure consisting of images and text. Select Menu Video Type if you
prefer a structure consisting of videos and text. Select Menu Multi Type if you prefer a structure consisting of images, videos and
text. To display the TV application auto-run page, select MyApp Type. To display the Express Checkout page, select the Bill Type
layout.

V»ﬂ Note

« The layouts above appear when the Menu Type template is selected from Widget 2011 [01]. To select the MyApp Type layout from the widgets
other than Widget 2011 [01], select the Other Type template.

+ The MyApp Type layout can be configured from any widget under LSS. The layout is only displayed and available on TVs released in 2013.

« For details on how to create an auto-run menu for a TV application using MyApp Type, refer to the following:  » Weather application auto-run
menu settings




Menu List Type/List Type templates

Menu List Type

The Menu List Type template provides a structure consisting of photo and text lists.

Full Type templates

Full Contents Type Full Video Type Full Multi Type

These templates provide layouts similar to the Menu Type templates, except for a few differences. In these templates, menus are
not displayed on the left side of the TV screen and the Bill Type layout is not available. These templates are available for top-level

menus only.
Other Type templates
TV Type Apps Type Language Type  Wifi Type MyApp Type  Bill Type Message Type

&

These templates provide layouts suitable to construct pages used to change the TV channel, display applications and configure
various settings. The Other Type templates can be selected from a top-level menu only.

= TVType, Apps Type and Language Type layouts are displayed in Full Type/Only Type mode and do not show menus on the
screen.

= To edit the instructions on how to use Allshare(DLNA) and Smart View that will be displayed on the customer screen, select
the Wifi Type layout. The Wifi Type layout is only available for 2012 widgets.

Note
- The Wifi Type layout cannot be selected from Widget 2011 [01].

+ To use the Bill Type or MyApp Type layout from Widget 2011 [01], select the Menu Type template.

+ The MyApp Type and Wifi Type layouts can be configured from any widget under LSS. These widgets are only displayed and available on TVs
released in 2013.

« This template does not appear in 2014 widget types.



Page layout settings

Change the location and size of the image, video and text layouts arranged in a page, if required.

Changing the image/video layout properties

1 To change the image or video layout settings, click the desired layout.

ST, ) ] e ] -l — -

The Hotel provides you with an alluring
journey for your taste buds; From fresh
baked goods to delightful authentic
gourmet cuisines by our award-winning
chefs. All of our restaurants offer you a
vegetarian and vegan option for your

preferences. Feast on our inspiring dishes
and wine list created by our very own

executive chefs.

Enter a location value to relocate the image or video layout.

o Note

Alternatively, drag | # ]above a layout to move the layout to the desired location.

Enter a size value to resize the image or video layout.

9 Note
+ Alternatively, drag E below a layout to resize the layout as desired.

« To keep the original aspect ratio of an image file, click the Keep aspect original ratio of the image checkbox.

= OK: Select if you want to apply the changed layout size and location.

(3]

= Default: Select if you want to restore the default location and size of an edited layout.

) To save the changes, click Save.



Changing text layout properties

1 Toeditatext layout, click the desired layout.

D@ B e l&mml ETR—| -~ |

Enter a location value to relocate the text layout.

o Note

Alternatively, drag | # |above a layout to move the layout to the desired location.

Enter a size value to resize the text layout.

6 Note

Alternatively, drag [iZ] below a layout to resize the layout as desired.

Select a text alignment mode and a text size from the dropdown lists. Change text color by entering an HTML
color code or by selecting a color from the color palette.

= SU: Add superscript to text.
(4] = OK: Select if you want to apply changes.

= Default: Select if you want to restore the default settings.

) Tosavethe changes, click Save.
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Page settings

Configure page settings by adding content files.

Menu page background music settings

Specify the background music for menu pages.
1 Click Upload in the right corner above the layout section.

) From the content list window displayed, click Apply next to the desired music file.

- Alternatively, click the desired music preview thumbnail.

Edit audio x

Contents List eame| |
Mo | Type | Contents | ContentsSize | File Name ~ | Date. | Apply
- -
1 audio .ﬂ Size:3.4MB  audio_Home_video.mp3 2013.07.15
1
¢/
Note

To use music files saved on a computer, refer to the following: ~ » Uploading content

3 Click OK in the confirmation window if you want to select the music.

— The selected music will be set as the layout background music.
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Inserting an image into a layout

Insert an image into a layout, if required.
1 Click[#]above the image layout.

) From the content list window displayed, click Apply next to the desired image file.

— Alternatively, click the desired image preview thumbnail.

Edit image x

Contents List R
Mo | Type | Contents | ContentsSize | File Name ~ | Date. | Apply
Width : 1280
48 image Height 1720 MAIN_IMAGE_FINALJpg 20121231
Size: 350 KB
Width : 480
a7 image Height : 400 CABANA_MAIN_-final.ipg 2012.12.27
Size: 222 KB
Width : 480
46 image Height : 400 QUTPOOL_MAIN_-finalipg.jog 2012.12.27
Size: 182 KB
- as -
_~ Width : 480
45 image m‘l e Height:400  SMC_MAIN_1120x600.finalipg 20121227
Size: 183 KB
Width ; 1120
a4 image Height : 300 SPA_MAIN_-_final.ipg 2012.12.27
Size : 346 KB
123 4 567 89 10 > »
&/
Note

To use image files saved in a computer, refer to the following: > Uploading content

3 Click OK in the confirmation window if you want to select the image.

— The selected image will be added to the layout.



Managing projects

Inserting a video into a layout

Insert a video into a layout, if required.
1 Click|#]above the video layout.

) From the content list window displayed, click Apply next to the desired video file.

- Alternatively, click the desired video preview thumbnail.

Edit application x

Contents List o I C |
Mo | Type | Contents | ContentsSize | File Name ~ | Date. | Apply
- -
1 spplication .@ Size: 600 KB  Home video_01mp4 2013.07.15
vvvvv
1
&/
Note

To use video files saved on a computer, refer to the following: ~ » Uploading content

3 Click OK in the confirmation window if you want to select the video.

— The selected video will be added to the layout.

4 Itis possible to load a video file by linking to an external URL for the video file.

— Click the External Url Check checkbox, and enter an external URL.




Distributing a group of projects/channels

Distribute a group of projects or IPTV channels to TVs. View or withdraw a list of distributed projects or IPTV channels, if required.

Projects or channels are distributed to TV groups, not individually to a specific TV. A group of distributed projects or IPTV channels
will be sent to all the TVs in the recipient TV group.

f»ﬁ Note

TVs that have no projects will display the default project. For details on specifying the default project, refer to the following: P> Basic settings for LSS

Distributing a project

1 Todistribute a project, click Deploy > Deploy Project at the top left.

) Select a project from the displayed project list. Click Next.
— For a project that has been distributed before, the distribution date and the recipient TV groups will appear on the list.

— Click a project name from the list to proceed to the next step.

Deploy Project Select Froject > Select Group & Deploy
@ Select one of projects and diick next button.
Total (8) Project Title ﬁ
No Project Title v Widget Type Date~ Deployed Date + Group Name +
g Project0s Widget 2012 [02] 2013,07.17 21:3%:45
Project03 Widget 2012 [01] 2013,07.17 19:56:02
3 Project04 Widget 2012 [01] 2013,07.17 19:54:41
5 Project02 Widget 2011 [04] 2013.07.15 14:28:57
4 Project0l Widget 2011 [04] 2013.07.12 20:42:01
3 2012_B_Type Widget 2012 [02] 2013.01.23 23:47:09 2013.07.17 22:02:53 Project_Grou...
-3 2 2012_A_Type Widget 2012 [01] 2012.01.19 09:14:01
1 DefaultHotel Widget 2011 [01] 2012.01.18 21:19:55
1
=9




3 Select a recipient group from the displayed TV group list. Click Deploy.
— The distributed project can be used as a widget in all the TVs under the selected TV group.
— The Deploy button will not appear until a recipient TV group is selected.
— To change the project to be distributed, click Previous.

— ForaTV group that has been a recipient of a project before, the distribution date and the distributed project will appear
on the list.

— For details on TV groups that receive distributed projects, refer to the following: » Managing project recipient groups

— For a distributed project to be applied to a recipient TV, the TV should be switched to another page or turned off and then
on again.

Deploy Project Select Project » Select Group & Deploy

@ Ciick deploy button, then the project will be deployed ko the selected group.

Project title Widget Type Deploy Status
2012_A_Type Widget 2012
Total (2) Project Titie B
Neo Group Name: Deployed Date Deployed Project
& 2 Project,_Group_001

1 Project_Group_002 2013.07.17 22:02:53 2012.8_Type

=

Withdrawing a distributed project

1 Towithdraw a distributed project, click Deploy > Project Deploy List at the top left.

) Select a project from the displayed list of distributed projects. Click Undeploy.

Project Deploy List Select Project » Select Group & Deploy

@ To undeploy project, select a project and dick undeploy buton.
Total (2) Project Tite a
-] No Project Title = Widget Type Date + Deploy Status +
2 2012 B Type Widget 2012 [0Z] 2013, Project_Grou..,
] 1 2012_A_Type Widget 2012 [01] 2012.01.19 09:14:01 Broject_Grou..,

1
“

3 Click OK in the confirmation window if you want to withdraw the IPTV channel group.

— The selected project will be withdrawn from the recipient TV group.



Distributing an IPTV channel group

1 Todistribute an IPTV channel group, click Deploy > Deploy Channel at the top left.

) Select a channel group from the displayed IPTV channel group list. Click Next.
— For a channel group that has been distributed before, the distribution date and the recipient TV groups will appear on the list.

— Click a channel group name from the list to proceed to the next step.

Deploy Channel Select Project > Select Group & Deploy
. Selact a channel, then dick Next button.
Total (3) Channel List E
No Channel List+ Channels v | Register Date v Group Name v Deployed Date v
@ 3 Villa_Channel_List 4 2013-07-02 05:46
2 Deluxe_Suite_Channel_List 3 2013-07-02 09:45 Channal Group 002 2013-07-17 22:08
1 Penthouse_Channel_List 5 2013-07-02 09:45
1
=,

3 Select a recipient group from the TV group list. Click Deploy.
— The channels in the distributed channel group are accessible from all the TVs under the selected TV group.
— The Deploy button will not appear until a recipient TV group is selected.
— To change the channel group to be distributed, click Previous.

— ForaTV group that has been a recipient of a channel group before, the distribution date and the distributed channel
group will appear on the list.

— For details on IPTV channel groups to be distributed, refer to the following: » Managing IPTV channel groups
- For details on TV groups that receive distributed IPTV channel groups, refer to the following:  » Managing IPTV channel

recipient groups

— For a distributed IPTV channel list to be applied on a recipient TV, the TV should be turned off and then on again.

Deploy Channel Select Project > Select Group & Deplay
@ Click deploy button, then the Channel will be deployed to the selected group.
Channel List Register Date Group Name
Villa_Channel_List 2013-07-02 0%:46
Total (2) CrameiTee [] ﬁ
No Group Name - Deplayed Date ~ Deployed Channel List v
& 2 Channel Group 001
1 Channel Group 002 2013-07-02 0%:45 Deboie_Suite_Channel_List

)




Managing projects

Withdrawing a distributed IPTV channel group

1 To withdraw a distributed IPTV channel group, click Deploy > Channel Deploy List at the top left.

) Select a channel group from the IPTV channel group list. Click Undeploy.

Channel Deploy List

@ Toundeploy channel lsts, select channsl ists and click undeploy buttan,

Total (2)

P —
Il No Channel List~ | Channels v | Register Date Group Name + | Deployed Date +
= 2 Villa_Channel_List 4 2013-07-02 05:46. Channel Group 001 2013-07-17 22110
o 1 Deluxe_Suite_Channel_List E 2013-07-02 03:45 Channel Group 002 2013-07-17 22:08

1

=

3 Click OK in the confirmation window if you want to withdraw the IPTV channel group.

— The selected IPTV channel group will be withdrawn from the recipient TV group.



More about the functions in

LSS

Learn more about the key menu items and functions provided in LSS.

"g Note

To go to the main page, click Home from the menu bar at the top of the LSS page. To download the LSS user guide, clickﬂ.

Group management

Efficiently manage projects, IPTV channels and TVs by grouping TVs connected to LSS.

To use the group management function, click Group from the menu bar at the top.

Managing project recipient groups

Efficiently distribute projects created from LSS by grouping TVs.

To manage project recipient groups, click Group > Project Group.

Project Group TV Management Group||  Channel Group
No Group Name « Description Deployed Project v Deployed Date~ | Widget Type -
1 Project001 Project Draft 001 2014_Type_A 2014-04-21 20:04 2014
1




1 Tocreate a project recipient group, click Add from the list.

) Entera group name and description. Select a widget type.

— To use a widget under Widget 2011 [01] from TVs released in 2011, select 2011 TV models.

— To use a widget under Widget 2012 [01] or Widget 2012 [02] from TVs released in 2012 or 2013, select 2012-2013 TV

models.

— To use Widget 2014 [A] and Widget 2014 [B] from TVs released in 2014 and after, select 2014-2016 TV models.

Add Project Group X

Group Name : Project001
() 2011 TV Models (@ 2012-2013 TV Models () 2014-2016 TV Models
Unselected IP: 1 Selected IP: 0
O Py Room v O Py Room v
0 192.168.0.12 2012
< >
Description : Project Draft 001
VoK 0 feset

Note

LSS provides Widget 2011 [01] and Widget 2012 [01] (default widgets) and Widget 2012 [02], Widget 2014 [A], Widget 2014 [B] (gallery widget).
Select the appropriate widget type for the TVs in the group.

3 SelectaTV checkbox from the Unselected IP list. Click | .

— The selected TV will be moved to the Selected IP list.

— To deselect aTV, select a TV checkbox from the Selected IP list and click [ €.

4 Click OK to add the new group to the list.

— To reset the settings, click Reset.

— To cancel creating a group and go back to the list, click Cancel.



More about the functions in LSS

Editing a project recipient group

1 Toedit a project recipient group, click a group name from the list.

) Change the settings required to edit a group from the displayed window. Click OK.
— To restore the previous settings, click Reset.

— To cancel editing a group and go back to the list, click Cancel.

Modify Project Group X

Group Name : | Project001 |

(O 2011 TV Models (8 2012-2013 TV Models (0 2014-2016 TV Models

Unselected IP: 0 Selected IP: 1

O Py Room + O P Room v

~ 192.168.0.12 2012 "~

A~

Description : | Project Draft 001 |

VoK o e

Deleting a project recipient group

1 Todelete a project recipient group, select a group checkbox from the list and click Delete.

) Click OK in the confirmation window if you want to delete.

— The selected project recipient group will be deleted.

Note

To delete a recipient group that has a project, first withdraw the project. For details on withdrawing distributed projects, refer to the
following:  » Withdrawing a distributed project




Managing TV management groups

Group TVs connected to LSS. This allows you to efficiently manage the TVs. Available features include distributing messages,
controlling TVs remotely and firmware upgrades.

To manage TV management groups, click Group > TV Management Group.

TV Management Group Project Group Channel Group
(W) No Group Name v Description v
a 1 TV_Management001 TV Management group 001

1

Creating a TV management group

1 To create aTV management group, click Add from the list.

) Enteragroup name and description. Select a widget type.
— To create aTV management group to apply to TVs released in 2011, select 2011 TV Models.
— To create aTV management group to apply to TVs released in 2012 and 2013, select 2012-2013 TV Models.
— To create aTV management group to apply to TVs released in 2014 and after, select 2014-2016 TV Models.

Add TV Management Group X

Group Name | TV_Management001 |

() 2011 TV Models @ 20122013 TV Models () 2014-2016 TV Models
Unselected IP: 1 Selected IP: 0

O P~ Room ~ O P Room ~
[ 192.168.0.12 2012

[
< >
Description | TV_Management group 001 |
MoK & we

3 SelectaTVIP address checkbox from the Unselected IP list. Click | /.
— The selected TV will be moved to the Selected IP list.

- To deselect aTV, select a TV IP address checkbox from the Selected IP list and click | €.



Click OK to add the new group to the list.
— To reset the settings, click Reset.

— To cancel creating a group and go back to the list, click Cancel.

To edit a TV management group, click a group name from the list.

Edit details of the TV management group as desired from the displayed window.

Modify TV Management Group x

Group Name TV_Management001
() 2011 TV Models (@ 2012-2013 TV Models () 2014-2016 TV Models
Unselected IP: 0 Selected IP: 1
O Py Room + O P~ Room
F  192.1680.12 2012
Description TV_Management group 001
0K

Click OK to save the changes.
- To restore the previous settings, click Reset.

— To cancel editing a group and go back to the list, click Cancel.

To delete a TV management group, select a group checkbox from the list and click Delete.

Click OK in the confirmation window if you want to delete.

— The selected TV management group will be deleted.



Managing IPTV channel recipient groups

Efficiently distribute IPTV channels by grouping TVs.

To manage IPTV channel recipient groups, click Group > Channel Group.

Channel Group Project Group || TV Management Group
O | No Group Name ~ Description + Deployed Project v Deployed Date +
(=] 1 Channel_Group001 Channel Group 001

1

Creating an IPTV channel recipient group

1 Tocreate an IPTV channel recipient group, click Add from the list.

) Enteragroup name and description. Select a widget type.
— To create an IPTV channel distribution group to apply to TVs released in 2011, select 2011 TV Models.
— To create an IPTV channel distribution group to apply to TVs released in 2012 and 2013, select 2012-2013 TV Models.
— To create an IPTV channel distribution group to apply to TVs released in 2014 and after, select 2014-2016 TV Models.

Add Channel Group X

Group Name |Channe\_GmupUUl |

(O 2011 TV Models @ 2012-2013 TV Models () 2014-2016 TV Models

Unselected IP: 1 Selected IP: 0
] Py Room ~ O Py Room

[ 192168012 2012

< pd

Description |Channe\ ‘Group 001 |

3 Select the desired TVs from the Unselected IP list. Click | *].
— The selected TV will be moved to the Selected IP list.
— To deselect TVs, select the desired TVs from the Selected IP list and click [€].



Click OK to add the new group to the list.
— To reset the settings, click Reset.

— To cancel creating a group and go back to the list, click Cancel.

To edit an IPTV channel recipient group, click an IPTV channel name from the list.

Edit details of the IPTV channel recipient group as desired from the displayed window.

Modify Channel Group x

Group Name Channel_Group001
() 2011 TV Models (@ 2012-2013 TV Models () 2014-2016 TV Models
Unselected IP: 0 Selected IP: 1
O Py Room + O P~ Room
F  192.1680.12 2012
Description Channel Group 001
0K

Click OK to save the changes.
- To restore the previous settings, click Reset.

— To cancel editing a group and go back to the list, click Cancel.

To delete an IPTV channel recipient group, select a group checkbox from the list and click Delete.

Click OK in the confirmation window if you want to delete.

— The selected IPTV channel recipient group will be deleted.



More about the functions in LSS

Content management

Upload or download content files on a computer. Content files can be used to make pages.
To manage content files, click Contents from the menu bar at the top.

= Click = / = nextto the desired header to rearrange content files in ascending or descending order.

Contents List [T Filename (a]
| Mo Typev |  Contents ContentsSize | File Name + | Date ~ | Download
o Width : 229
5 image i | Height : 28 text_logo.png 2011.02.22
Size: 3 KB
Width : 354
4 image Height : 227 guestservice_image02.png 2011.02.22 # Download
: Size : 142 KB
.
Width : 354
3 image Height : 227 guestservice_image03.png 2011.02.22 # Download
Size : 181 KB
Width : 889
2 image Height : 384 guestservice_spa.png 2011.02.22
Size : 500 KB
Width : 889
1 image Height : 384 guestservice_dining.png 2011.02.22
Size : 572 KB
€ €123456
Total (55) Download m
&/
[
Note

Content restrictions and recommendations

+  Maximum image resolution: 3264X2448

+  Recommended video resolution: 1024X768

+  Recommended video playback method: Streaming URL

- For details on video and music file restrictions, refer to the following page: B http://www.samsungdforum.com/Guide/rel00010/index.html




Uploading content

1 To upload content files, click Upload above the list.

) Click File Select, and select a file.
— A content file up to 1GB can be uploaded.
- Click Stop if you want to cancel a file upload process.

— To delete an added file before uploading the file to LSS, click [£§ from the file list.

File Upload X

Max Size : 1000MB | File Select

IMG_0418.jpg
IMG_1289.jpg
132-4777.ipg u
. j32-5060.jpg B

Upload Completed 4.

3 Click OK to add the uploaded file to the list.

— To cancel uploading a file and go back to the list, click Cancel.

Downloading content

1 To download a content file uploaded in LSS, click Download for the desired file from the list.

) To download multiple content files, select file checkboxes from the list and click Download below the list.

— The selected files will be downloaded one after another.

Note

To download multiple files, make sure to disable the pop-up blocker function in the Internet browser. For details on disabling the pop-up blocker
function, refer to your Internet browser user guide.



Deleting content

1 To delete a content file, select a file checkbox.
) Click Delete below the list.

3 Click OK in the confirmation window if you want to delete.

— The selected content file will be deleted.

Theme management

Use the provided default themes that can be applied according to the TV model. It is possible to create new themes.

To manage themes, click Theme from the menu bar at the top.

Note

« Themes refer to a group of graphic components in a TV widget, such as the buttons, background image and colors. LSS provides five types of

widgets by default: Widget 2011 [01], Widget 2012 [01], Widget 2012 [02], Widget 2014 [A] and Widget 2014 [B]. These default widgets can be

applied by TV model. It is possible to use the four default themes provided for each default widget type, or create new themes.

« Default themes for each default widget type: Widget 2011 [01] and Widget 2012 [02], which are the default widgets, provide the Default,
Purple, Green and Brown themes. Widget 2012 [02], Widget 2014 [A] and Widget 2014 [B], which are gallery widgets, provide the Default,

Purple, Green and Red themes. Default themes cannot be edited or deleted.

Select Theme ? 2011 H 2012-01 ” 2012-02 || 2014-B

2 vellow

2 customized_Theme_001

e [re - Momegta 3

w=1s-1 E=jc=Ia=




Select the desired default widget type.

Default and customized themes are displayed. Customized themes display Modify and Delete at the bottom. These
options are not available for default themes.

= Create New Theme: Create a new customized theme.

= Apply: Apply the theme selected from the list.

Making a theme

1 To make a new theme, click Create New Theme from the Select Theme page.

) Configure the settings required to create a theme from the displayed window.

Create New Theme

Theme Name Theme Guideline

Edit Menu Color
Color & | 3=lele .
Background Corner u | FeFEFe
Border Left 4 | fofdfd
idth:274px  Height: 156px Modify
Shadow Color % | SBARFE .
Barder Right & | cpooco

1 ' l 1280x 720 bg_main.png m 2 ‘ 18x 18 btn_arrow_n_l.png m o

Enter a theme name.

View the theme guidelines. For details on the theme guidelines, refer to the following:
» Viewing the theme guidelines

Insert a representative image to be displayed on the list of theme choices. To insert a representative image,
(3] click Modify.

= Animage file with the resolution of 274x156 is recommended.



Specify the colors for general menus and active menus by entering an HTML color code or clicking the color

palette.

Add a design element for a theme. To add a design element, click Modify.

0 Note
Image files in .png format are supported. The recommended size in pixels for a file can be found in the corresponding design

element.

3 After configuring the required settings, click OK.

— To cancel creating a theme and go back to the list, click Cancel.

Viewing the theme guidelines

Using the theme guidelines, preview where design elements will be applied on a theme page.
1 Toview the theme guidelines, click Theme Guideline in the Create New Theme window.

) View where the design elements will be applied from the displayed theme guidelines window.

Guidlines

Images

1)8 focus images used : focus_{l png .focus_ir, focus_bl, focus_br,
focus_m focus_mr focus_tc focus_bc

2)img_arr_02.0ng

3)widget_arrow_right_n.png
4) widget_arrow_lefi_d.png

5)img_am_01,png

Tresioy 20 10:30 AM

7
Note
The theme guidelines function shows a sample of the locations of design elements used in a theme. It is not possible to preview the actual image

of a theme with design elements applied.



Editing a theme

1 Toedita customized theme, click Modify below a customized theme in the list.

) Themes can be edited using the same method used when making a theme. Edit the theme properties as desired from the

displayed window.

Theme Name | Customizad_Theme_001]

Width:274px  Helght: 156px

1 ' l 12680720 bg_main.png

Edit Menu Color

Color

Background Corner

Border Left

Shadow Color

Border Right

[ Modity JFS 4 18x18  bin_amow_n_Lpng

Download Images Zip File

PSS

o | FeRRe

« | tatara

& | ssamre

« | coenen

‘Theme Guideline

Modify

3 Todownload all the design elements used in a theme as a zipped file, click Download Images Zip File.

4 To save an edited theme, click OK.

— To cancel editing a theme and go back to the list, click Cancel.

Deleting atheme

1 To delete a customized theme, click Delete below a customized theme in the list.

) Click OK in the confirmation window if you want to delete.

— The selected theme will be deleted.

Applying a theme

Select a theme from the list, and click Apply.
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My account management

View or edit your account information.

Click Account on the main page.

Editing my account info.

1 Edit the details as desired.
— Fields with * cannot be left blank.

— ID and Name cannot be edited.

Account
D * admin
Mame  * Super Admin
@ oo pesso @
9 Current Password | ........... |
9 Choose a Password  # | ............. |
o Re-enter Password  # | ............. |
e Mobile Number | 111-222-3333 |
G Telephone Number | 123-456-7890 |
eE-rnai\ * | admin@admin.com |
0 Department | Executive Office |
0 Positian | Director |
0 To change the password, click the checkbox. The current password and new password fields will be enabled.
(2] Enter the current password.

Enter a new password.

9 Note

Enter 8-20 alphanumeric characters.

(4] Enter the new password again.
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Enter your cell phone number.

0 Note

Make sure the cell phone number consists of numbers and "-" only. It must be 30 digits or shorter.

Enter your landline phone number.

G Note

Make sure the cell phone number consists of numbers and "-" only. It must be 80 digits or shorter.

Enter your email address.

0 Note

Make sure it is 50 characters or shorter.

Enter your department name.

0 Z) Note

Make sure it is 80 characters or shorter.

Enter your position.

9 Note

Make sure it is 10 characters or shorter.

) After entering the required information, click OK.



TV list management

After LSS connects to TVs that have been configured, TV information will be displayed on the TV list.

The TV list can be used to manage identification information of TVs in room:s. If the IP addresses of TVs in rooms are not managed
from PMS, communication between the PMS and TVs can be relayed by mapping TV information to room numbers.

To add aTV license to LSS, or to add and manage information on TVs in all rooms, click TV List from the menu bar at the top.

Note

PMS (Property Management System) refers to a hotel room management system. The system connects to LSS to provide necessary information for
hotel room management.

&w List ?oom Number
[ | N

o Room Number - softap_id/pw + IP Address + MAC Address + TV Type + Firmware Ver - TV Model Status

O 2 203 10.10.10.11 11-11-11-11-11-11  Widget 2014 - -

101

O 1 (V] 11223344 12-34-56-78-00-00  Widget 2014 - B

1

(1) Use room numbers to search a list of TVs.

9 Select a number to specify the maximum number of TVs to be listed on the page.

* ExportTV ID Data: Export the MAC addresses of TVs in all rooms registered in the list.
* ImportTV License: Register licenses for TVs released in 2012.
= Export Excel File: Export mapping information of TVs in all rooms registered in the list as an Excel file.

= Import Excel File: Import an Excel file that contains TV mapping information and update the TV list.

View TV information registered in LSS.

Click #= / ™ next to the desired header to rearrange the list in ascending or descending order.

View or manually specify the occupancy by room.
(5] * Checked Out: The room is not occupied.

= CheckIn:The roomis in use (occupied).

» Add: Add TVs to the list by manually entering TV information in the mapping table.
(6] * Modify: Edit desired TV information.

= Delete: Delete desired TV information.



Managing TV info.

Import or export TV information and conveniently manage the information.

ExportingTVID

Export a MAC address to a computer. A MAC address identifies a TV and can be used to check a TV license. To export a TV ID, click

Export TV ID Data.
= TheTV_ID.list file will be downloaded to the computer.

ImportingaTV license

1 Toregister an additional TV license, click Import TV License.

) Click Upload, and select a license file.

License Upload

Find Text File | Upload

3 To upload the license file, click OK.

— To cancel uploading a license and go back to the list, click Cancel.

Exporting mapping info.

To export mapping information as an Excel file, click Export Excel File.

= An Excel file containing mapping information will be downloaded to the computer.



To import a downloaded mapping info file to LSS, click Import Excel File.

— The mapping info file uploader window will appear.

Import Mapping Table
1

Find Text File Upload

Import Type

Do not change old room information
if duplicated information exist in the file.

®  Overwrite old room information with new one
if duplicated information exist in the file.
Delete old table and create new one
with information from the file.

Import a desired mapping info file.

To import a mapping info file, click Upload and select a file.

Select how to handle files being imported to LSS when the files contain information that already exists.

= Do not change old room information if duplicated information exist in the file: Select this mode if you do
not want duplicate mapping information to be imported to LSS.

(2) = Overwrite old room information with new one if duplicated information exist in the file: Select this mode
if you want the current mapping information in LSS to overwrite the new information.

= Delete old table and create new one with information from the file: Select this mode if you want the new
information to overwrite the current information in LSS.

After configuring the required settings, click OK.



Managing the room occupancy

Manually configure the room occupancy settings from LSS, if required.

Check-in settings

1 Tomanually change the occupancy status to checked-in mode, click Checked Out under Status for the desired room on the list.

) The check-in settings window appears. Select a language and click AddGuest.

Check In X

Room Number: 103

Language: English ¥

u Guestname Company Guestid

v 0K + AddGuest % Checkout

3 The guest info input window appears. Fill in the required input fields and click OK.

' Add Guest %

Guest Name™: | James Johns |

Company Name: |JJ&CDI |

Guest Id*: |A103 |

* Mandatory Fields

Guest Name Enter the guest name.
Company Name Enter the company information of the guest.
Guest Id Assign an ID for the guest to use during their stay at the hotel.



4 After adding the guest, click OK in the check-in settings window.

— To cancel check-in and go back to the list, click Cancel.

Note

Mapping tables with the occupancy status set to checked-in mode cannot be edited or deleted.

1 Tomanually change the occupancy status to checked-out mode, click Checked In for the desired room on the list.

) Select a guest checkbox from the check-out settings window and click Checkout.

— To add a guest, click AddGuest. Guests can be added using the same method used when configuring check-in settings.

Check Out b4

Room Number: 103

ol Guestname Company Guestid
o James Johns J1&Co. Al03
Amy Johns B103

v 0K == AddGuest X Checkout




Managing mapping tables

Manage mapping tables by manually entering information on TVs in room:s.

Note

Mapping tables with the occupancy status set to checked-out mode can only be edited or deleted. For details on check-out settings, refer to the
following:  » Check-out settings

Adding a mapping table

1 Tomanually add a mapping table, click Add below the list.

) Configure the settings required to add a mapping table from the displayed window.

. Add Mapping Table X

Room Mumber 103

Softap ID A103

IP Address 1M |- 22 |-] 33 || 243
MAC Address 12| |34|-|56|" 78|~ [90| |00
TV Type [2014 v

Room Number Enter a room number.

Softap ID Set the tethering ID for the TV.

IP Address Enter the IP address of the TV.

MAC Address Enter the MAC address of the TV.

TV Type Selecta TV type from the dropdown list.

3 After configuring the required settings, click OK.

— To cancel adding a mapping table and go back to the list, click Cancel.
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Editing a mapping table
1 Toedit a mapping table, select an item checkbox from the list.

) Click Modify below the list.

Modify Mapping Table X

Room Number | 104 |

Softap ID | A104 |

MAC Address @

TV Type [2014 v

3 Edit the details, and click OK.

— To cancel editing a mapping table and go back to the list, click Cancel.

Deleting a mapping table

1 Todelete a mapping table, select an item checkbox from the list.
) Click Delete below the list.

3 Click OK in the confirmation window if you want to delete.

— The selected mapping table will be deleted.




License management

View a registered LSS license. Add a new license, if required. License registration allows a connection to TVs to be established.
Connected TVs can be managed from LSS.

To use the license management function, click License from the menu bar at the top.

Managing licenses

To view or add a license, click License > License List.

icense (Total . 1, active: 1 ) (® Auto O Manual | i m License TV List

License Return Free License |
License Key Product Key Product Name | Connected Start Date End Date Registration Date Status
1 [l 011120-Z7ZK74-DQKID3-YCES 011120 011120 10 27-01-2016 29-04-2849 15-02-2016 Active

¢

o

= Total: View the total number of currently registered licenses.
= active: View the total number of Active Status licenses.

= Auto/Manual: Select Auto if you want TVs recognized by LSS to be automatically connected. Select Manual if
o you want to manually connect TVs recognized by LSS by approving the connections from the License TV List
menu.

f»ﬂ Note

For further details on how to approve TV connections, refer to the following:  » Approving a TV connection

* License List: Display a list of licenses registered in LSS.

= License TV List: Display a list of TVs recognized by LSS.

= Initial License: Register a license.
(3) « License Return: Return a license.

= Free License: Use a free license.
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= License Key: View the registered license keys.
= Product Key: View the unique key assigned to the product.
* Product Name: View the product name.

= Connected: View the maximum number of TVs that can be connected using a license.

Note
"9999" will be displayed if the number of TVs that can be connected is unlimited.
= Start Date: View the start date to use the license.
» End Date: View the license expiration date.
(4] = Registration Date: View the date a license was registered.

= Status: View whether the license is active.

Note

Full and trial versions of licenses are available. The license term and the number of TVs that can be connected vary depending on
the license version.

« Full version (Standard) license: The license term for the full version is unlimited. Licenses can be divided into two types: the first
allows only a limited number of TVs to be connected, and the second has no restrictions and allows an unlimited number of TVs
to be connected.

« Trial version (Demo) license: The license term for a trial version is limited. TVs will be disconnected once the license expires. The
number of TVs that can be connected varies by license.

@ Click a page number to display a list of licenses on the corresponding page.

(6] Delete: Delete a license.
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Registering a license

1 Click Initial License above the list of licenses.

— The register license window will appear.

) Enter license information.

. Add License

Internet Status

(@) Connect (7) Don't Connect

License Server

|https:,-’,-’V3.5amsungg5bn.c0m |

License Key

FI | | | |

Could not find the License Key ??

Select your Internet environment.

Note

« IfanInternet connection is not available, select Don't Connect and activate your license following the displayed
instructions.

- Toregister a license offline, access the license server at https://v3.samsunggsbn.com and obtain a license activation key.

Q Enter the obtained license key.
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3 Click Activate.
4 Click OK in the registration confirmation window.

5 Anotification message appears when the license is successfully registered. Click Close and close the register license window.

— The registered license will be added to the license list.

Note

Without a registered license, it is not possible to establish connections with TVs.

Returning a license

A license key used on an LSS program on a computer cannot be used on an LSS program on another computer. If an LSS program
will be installed on another computer or if the program no longer needs to be used, return your license.

1 Selecta license checkbox to return from the list of licenses. Click License Return above the list of licenses.

— The return license window will appear.

) Select your Internet environment and click Continue.

4
Note
+ IfanInternet connection is not available, select Don't Connect and return your license following the displayed instructions.

+ Toreturn alicense offline, access the license server at https://v3.samsunggsbn.com and enter the key to return the license.
3 A prompt appears requiring a confirmation to return the license. Click OK.

4 Anotification window appears when the license is successfully returned. Click OK.
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Obtain a free license to use a trial version of LSS.

1 Click Free License above the list of licenses.

— The register free license window will appear.

) Enter the free license information.

| Add Free License

License Type

Internet Status

(@) Connect (7) Don't Connect

License Server

|https:f;’v3.samsunggsbn.com |

Company Name | | Division | |

Address | |

Work Phone Email

[T accept terms and conditions ‘ Terms and Conditions ‘

Activate

Select a desired free license type.

= Trial: Access all functions provided by LSS for 30 days.

= IPTV Only: Access the IPTV channel-related menus and the function to distribute channels without time
limits.
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Select your Internet environment.

Note

« IfanInternet connection is not available, select Don't Connect and activate your free license following the displayed
instructions.

+ Toregister a free license offline, access the license server at https://v3.samsunggsbn.com and obtain a license activation key.

(3] Enter in user information for the free license.

(4] Select the agree to terms of use checkbox. To view the terms of use in detail, click Terms and Conditions.

3 Click Activate.
4 Click OK in the registration confirmation window.

5 Anotification message appears when the license is successfully registered. Click Close and close the register license window.

— The registered license will be added to the license list.



Connecting TVs

View information on TVs recognized by LSS. Approve connections for recognized TVs.

Click License > License TV List to manage connection settings with TV.

Note

For LSS to recognize TVs, first configure the LSS connection settings from the TVs. For details on TV settings, refer to the following: ~ » TV settings

p)
TV List (Total : 5, active : 1) T

= No Room Number IP Add MAC Add TV Type Status
E 2 806 10.10.11.276 fe-07-5d-4e-fe-07  Widget 2012 Unapproved

4

‘ & 1 803 10.10.11.206 fe-3a-5d-4e-fe-07  Widget 2012 Approved

e

* Total: View the maximum number of TVs that can be connected using the licenses currently registered.

= active: View the number of TVs currently connected.

= License List: Display a list of licenses registered in LSS.

» License TV List: Display a list of TVs recognized by LSS.

= Room Number:View the room number assigned toaTV.
= |P Address: View the IP address assigned toa TV.
(3] * MAC Address: View the MAC address assigned toa TV.
» TV Type:View the type of a TV. The type of a TV depends on the widget type used on the TV.

= Status: View whether a TV has been approved to connect to LSS.
Q Click a page number to display a list of TVs on the corresponding page.

= Approve: Approve the selected TV to connect to LSS.

= Unapprove: Disconnect the selected TV from LSS.
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Approving a TV connection

If Manual is selected as the TV connection method in License List, TVs recognized by LSS need approval to connect to the
program. Perform the approval process from License TV List.

Note
If Auto is selected as the TV connection method, TVs recognized by LSS will automatically connect to the program without going through an

approval process.

1 ClickaTV checkbox from the TV list.

Note

The approval process is only applicable to TVs that have Unapproved displayed under the Status option.
) Click Approve below the TV list.
3 Click OK in the confirmation window if you want to proceed with approval.

4 Click OK in the confirmation window if you want to complete approval.

— Onthe TV list, the Status mode for the TV will change to Approved.

Disconnectinga TV

To disconnect aTV from LSS, cancel the TV connection approval.
1 ClickaTV checkbox from the TV list.

Note

The disconnection process is only applicable to TVs that have Approved displayed under the Status option.
) Click Unapprove below the TV list.
3 Click OK in the confirmation window if you want to proceed with disconnection.

4 Click OK in the confirmation window if you want to complete disconnection.

— On the TV list, the Status mode for the TV will change to Unapproved.
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TV management

Manage IPTV channels, messages, TV widget info, remote control features and TV firmware.

Click TV Management from the menu bar at the top.

Managing IPTV channel groups

Add or edit IPTV channel groups.

Click TV Management > Channel Management > Channel List to manage IPTV channel groups.

Note

To add an IPTV channel group, first add IPTV channel information to LSS. For details on adding IPTV channel information, refer to the

following: ~ » Adding IPTV channel info.

Channel Management

[— |

iz |

= e E—
O | No | List Name ~ | channels | Register Date ~ Deploy Status + | Deployed Date~ | EPG view
] 2 IPTV Channel 002 2 2014-04-22 09:32 EPG
1 IPTV Channel 001 2 2014-04-22 09:30 Channel_Group001 2014-04-22 09:33 EPG
1
Total (2)

Adding an IPTV channel group

1 Toadd an IPTV channel group, click Add below the list.

Channel Management

- P S e

List Name :

[pTv chann

el 001

Unselected: 2

Selected: 1

1

5

Number v

Jnes

Humber + ‘ Name v

a8

I

. S .




Enter an IPTV channel group name.

Select IPTV channels displayed under Unselected. Click [ */.

— To return an IPTV channel to the Unselected list, select an IPTV channel under Selected and click | <.

After configuring the required settings, click OK.
— To reset the settings, click Reset.

— To cancel adding a group and go back to the list, click List.

Select a group checkbox from the list. Click Modify.
— An alternative way to edit a group is to select a group name from the list.

— An IPTV channel group can be edited using the same method used when adding a group.

Click OK to save the changes.
— To restore the previous settings, click Reset.

— To cancel editing a group and go back to the list, click List.

Select a group checkbox from the list. Click Delete.

Click OK in the confirmation window if you want to delete.

— The selected IPTV channel group will be deleted.

Select a group checkbox from the list. Click Clone To USB.

When the select USB window appears, set the destination folder.

— Information about the selected IPTV channel group will be saved as a zipped file.
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Managing IPTV channel info.

Add or manage IPTV channel information in LSS.

Click TV Management > Channel Management > Channels to manage IPTV Channel information.

Channel Management {nssa;e ﬂ K Jl “ TV File ]
el @
[/ | No | ChannelNoa | Channel Name | Channel category ~ | Language ~ | Load
] 7 7 7Hma News English
=] 6 6 [ ] News English
] 5 5 sHEg News English
a 4 4 aug News English
-] 3 3 3UH9 News English
=] 2 2 2939 News English
a8 1 b ¢ 139 News English
= == L= = W] == |
D' Swap the selected channel number with the channel above or below it.
Save Save updated information of a changed channel number.
Add Add IPTV channel information.
Modify Edit previously added IPTV channel information.
Delete Delete IPTV channel information.
Import from Excel Import IPTV channel information from an Excel file that was previously exported.
Export to Excel Export all information about IPTV channels as an Excel file.




1 Toadd IPTV channel information, click Add below the list.

) Fillin the input fields required to enter IPTV channel information from the displayed window.

‘ Add Channel

1. Channel Number *

2. Channel Name *

3. Channel 1P *

4. Channel Port *

5. Channel Category *
6. Channel Language *
7. Audio Delay *

8. Channel Payment *

9. Select EPG

48

EEF

8201

News

English

100

* Free

EPG

123

Channel Number
Channel Name
Channel IP
Channel Port
Channel Category

Channel Language

Audio Delay

Channel Payment

Select EPG

Enter an IPTV channel number that is selectable from TVs in rooms.
Enter an IPTV channel name.

Enter the IP address of the IPTV channel.

Enter the port number of the IPTV channel.

Specify the IPTV channel category using the dropdown list.
Specify the IPTV channel language using the dropdown list.

If the audio is out of sync with the video, specify an Audio Delay value to sync them.

Note

Audio Delay can be filled in with an integer within a range of 0-500 (unit: 1/1000 seconds).
Select whether to provide the IPTV channel for free or for a charge.

Import EPG info for the IPTV channel.
For details on EPG info, refer to the following: B Creating EPG data
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3 After entering the required information, click OK.

— To cancel adding a channel and go back to the list, click Cancel.

Editing IPTV channel info.

1 ToeditIPTV channel information, select an IPTV channel checkbox from the list and click Modify.

- An alternative way to edit IPTV channel information is to select an IPTV channel name or number from the list.

) Click OK to save the changes.

— To cancel editing a mapping table and go back to the list, click Cancel.

Deleting IPTV channel info.

1 Todelete IPTV channel information, select an IPTV channel checkbox from the list and click Delete.

) Click OK in the confirmation window if you want to delete.

— The selected IPTV channel information will be deleted.
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Managing IPTV channel DRM

1 To configure the DRM settings for IPTV channels, click TV Management > Channel Management > Channel DRM.

) Fillin the input fields required to add DRM information in the displayed window.

Channel Management

[ | e

onnel it honmel o
COMPANY NAME : |SAMSUNG

DRH 1P :

COMPANY NAME

Enter the DRM provider name.

DRM TYPE

Select a DRM type.

Note

LSS defaults to Verimatrix VCAS DRM and Samsung SCAS DRM. These are suitable for Hotel Smart
TV service. IP Prozidiom is also supported on TVs from the NC690 and NC890 series released in the
US.in2014.

DRM IP

Enter the DRM IP.

3 After entering the required details, click OK.

— The IPTV channel DRM information will be saved.

Note

DRM (Digital Rights Management) refers to a technology that restricts the use of distributed content which is controlled by the copyright owner.



Create data consisting of information on configuring programs to use on IPTV. Using the provided basic data, conveniently
configure and use the program information.

1 Run EPG Broker, which was installed along with the LSS program.

) Click Settings from the EPG Broker window.

r N
& EPG Broker = | E ||

Guide

3 Enter EPG environment info and click Save.
- Entering the provided environment info allows you to use basic data.

- After the provided environment info is entered, basic data will be displayed in the EPG Broker window and saved as an

XML file.
o] Select a country from the dropdown list and specify a zip code. To use basic data, select
IpLode United States and set the zip code to 73167.
Provider Select the provider from the dropdown list. To use basic data, select 321045.
Update Select an update cycle from the dropdown list. To use basic data, select Every 1 Day.
. . Set the destination folder to save EPG data. To use basic data, set the destination folder
File Location

to C:\HotelTV\htdocs\data\epgxml.

— The example path above assumes the LSS program is installed on the C drive. The path can vary depending on the drive

where the program is installed.

4 Check to see that all the information is correctly entered and click Close.

Note

To edit data, edit C:\HotelTV\htdocs\data\epgxml\Samsung_epg.xml and load data to EPG Broker again.
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Managing messages

Efficiently manage messages to be distributed to hotel guests.

Click TV Management > Message Management to manage messages.

Message "anagemen‘t Channel Management | i “ Control “ TV File Management ‘

Message Title ﬂ 10 .

0-

| No |Message Type~ | Destinationv | Message Title v | useriDv | SendingTypev | Registered Datew | Current Status v
O 4 Notice P About our Hotel admin Period 2016.02.15 05:13:48 Waiting
O 3 Message Group Attractions admin Instant 2016.02.15 05:13:20 Done
O o) Message P To check out admin Scheduled 2016.02.15 05:13:05 Waiting
O 1 Notice Group ‘You are more... admin Instant 2016.02.15 05:12:30 Done

e ]

Search for a message title. Specify the maximum number of messages to be displayed in a list.

View message details. Click # / ™ next to the desired header to rearrange the list in ascending or descending
order.

= Delete: Delete the selected message from the list. If the message is scheduled for distribution, you must cancel
distribution first.

* Add: Create a new message.
* Modify: Edit a message scheduled for distribution.

= Cancel: Cancel distribution of a scheduled message.




1 Toadd a message to be distributed to hotel guests, click Add below the list.

2

Fill in the input fields required to add a message in the displayed page.

[T RSeS| information Management | Remote Control TV File Management

Message Type Notice  (® Message

Title

Message
(0/300bytes)

Do you want to register the message with frequently used message? [

Default Image img_messages_popup_photo.png

Delivery Schedule ® Instantly O Set  Due Date

Closed Type @ Cosed by guest's confirmation

Destination Group P

Set Period

Frequently-Used

New Frequently-Used

Message Type

Title

Message

Default Image

Select a frequently-used message.
Add a frequently-used message.

= Notice: Select this mode if you want messages to be distributed as pop-ups on the
main page and saved in the message box.

= Message: Select this mode if you want to distribute messages to the message box
or attach images.

Enter a message title.

Enter the content of the message.

Click the Do you want to register the message with frequently used message?
checkbox if you want to add the entered message title and content to the list of
frequently-used messages.

f»ﬂ Note

A message up to 90 bytes can be transmitted.

When the message type is set to Message, you can view attached images as thumbnails. To
change an attached image, click .

Attach an image to a message. To change an attached image, click Change Image.

Fﬁ Note

This feature is only available when the message type is set to Message.



= Instantly: Select if you want to send a message immediately.

= SetaDue Date: Select if you want to distribute a message at a specified date and
time.

= Set Period: Distribute a message for a specified period.

Note

Setting items to schedule a message distribution will appear if Set a Due Date is selected. Select a

Delivery Schedule

date and time.
= Closed by guest’s confirmation: Select if you want a distributed message to be
removed from the screen after a guest reads the message.

= Closed automatically after: Select if you want a message to be automatically
removed after displaying on the TV screen for a specified time.

Closed Type Note

+ Adropdown list used to specify the message display duration will appear if Closed
automatically after is selected. Specify the display duration.

« If Message Type is set to Message, ClosedType is automatically set to Closed by guest’s
confirmation and cannot be changed.
= Group: Select if you want to distribute a message by TV management group.

= |IP: Select if you want to distribute a message to specific TVs.

Destination Note

To distribute a message by group, first register a TV management group in LSS. For details on TV
management groups, refer to the following:  » Managing TV management groups

3 After configuring the required settings, click OK.
— To reset the settings, click Reset.

— To cancel creating a message and go back to the list, click List.

1 Toeditascheduled message before distributing it, select a message checkbox from the list and click Modify.

) A message can be edited using the same method used when adding a message. Click OK to save the changes.
— To restore the previous settings, click Reset.

— To cancel editing a message and go back to the list, click Cancel.

f»ﬁ Note

It is not possible to edit a message set to be distributed immediately.



More about the functions in LSS

Canceling a message distribution schedule

1 Tocancel a scheduled message before distributing it, select a message checkbox from the list and click Cancel.

) Click OK in the confirmation window if you want to delete.

— The selected message distribution schedule will be deleted.

Note

Itis not possible to cancel distribution of a message set to be distributed immediately.

Using frequently-used messages

Conveniently create a message using frequently-used messages.
1 To use afrequently-used message, click Frequently-Used in the message creation page.

) Select a message checkbox, and click Insert.

Frequently-Used x

| No | Title

4 Attractions

3 YOU ARE MORE THAN WELCOME.
2 Welcome to our Hotel

1 About our Hotel

1

3 Todelete a message from the list of frequently-used messages, select a message checkbox and click Delete.
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Adding frequently-used messages

1 Toadd afrequently-used message, click New Frequently-Used in the message creation page.

) Enter a message title and content required to add a frequently-used message in the displayed window.

New Frequently-Used X

Title |Welmme Message |
Message Greetings from THE hotel with the greatest ~
pleasure. ~

3 After entering the required information, click OK.

— To view an added message, click Frequently-Used in the message creation page.



Managing ticker messages

Ticker messages refer to messages displayed at the bottom of a TV screen. Add or edit a ticker message to send while watching
IPTV.

To manage ticker messages, click TV Management > Information Management > Ticker.

Info. Management Channel Manag t || M ge Manag t Remote Control TV File Management
T T

I Ticker Option I Select the Ticker List you want to apply and click the Apply button

No Type« Contents - Registered Date + Current Status -
O 3 Announcement Good Morning?! 2014-04-18 10:34:42 Unapplied

2 Announcement For your safety and co... 2014-04-18 08:58:29 Applied

1 Announcement Lunch is ready at "The ... 2014-04-18 08:50:30 Applied
Total (3) 1

0 Configure ticker message settings.

Ticker messages are listed. Click ™ / * next to the desired header to rearrange content files in ascending or
descending order.

= Type: The ticker message type is shown.
(2] = Contents: The content of the ticker message is shown.
= Registered Date: The date the ticker message was created is shown.
= Current Status: The ticker message status is shown. Unapplied is displayed if a ticker message has not been
sent. Applied is displayed if a message has been sent.
= Apply: Send a ticker message.
= Add: Create a new ticker message.
= Modify: Edit a ticker message.

= Delete: Delete a ticker message.

(4) Search ticker messages.



Configure ticker message settings such as the background, text size and color.

1 Click Ticker Option above the list of ticker messages.

2

From the settings window, configure settings using the following options and click OK.

— To preview configured settings, click Preview.

| Ticker Option

Ticker Type: Flow v
Flow Time:

Enter Ticker Interval: —j m
Text color: # |FFFFFF

Background color: # |FFO00D .
Transparency: —— | (100!

Ticker Type

Flow Time

Enter Ticker Interval
Text color
Background color

Transparency

Select a ticker message type.
= Fixed: Display a fixed message at the bottom of the TV screen.

= Flow: Display a scrolling message at the bottom of the TV screen.

Set the scroll speed of the ticker message.

f»ﬂ Note

This feature is only available when the ticker message type is set to Flow.

Set the time interval between ticker messages when displaying multiple messages.

Set the text color of the ticker message.
Set the background color of the ticker message.

Adjust the transparency of the ticker message.



Create and save a ticker message to the list of ticker messages as a message waiting to be sent.

1 Toadd aticker message, click Add below the list.
-The add ticker message window will appear.

) Enter ticker message info and click OK.
- To preview a new ticker message, click Preview.

Message » |

(0/200)

Text Size 12pt v

Delivery Schedule » *Instantly Set a Due Date

Message Type the content of the message to send.
Text Size Set the text size.

Specify when to send the message.
= Instantly: Send the message immediately.

Delivery Schedule
= SetaDue Date: Send the message at a specified time. Set the date and time to

send the message.

3 Click OK to save the settings.

— The created ticker message will be added to the list.
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Sending ticker messages

Send a ticker message that is waiting to be sent.
1 Select the checkbox of a message to send from the list of ticker messages.
) Click Apply below the list.

3 Click OK to confirm the transmission.

— The ticker message will be sent to the room TVs where IPTV is being viewed.

Editing ticker messages

Edit a ticker message that is waiting to be sent.
1 Select the checkbox of a message to edit from the list of ticker messages.
) Click Modify below the list.

3 Edit the message using the edit message window. A message can be edited using the same method used when creating a
message.

Deleting ticker messages

Delete a ticker message that is waiting to be sent.
1 Select the checkbox of a message to delete from the list of ticker messages.
) Click Delete below the list.

3 Click OK to confirm the deletion.

- The ticker message will be removed from the list.
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Weather info settings

Weather info displayed on room TVs is transmitted in real time from the AccuWeather website. Select a country and city to display
weather info. Set the info update cycle.

1 To configure weather info settings, click TV Management > Information Management > Weather Info.

) Configure the required settings and click Save.

Info. Management | Channel |l | Remote Control | TV Fie Management
Weather API Available AccuWeather
Select City » |India v || New Delhi v |
Temperature Unit |Degree Ceisius v
Update Period * |300 |In Seconds
—

Weather API Available The website to import weather info from is shown.
Select City Set the country and city to display weather info.
Temperature Unit Temperature unit is shown.

Update Period Set the info update cycle.
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Flight info settings

Flight info displayed on room TVs is transmitted in real time from the Flight Status website. Select a country and city to display
flight info. Set info used to sign up on the Flight Status website. Specify the info update cycle.

Note

To use information from the Flight Status website, sign up for the website. For further information, refer to the following:  » Signing up for the

Flight Info website

1 To configure weather info settings, click TV Management > Information Management > Flight Info.

) Configure the required settings and click Save.

Info. Management

lﬂlal'l'[l"

[P

rmorrenes R T

Weather Info Flight Info

Flight APT %

Select City *

App Id *

App Key *

Update Period +

| Flight Status

']

United states

v || Las Vegas-McCarran Inter ¥ ‘

|Qel 105b

[21e3145fbfodsofosfdazatestrsicbs |

|86400

‘ In Seconds

Flight API The website to import flight info from is shown.

Select City Set the country and city to display flight info.

App Id Enter your app ID obtained when you signed up on flightstats.com.
App Key Enter your app key obtained when you signed up on flightstats.com.
Update Period Set the info update cycle.




LYNK SINC 3.0 sends flight info from flightstats.com to room TVs. To use flight info, sign up at flightstats.com and obtain an app ID

and key.

1 Access https://developer flightstats.com/.

) Click Register at the top right of the screen.

3 Enter membership info required to sign up. Make sure to set Product Interest to API Services.

4 After entering the required information, click Sign up.

— An email confirming your sign-up will be sent to the personal email address you entered in your membership info.

5 Access your personal email and go to the address linked to the sign-up confirmation email.

6 From the displayed page, log in using the ID and password you entered in your membership info.

]/ After logging in, click Dashboard at the top right of the screen.

- You can view information on your account that you signed up.

Click View in the account info page.

— You can view your app ID and key.



Remotely controlling TVs

Remotely control TVs registered in LSS.

Click TV Management > Remote Control to remotely control TVs.

Remote control Channel 0 0 Information Management TV File Management
qDes:':ratm-'\ All ﬂ ﬁ H ﬂ
9[‘ No Destination User ID Execution Type v Register Date + Command + Current Status
O 7 P admin Instant 2016-02-15 04:41:48 Clone Update @ Done
O =6 Group admin Scheduled 2016-02-15 22:00:00 Power Off (O] Waiting
O 5 Group admin Instant 2016-02-15 04:41:23 Firmware Update @ Done
O 4 w» admin sScheduled 2016-02-15 21:00:00 Factory Lock ® Waiting
O 3 Group admin Instant 2016-02-15 04:40:46 Volume @ Done
O 2. P admin Scheduled 2016-02-15 21:00:00 Power On @ Waiting
O 3y b admin Instant 2016-02-15 04:39:56 Re SoftapID ) Done
122> »
Total (11) ® poweron @ power 0ff @ Reboot @ Firmware Update. @) Factory Unlock @ Factory Lo 4 " Delete ﬁ ﬁ
@) softap on (@) softap 0F @ volume (%) clone Update

Select Group or IP to sort the targets that are remotely controlled.

Select a number to specify the maximum number of items to be displayed in the list.

View details on remote control commands. Remote control commands refer to commands used to remotely control

TVs.

Click = / = next to the desired header to rearrange content files in ascending or descending order.

Delete: Delete the selected remote control command from the list. If the remote control command is
scheduled, you must cancel the scheduled remote control command first.

Add: Add a remote control command.
Modify: Edit a scheduled remote control command.

Cancel: Cancel a scheduled remote control command.
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Adding a remote control command

Remotely control TVs in rooms using LSS. Note that it is only possible to remotely control TVs released in 2013 when the TVs are
turned on or the Virtual Standby function is active.

Z) Note

The Virtual Standby function only turns off the TV panel without turning off the main power of aTV set.

1 Toadd a remote control command, click Add below the list.

) Configure the settings required to add a remote control command from the displayed window.

Remote Control | channet

Destination S @ l:lﬂ

ListTP:1

selected IP: 1

O Py Room v |(‘Almnarwv‘ Hame~ | (=] Py Room + Company v Name v
0 wainn 103 - 0 naowazs

« R

Recussad acten

Execution Schedule O Instantly @ Set A Due Date

pate:[ | Hour[00 v] minute:[00 v]
T

= Group: Select if you want to send a remote control command to a TV group.
Select a group from the list, and click EE

= IP: Select if you want to send a remote control command to specific TVs.
Destination Select the IP addresses of desired TVs from the list. Click [}]

Note

To distribute a message by group, first register a TV management group in LSS. For details on TV
management groups, refer to the following: B Managing TV management groups




= Power On: Select if you want to turn on TVs.
= Power Off: Select if you want to turn off TVs.
= Firmware Update: Update the TV to a TV firmware registered in LSS.
* Clone Update: Update TV configuration to TV configuration files registered in LSS.
* Reboot: Select if you want to restart TVs.
* Factory Unlock: Set the feature to be accessible from any country.
* Factory Lock: Set the feature to be accessible only from specified countries.
= Volume: Select if you want to adjust the sound volume of TVs.
Requested Action = Softap On: Enable the tethering feature.
= Softap Off: Disable the tethering feature.

f»ﬂ Note

Firmware updates take place as soon as a TV begins to turn off. The update will take between
5-15 minutes. Controlling the power to a TV while the firmware is being updated may cancel
the update.

If you turn on Clone Update, there is an automatic update when the TV turns off after a remote
control command is transmitted.

A volume control menu item will appear if Volume is selected. Select a value within the range
of 0-100.
= Instantly: Select if you want to send a remote control command immediately.

= Set A Due Date: Select if you want to send a remote control command on a
specified date.

Note

Setting items to schedule a message distribution will appear if Set A Due Date is selected. Enter a

Execution Schedule

date and time.

3 After configuring the required settings, click OK.
— To reset the settings, click Reset.

- To cancel adding a remote control command and go back to the list, click List.
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Deleting a remote control command from the list

1 To delete a remote control command from the list, select a control command and click Delete.

) Click OK in the confirmation window if you want to delete.

— The selected remote control command is deleted from the list.

Note

+ Todelete a scheduled remote control command, you must cancel the scheduled event first.

+ Itis not possible to delete a remote control command that was already transmitted.

Editing a remote control command

1 Toedit a remote control command scheduled for transmission, select a control command checkbox from the list and click
Modify.

) Click OK to save the changes.
— To restore the previous settings, click Reset.

— To cancel editing a remote control command and go back to the list, click List.

Note

Itis not possible to edit a remote control command that has already been transmitted.

Canceling a remote control schedule

1 Tocancel a remote control schedule, select a control command checkbox from the list and click Cancel.

) When the deletion confirmation dialog box appears, click KIX.

— The scheduled remote control event that has been selected is canceled.

Note

Itis not possible to cancel a remote control command that was already transmitted.




Managing TV firmware

Register and manage TV firmware in LSS.

Click TV Management > TV File Management > TV Firmware to manage TV firmware.

TV File Management G | Messoge I B 7
=== o
D No Firmware Name v Version v TV Model v Register Date v UserID w Download
D 3 Firmware_Ver03 3.0 HG40AA790 2013-07-29 admin
= 2 Frmware_Ver02 2.0 HG40AA790 2013-07-29 admin
L} 1 Firmware_Ver01 1.0 HG40AA790 2013-07-29 admin
.
e =n

Adding TV firmware

1 ToaddTV firmware, click Add below the list.

) Configure the settings required to add TV firmware from the displayed window.

Upload Firmware File

. Firmware Name |Finnware_\u’er04 ||

. Model Select TV Model

E.  Version |4.D ||

aionﬁguraticn files (Max Size : 1000MB) | File Select

Uploading completes 0.

o Enter the name of firmware.

Q Select aTV model from the dropdown list.
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(3] Enter the version of firmware.

Upload a firmware file.
Click File Select, and select a firmware file.

= To upload a zipped firmware file, unzip the file to the desired folder and then upload the upgrade.msd file
0 to the folder.

Note

A firmware file up to 1GB can be uploaded.

3 After configuring the required settings, click OK.

— To cancel uploading a firmware, click Cancel.

Note

Uploaded firmware can be distributed to TVs using the TV remote controlling function. For details on remotely controlling TVs, refer to the
following:  » Adding a remote control command

Deleting TV firmware

1 Todelete TV firmware, select a firmware checkbox from the list and click Delete.

) Click OK in the confirmation window if you want to delete.

— The selected TV firmware will be deleted.

Downloading TV firmaware information

1 Todownload TV firmware information registered in LSS to a computer, click Download for the desired firmware on the list.

) Select a destination folder, and click OK.

— A memo pad file containing the selected TV firmware information will be downloaded.



Managing TV configuration files

Add and manage TV configuration files in LSS.

Click TV Management > TV File Management > TV Configuration to manage TV configuration files.

TV File Management channel | message ' Remote Control
TV Firmware Configuration Name l:|m EE
O | Mo Configuration Name v TV Model v Register Date~ | UserID w Download
D 3 Config File#3 HG40AA790 2013-07-29 admin
= 2 Config File#2 HG40AA790 2013-07-29 admin
L} 1 Config File#1 HG40AA790 2013-07-29 admin
.
e ==

Adding TV configuration files

1 ToaddaTV configuration file, click Add below the list.

) Configure the settings required to add a TV configuration file from the displayed window.

Upload TV Configuration File

Model Select TV Model

Configuration files (Max Size : 1000MB) | File Select

Uploading completes 0.

ﬂ Boot logo{.bmp only) Ekepath'—.Samsung. bmp| Upload

* Maximum file size you can upload is 2MB
* Maximum resolution you can upload is 1280x720
* filename must be ‘samsung.bmp’

(1) Enter a configuration name.
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9 Select a TV model from the dropdown list.

Upload a configuration file.

Click File Select, and select a configuration file.

Note

A configuration file up to 1GB can be uploaded.

Upload a booting logo.
Click Upload, and select a booting logo.

0 ] Note
« Animage file up to 2MB can be uploaded.
« The booting logo image file name is Samsung.bmp.

A booting logo image file with the resolution of 1280X720 is recommended.

3 After configuring the required settings, click OK.

— To cancel adding a configuration file and go back to the list, click Cancel.



Checking the result of TV configuration file distribution

A configuration file is distributed successfully to TVs via a remote control command in the Remote Control menu if the TVs are the
same model. Check to ensure that TV configuration files have been distributed successfully, using the steps below:

fvﬁ Note

For details on remote control commands in Remote Control, refer to the following: B Remotely controlling TVs

1 Goto C:\HotelTV\htdocs\bin\logs\sdap. The folder is created on the C drive during LSS installation.
— Assume that the path to the HOTELTV folder is the C drive.

) Open the sdap.log-2013-08-29.txt file.

— The date in the log file name may vary depending on the user.

3 IfTV configuration files are distributed successfully, the following information appears in the log file.

— The date, firmware version and LSS IP address shown in the information may vary depending on the user.

SERVER 1600 SYSTEM CLONE URL=http: //200.200.100.100:444/data/firm/firmware/23/clonefile_url.txt
CLONEVERSION=20130829094728 ACK=YES

CLIENT 100 SYSTEM CLONE RESULT=SUCCESS REASON=READY MAC=aa:aa:aa:aa:aa:aa

CLIENT 100 SYSTEM CLONE RESULT=SUCCESS REASON=SWCLONE_DONE SuccessFile/ToCloneFiles=32/32 MAC=aa:aa:aa:aa:aa:aa

CLIENT 100 TVBOOT READY MAC=aa:aa:aa:aa:aa:aa FWVERSION="T-NT14UDEUCB-1006.5" CHVERSION=N/A
CLONEVERSION="20160218030953" TVTIME=20160218031426 AUTH=NEED_INFO SUBMICOM_VERSION="T-NT14UDEUSB-1007



Deleting a TV configuration file

1 Todelete aTV configuration file, select a file checkbox from the list and click Delete.

) Click OK in the confirmation window if you want to delete.

— The selected configuration file will be deleted.

Downloading TV configuration files information

1 Todownload a TV configuration file information saved in LSS to a computer, click Download for the desired file on the list.

) Select a destination folder, and click OK.

— A memo pad file containing the selected TV configuration file information will be downloaded.

Administrator menu

To add or delete a general administrator, or to edit information on a general administrator, click Admin from the menu bar at the
top.

Note

The Admin menu is accessible to the super administrator only.
LSS users are classified as super administrators and general administrators.

«  Super administrator: This is an account (admin) provided by default when LSS is installed. Users with this user account can access all LSS menus
and create a super administrator account for another user.

«  General administrator: This is an administrator account added by the super administrator from the Admin menu. The Admin and Setup menu
items do not appear when a general administrator is logged in.

User List ?m 5| | w0 =]
| No D~ | Name ~ | Mobile ~ E-mail ~ | Control
5 user(s Landy Smith F77-888-9999 userl5Esamsung. com Unapproved
4 user4 John Barringer 555-666-7777 userd4@samsung. com Unapproved
3 user(3 Samantha McLeod 333-555-7777 userd3@samsung.com Approved
2 userd2 Bruce Campbell 222-333-5555 userd2@samsung.com Approved
1 user(l Samsung Kim 111-222-3333 userl1@samsung.com Approved
 C—re)

o Search users by ID, name or approval status (approved/unapproved).




9 Specify the number of users displayed on each user list page.

= |D:View a user ID.
= Name:View a user name.

9 = Mobile: View the cell phone number of a user.
* E-mail: View the email address of a user.

= Control: View whether a user has been approved by the super administrator to use LSS.

(4] Click a page number to display a list of users on the corresponding page.

(5) View the number of users currently not approved on the user list.

= Approve: Approve the selected user to use LSS.

= Unapprove: Cancel the approval to use LSS for the selected user.
(6] = Modify: Edit information on the selected user.

= Add: Add a user.

= Delete: Delete the selected user.

Note

Sort users by the criterion including ID or name on the user list in ascending or descending order, using ¥/ A next to the desired criterion.

Approving a user

For a general administrator to use LSS, approval from the super administrator is required.

1 Click a user checkbox from the user list.

Note

The approval process is only applicable to users that have Unapproved displayed under the Control option.
) Click Approve below the user list.

3 Click OK in the approval confirmation window.

— On the user list, the Control mode for the user will change to Approved.
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Canceling approval for a user

Cancel the approval for a user to prevent the user from using LSS, if required.

1 Click a user checkbox from the user list.

Note

The process to cancel approval is only applicable to users that have Approved displayed under the Control option.

) Click Unapprove below the user list.

3 Click OK in the confirmation window if you want to cancel approval.

— On the user list, the Control item for the ID changes to Unapproved.

Editing user info.

Edit user information, if required.
1 Click a user checkbox from the user list.
) Click Modify below the user list.

3 Editinformation as desired in the displayed page.

Note

+ An alternative way to edit user information is to click a user ID or name from the user list.

«  Fields with * cannot be left blank.

4 Click OK to save the changes.

- You will be redirected to the user list page. The corresponding user information has been changed in the user list.

— To cancel editing user information and go back to the list, click Cancel.
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Adding a user

Add a super administrator or general administrator.
1 Click Add below the user list.

) Enter the user information in the user account creation page.

Note

Fields with * cannot be left blank.

3 After entering the required information, click Add.

- You will be redirected to the user list page. The corresponding user has been added in the user list.

— To cancel adding a user and go back to the list, click Cancel.

Deleting a user

Delete a super administrator or general administrator.
1 Click a user checkbox from the user list.
) Click Delete below the user list.

3 Click OK in the confirmation window if you want to delete.

— The corresponding user has been deleted in the user list.



Log management

Briefly view the connection and service records in LSS.

Click Log from the menu bar at the top.

J’Log List ?;:;:-:‘-:; (| ~ 2013-07-18 _',_'E':'_?AJI [=] ﬁm El

[

£ | ne Action ~ Project Userld ~ Detailed Description - Date -
=] 31 Project 2012_B_Type admin Set deploy project 2012_B_Type 2013.07.18 09:40:12
[ 30 Menu Edit 2012_B_Type admin Menu editing Edit Menu8 -> ... 2013.07.18 09:38:23
(=] 29 project 2012_B_Type admin Apply load project 2013.07.18 09:36:16
F 28 Login admin Login (10.10.10.141) 2013.07.18 09:15:19
B 2z Login admin Logout#TIME (10.10.10.141) 2013.07.17 00:50:18
=] 26 Project 2012_A_Type admin Set deploy project 2012_A_Type 2013.07.16 18:50:14
=] 25 Channel 2012_A_Type admin Set deploy channel. 2013.07.16 16:47:27
B 24 Login admin Login (10.10.10.141) 2013.07.16 15:53:49
B = Login admin Logout#TIME (10.10.10.141) 2013.07.15 20:52:13
=} 22 project 2012_A_Type admin Apply load project 2013.07.15 14:48:14

122 4 2> »

Total (31)

(1) Click i | above the list to display logs generated in a specified period.

Search logs.

(2] Select All, User ID or Project from the dropdown list to specify the search criterion. Enter a keyword in the search
box.

0 Select a number from the dropdown list to specify the maximum number of logs to be displayed in the list.

View log details.

Click & / = nextto the desired header to rearrange content files in ascending or descending order.

Deleting alog

1 Todelete alog, select a log checkbox from the list and click Delete.

) Click OK in the confirmation window if you want to delete.

— The selected log will be deleted.
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Settings

Configure basic settings to use LSS including the menu language.

Click Setup from the menu bar at the top.

Note

The Setup menu is accessible to the super administrator only.

LSS users are classified as super administrators and general administrators.

« Super administrator: This is an account (admin) provided by default when LSS is installed. Users with this user account can access all LSS menus
and create a super administrator account for another user.

« General administrator: This is an administrator account added by the super administrator from the Admin menu. The Admin and Setup menu
items do not appear when a general administrator is logged in.

Basic settings for LSS

1 To configure basic settings for LSS, click Setup > Common.

) Configure the basic settings.

Setup

o R

PMS IP

Default Project 2014

Default Project 2012

Default Project 2011

Default Channel

Project Select [ 2014_Type_B]
Project Select [ 2012_Type B
Project Select [ DefaultHotel ]

Default Channel Select [ ]

Layout Background [ |
Alarm Music Walk_in_the_forest.mp3
Write logs to file Enable® Disable ®  The log file is lacated in : [webraot]/data/temp
Date Fomat
(I
Enter the IP address of the PMS that will be connected to LSS.
PMS IP Note
PMS (Property Management System) refers to a hotel room management system. The system
connects to LSS to provide necessary information for hotel room management.
To select a default project to be distributed to TVs released in 2014 and after, click
Project Select, select a project, and then click Default.
Default Project 2014

Note

The specified default project will be displayed on TVs that do not have a project.




Default Project 2012

Default Project 2011

Default Channel

Layout Background

Alarm Music

Write logs to file

Date Format

To specify the default project to be distributed to TVs released in 2012 or 2013, click
Project Select. Select a project, and click Default.

#) Note
The specified default project will be displayed on TVs that do not have a project.

To specify the default project to be distributed to TVs released in 2011, click Project
Select. Select a project, and click Default.

Specify default channels to distribute. Click Default Channel Select, select channels and
then click Default.

Specify the LSS background color by entering an HTML color code or by clicking the
color palette and selecting a color.

Add music files to use on alarms.

Save communication details between TV widgets, LSS and PMS as a file.

= Enable: Select if you want to enable the function that saves communication detail
to afile.

= Disable: Select if you want to disable the function that saves communication
details to afile.

Note

A log saved as a file will be stored for 90 days.

Select a format to display dates.

3 After configuring the required settings, click Save.
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Language settings

Specify the language used to edit projects and the TV widget menu language.
Click Setup > Language to specify the language.

setup

Select Language English v Language option

Welcome Title ‘ Welcome! @ center O Left O Right

We are honored te have you as our distinguished guest.
We hope you have a memorable stay with us in USA.

Welcome
Message

@ Center @ Left O Right

Monetary Unit O Left  ® Right

‘Successfully Checked out.

success

Message

@ Center @ Left @ Right

Check out fails. Please ask Front-Desk.
Failure
Message

® Center @ Left O Right
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Activating a menu language

To select a language to use to configure TV widgets or projects, first activate the language from LSS.
1 dlick Language Option.

) Select a language checkbox, and click Enable.
— An active language will display On in the list.

— An active language can be selected from the TV widget settings menu.

Language Option X

Select o
::‘:?:?:I‘;liﬁh) Language On/Off - La:‘:;:ge Template In use H|
English {on) (Main) In use
Afrikaans {off) In use
Albanian (Off) In use
Amharic () In use
Arabic (OfF) In use
Bulgarian {Off) In use
Chinese (0ff) In use
Croatian () In use
Czech (o) In use
e | e

3 Todeactivate a language, select a language checkbox and click Disable.

- Languages that are not active will display Off in the list.

4 To save the changes, click Save.

— Languages available to be used to edit pages will display In use.
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Specifying the default language used to edit menu pages

Default edit language can only be used to configure images in a menu page. The default edit language is set to ensure
consistency when editing and designing menu pages for each language.

1 To specify the default language, click Language Option.

Language Option X

Select o~
::‘:?:2?;“5'1) Language On/Off = La:‘;;:ge Template In use H|
English {on) (Main) In use
Afrikaans (OfF) In use
Albanian (Off) In use
Amharic (Off) In use
Arahic {0} In use
Bulgarian {off) In use
Chinese ) In use
Croatian (0ff) In use
Czech (o) In use
e ] e

) Select a language checkbox, and click Main.

— The default language used to edit pages will be updated to the selected language.

3 To save the changes, click Save.

Changing the menu language

To change the language used to configure TV widgets or projects, select a language from the dropdown list under Select
Language.

Note

Projects edited from LSS are managed by language. If English is selected, the content language of all pages in a project will change to English.

Any changes will be saved to pages in English.

- Toedita page using a desired language, change the language setting.




More about the functions in LSS

Managing welcome messages

Manage welcome messages to be displayed on the TV widget by language. To manage welcome messages by language, select a
language from the Select Language dropdown list.

‘Select Language English L]

Weicome Title [ welcome! | ®center Ot O Rone
We are honored to have you as our distinguished guest.
We hope you have a memorable stay with us in USA.

Welcome

Message
@ Center  © Left O Right

Monetary Unit O Left  ® Right

Successfully Checked out.

success
Message

@ Center  © Left  © Right

Check out fails. Please ask Front-Desk.

Failure
Message

@ Center @ Left O Right

Welcome message title settings

1 Enter a welcome message title in the Welcome Title field.

— A welcome message title can be up to 30 characters long.
) Select a location to display the title from Center/Left/Right.

3 To save the changes, click Save.

Welcome message content settings

1 Enter the content of a welcome message in the Welcome Message field.

— The content of a welcome message can be up to 500 characters long.
) Select a location to display the message from Center/Left/Right.

3 To save the changes, click Save.
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Currency unit settings

1 To specify the currency unit to be displayed on Express checkout bills, select a language from the Select Language
dropdown list.

) Enter a unit in the Monetary Unit field.
3 Select alocation to display the unit from Left/Right.

4 To save the changes, click Save.

Managing Express checkout messages

Manage Express checkout result messages for guests by language. To manage Express checkout messages by language, select a
language from the Select Language dropdown list.

Check-out success message settings

1 To specify the message to be displayed on TVs when Express checkout is successful, enter a message in the success Message
field.

) Select alocation to display the message from Center/Left/Right.

3 To save the changes, click Save.

Check-out failure message settings

1 To specify the message to be displayed on TVs when Express checkout fails, enter a message in the Failure Message field.
) Select a location to display the message from Center/Left/Right.

3 To save the changes, click Save.



Special feature settings for 2014 widgets

Set the remote control hot key feature and the select channel feature. These features are provided only to 2014 widgets.
1 To set special features provided to 2014 widgets, click Setup > Configurables.

) Fillin the required input fields and click Save.

Setup Commeon Language

Loaded Project

Red Hotkey

Green Hotkey

Yellow Hotkey

Blue Hotkey

Power On IP O Yes ® No
Loaded Project View the widget type currently loaded.
Red Hotkey Set the feature to run when the red button is pressed on the remote control.
Green Hotkey Set the feature to run when the green button is pressed on the remote control.
Yellow Hotkey Set the feature to run when the yellow button is pressed on the remote control.
Blue Hotkey Set the feature to run when the blue button is pressed on the remote conttrol.

= Yes: Set the IPTV channel info to be displayed as the first page when aroom TV is
turned on.

Power On IP

= No: Set the main page of the selected widget type to be displayed as the first page
when aroom TV is turned on.



Monitoring

To view the TV network status and the room occupancy status, click Monitoring from the menu bar at the top.

= The Monitoring window will appear.

Monitoring

Interval: [EXTGRRG 2.0/Sec [Lastupdate. 13:12:10] (0.3) Stop

® OK/ Occupied Fail / Empty

Specify the monitoring update cycle using the dropdown list.

* The default cycle is set to Auto.

9 View the last monitoring update time. Click Stop if you want to stop monitoring.

9 View the room number, network status and check-in status for a TV connected to LSS.

If monitoring update has not been performed properly, click Sync to manually sync with PMS.

0 Note

PMS (Property Management System) refers to a hotel room management system. The system connects to LSS to provide necessary
information for hotel room management.



TV settings

To connect and manage a TV from LSS, first configure the TV settings. Configure the TV settings following the instructions below:

Note

The menu names, pages, or paths may vary depending on the TV model.

TV network settings

To connect a TV to LSS, make sure to configure the TV network settings.
Turnon theTV.

Press Mute > 1 >1>9 > ENTER on the Samsung remote control to enter factory mode.

— Inreset mode, the initial TV settings menu appears.

Select Network > Network Setup from the TV default settings menu.

MAIN:Opin, MODE:NONE, RES:NOSIGNAL, Standalone Menu

SI Veendor OFF Widget
Power On Sevice
Channel

Menu 0SD

Operation

Clock

Music Mode

External Device

External Source

Bathroom Speaker

Eco Solution

Logo/Message

When Complate, power down TV.




4 Select Network > Network Settings from the displayed network settings menu.

Network

Network Status

Network Settings
<

soft AP
- Network

AliShare Settings

Device Name [TV] Samsung

5 From the network settings page, select a network type (wired/wireless) and click Connect.

Wireless

VO
Ve v Wired m

6 Select IP Settings from the displayed network connection information page.

— The IP settings page will appear.



From the IP settings page, specify the IP settings including the TV IP address and subnet mask.

— Select Obtain automatically from IP Setting if you want the IP settings to be configured automatically. Select Enter
manually if you want to configure the IP settings manually.

Note

It is recommended to select Enter manually from IP Setting and manually configure the IP settings using a desired IP address.

IP Settings

IP Setting Enter manually

IP Address 123.456.7.89
Subnet Mask 100.100.100.0

Gateway 900.800.9.8

DNS Setting Enter manually
DNS Server 100.200.1.2

Cancel

Select OK to save the configured IP settings.

— The TV network settings are complete.



LSS IP settings required to connect TVs

After configuring the TV network settings, configure the LSS settings to enable LSS to recognize the TV. After configuring the
connection settings, it is possible to manage a TV after TV connection approval from LSS.

Turn on the TV.

Press Mute > 1> 1>9 > ENTER on the Samsung remote control to enter factory mode.

— Inreset mode, the initial TV settings menu appears.

Select Widget > License Server IP Setting from the TV default settings menu.

MAIN:Opin, MODE:NONE, RES:NOSIGNAL, Standalone Menu

Hospitality Mode Standalone Network
ST Vendor OFF

Power On Sevice
Channel

Menu 0SD

Operation

Clock

Music Mode

External Device

External Source

Bathroom Speaker

Eco Solution

Logo/Message

[ols

When Complate, power down TV.

In the displayed LSS IP settings page, enter the LSS IP address to be connected to the TV. Set the port number to 444.

Edit Sever IP

Server 1P :

Server Port Number :

<» Move @» Number (¥ Enter 'O Return

Select Enter to save the configured IP settings.

— The LSS settings from the TV are complete. LSS can recognize the TV now.



LSS IP settings required to distribute projects

Configure the LSS connection settings. Connection settings are required to distribute projects (widgets), IPTV channel groups or
messages from LSS to TVs.

Turn on the TV.

Press Mute > 1> 1>9 > ENTER on the Samsung remote control to enter factory mode.

— Inreset mode, the initial TV settings menu appears.

Select Widget from the TV default settings menu.

MAIN:Opin, MODE:NONE, RES:NOSIGNAL, Standalone Menu

Hospitality Mode Standalone Network
ST Vendor OFF

Power On Sevice
Channel

Menu 0SD

Operation

Clock

Music Mode

External Device

External Source

Bathroom Speaker

Eco Solution

Logo/Message

[ols

When Complate, power down TV.

Configure the following settings from the displayed widget settings menu.
— Set Widget Mode to ON.

— Set Solution Type to SINC Server.

— To use IPTV, set IPTV Mode to ON.

Note

Set IPTV Mode to OFF if you do not want to use IPTV channels. If OFF is selected for a TV, none of the IPTV channel settings configured from LSS
will be applied to the TV.

— Set Virtual Standby to ON or OFF.

Note

To reduce the time it takes to boot a TV, set Virtual Standby to ON. If Virtual Standby is set to ON, power consumption can increase.



MAIN:Option, MODE:NONE, RES:NOSIGNAL, Standalone Menu

Solution Type SINC Server
ServerURL Setting

License Server IP Setting

IPTV Mode

Virtual Standby

Room Num Setting

When complate, power down TV.

Select ServerURL Setting from the widget settings menu.

When the LSS IP settings screen appears, enter "http: //LSS IP address/browser" or "https: //SINC domain name.s-
hospitalitysolution.net:port number/browser" (e.g., https: //sinc.s-hospitalitysolution.net:444/browser) in the address input
window and select Done.

— The settings required to distribute a project are complete.

Note

If a distributed project is not found on a TV, check to make sure that the TV source is set to App TV hospitality Browser.

http://200.200.100.100/browser

< >

Cancel

(LA ML




Tutorial

Creating and distributing projects for VIP rooms

Explore the process to create and distribute TV widgets (projects) from LSS targeting guests staying in hotel VIP rooms.

Note

This tutorial assumes you are using a VIP room TV released in 2012 and the Widget 2012 [01] type.

Activating a menu language

Activate a language to use to configure projects.
1 Click Setup > Language > Language option from the menu bar at the top.

) Select alanguage checkbox and then click Enable from the displayed language activation window.

Select -
Language Main
(Main English) | Language On/Off - Language Template In use H

O English {on) (Main) In use

[ Afrikaans (on)

[ French [on)

Albanizn (of)

[ Amharic (0ff)

Arabic (Off)

[ Bulgarian (off)

Chinese (i0ff)

Croatian (off)

| vain | %
=




3 Click OK in the displayed activation confirmation window.

— The selected language will activate.

Note

The language that will be used to configure projects must be activated before creating a project.

Creating a project

Create a project for VIP rooms.
1 Tocreate a project, click Project Management > New Project at the top left.

) Configure the settings required to create a project from the displayed window.

Note

This tutorial assumes you are using a VIP room TV released in 2012 and the Widget 2012 [01] type.

New Project X

Name: [ VIP widget |

@® Blank O Default

WAERD

Widget 2011 [01] Widget 2012 [01] Widget 2012 [02]

O

=
Widget 2014 [A] Widget 2014 [] Widget 2014 [E]

Select Theme

®Default

v 0K

3 After configuring the required settings, click OK.



4 Click OK in the confirmation window if you want to create the project.

- The main page of the new project will be loaded on the screen.

B 7 =

f»ﬂ Note

For details on the settings required when creating a project, refer to the following: > Creating a project

Menu settings

Configure the menu settings for a VIP Widget project. Click Menu on from the left side of the page.

= The menu editor will appear.

User Menu(6)

Menu 1
Menu 2
Menu 3
Menu 4
Menu 5

Menu 6




Configure the settings for the top-level menus which appear on the main page of a project.
1 Right-click on Menu 1 from the top-level menu names in the menu editor.

) Select Rename from the context menu items.

ibd IR
User Menu(6)

Menul | g Menu [

Menu2 [Rename ()

Active

Menu 3 Add Sub menu I

Menu 4 | Menu Lock I
Menu up

Menu 5 I
Menu down

Menu 6 | Delste [

3 From the menu name settings window, specify the text size and menu name. Click OK.

| Edit Menu

Font Size 21px ¥

Current Title Menu 1

New Title Hotel Information

L

— The menu name will be updated. Specify the names of the other menu items using the same method.

oooana et~ |3 7 [e—

User Menu(6

Hotel Information

Menu 2
Menu 3
Menu 4
Menu 5

Menu 6

Hotel Information

Icon6

App6

© Left/Right [ Enter




4 To add a top-level menu, select a top-level menu name and click [zl from the menu editor.

— Atop-level menu section will be added in the menu editor.

Hotel Information %uu |—|A]Y]

User Menu(7)

Hotel Information
Menu 2
Menu 3
Menu 4
Menu 5

Menu 6

| Edit Menu7

5 Right-click on the new top-level menu section.

f Select Rename from the context menu items to specify the menu name using the previously mentioned steps.

— Configured top-level menus can be found on the main page.

e < | P =

[ &% I

Hotel Information Guest Service TV Channel Attractions

Icon6

App6

O Left/Right [= Enter




-

Sub-level/lower sub-level user menu settings

Configure the settings for sub-menus and lower sub-menus that are found under a top-level menu.
1 Right-click on a top-level menu in the menu editor.

) Select Add Sub menu from the context menu items.

v | EAEIED NN

User Menu(7)

Hotel Informat... &0

Guest id Add Menu

TV Channel Rename

Active

rope - [aaa s menuy |
Attractions Menu Lock

Menu up
Setup Menu down

Edit Menu7 | Delet®

— A sub-menu will be created.

e | OEHOEOD

User Menu(8)

Hotel Information @o

| Guest Service o0

47 Edit Menu o0
TV Channel o0
Apps o0
Attractions o0
Setup o0

Edit Menu7 @0




-

— Similarly, right-click on a sub-menu and select Add Sub menu if you want to create a lower sub-menu.

e | OEHOEOD

User Menu(9)
Hotel Information (& )
| Guest Service 0
4 Edit Menu Q0
B EditMenu @o
TV Channel 0
Apps ©0
Attractions 0
Setup ©0
Edit Menu? 0

3 Right-click on Edit Menu that has been created.

4 Select Rename from the context menu items to specify the menu name.

Edit Menu X

Font Size
Current Title  |Edit Menu ‘
New Title

Dining ‘




-

— A new menu structure has been created as follows:

I L

User Menu(19)

Hotel Information e 0

| Guest Service 0
Dining @ 0
LB ariske 00

> Continental e 0
The Park View e 0

Spa o0
Activities 00
l Swimming Pool @ o
Arcade e 0
Bil @0
TV Channel @ 0
Apps @0

[~ Attractions @ 0
‘ Surroundings @ o
‘ Downtown @ 0
Setup @0
Service @ 0

Basic menu settings

To use widgets released in 2014, configure basic menus after configuring user menus.

Note

For details on basic menu settings, refer to the following: ~ » Managing basic menus

For details on configuring project menu settings including the menu hierarchy, refer to the following:  » Project menu settings

Main page settings

Configure the main page settings of a TV widget for VIP rooms.

Note

For details on the main page settings such as the default image, text and background music, refer to the following:
» Main page settings for the default widget, Main page settings for the gallery widget




Tutorial

Menu page settings

Configure the settings for the menu pages that will be provided to users.

Specifying the default edit language

Specify the default edit language.
1 Click Setup > Language > Language option from the menu bar at the top.

] Select alanguage checkbox and then click Main from the displayed language selector window.

Language Option b4

Select -
:I::::Iish) ] Language On/Off = Lal:‘llgal.il:ge Template In use H
[ English (on) (Main) In use
& Afrikaans (on) In use
Albanizn (on) Inuse
O  Ambic (on) Inuse
O chinese (o) Inuse
Croatian (on) In use
O French {on) In us=
E  amharic (o) In usa

[  Bulgarian (off) In use i

e Lo Lo

3 Click OK in the displayed setting confirmation window.

— The selected language will be set as the default edit language.

Note

Default edit language refers to a language used to configure images to ensure a consistent language is used when editing menu pages. To use a
variety of languages when editing menus, refer to the following: B Selecting a menu page language




Tutorial

User menu page template and layout settings

Configure the template and layout settings for a menu page.
1 Click Menu on from the left side of the page.

) Click a menu item from the menu editor.

— The page settings window will appear.

Select Template W renutype | | 18 MenutistType O ocherType.

Full Contents Type. Full Video Type Full Multi Type

= T [ o
JH I B = E= BE BE = ) E=  HE
4 = { —l—l— 1Bl 3 ) — . >
— j [ .
3 i e © i

3 Select a template type to be applied to the page.

— Available template type choices vary depending on the menu type (top-level menu, sub-menu or lower sub-menu).

[ setct Tempate ]

4 Select alayout type to be applied to the page.
- Available layout type choices vary depending on the template type applied to the page.




— After a layout is selected, the detailed menu page settings window will appear as follows:

Layout Edit

Location:[o | x[0 | size: 400 |x[s20 | I~ Keep aspectorgimal rtioof theimace ([ (SN n =

Configure the menu page settings using text and content, such as images, videos and audio.

@ Note

Available content types and the availability of text can vary depending on the selected template and layout.

To insert an image, click the pencil icon above the image section in the menu page settings window.

Layout Edit

Location:[0  |x|0 | Size:[480 |x|520 |I” Keep aspect original ratio of the image ([T (U S n [ vpload |




Tutorial

) Select an image from the content list window. Click OK.

— The selected image will appear in the image section.

Location:[z[x[1_| sie: s |x[520 |~ Keep aspectorgnal rtio o hemace ([ (D i - ]

Edit text

{
\
oL
‘ i Edit text

A

3 Click the text section, and enter text.

oot o et x| | (D D D  i—]

The Representative Hotel Brand of Korea, The Shilla Seoul

4 To change text layout properties, click| %] in the desired text section.

— The selected text section properties such as the location will appear at the top of the menu page settings window.



5 Change the properties such as the text layout location/size, text alignment/size and text color. Click OK.
- The text layout will be updated according to the new settings.

- To cancel changing a layout and go back to the default settings, click Default.

Note

Image and video layouts can be changed using the same method.

[ o e s i ol o1 D D D | E — - |

6 To set the background music, click Upload on the right side of the menu page settings window.

7 Select a music file from the content list window. Click OK.

— The selected music will be set as the menu page background music.

Location:[505|xlo | swe:[a1s |x(ev |[ien [ [20mn [v]lzee] [ (D (D D | 13 [Tasscnss ml‘

8 After configuring the required menu page settings, click Save at the bottom of the page.

0 Click OK in the confirmation window if you want to apply the new settings.

— The new settings will be applied to the menu page.

Note

For details on components of menu pages, refer to the following: B User menu page settings




Tutorial

Selecting a menu page language

Configure different menu pages for each language by selecting a desired language.
1 Click Setup > Language from the menu bar at the top.

) Select alanguage from the Select Language dropdown list.

3 After configuring the required settings, click Save.

4 Configure menu pages for the selected language.

Note

« A new font for a language can be viewed after the corresponding project is distributed to TVs. To check the updated font when editing menu
pages, distribute the project to TVs.

- Images in menu pages can only be changed using the default edit language. This ensures a consistent language is used. For details on selecting
a default edit language, refer to the following: B Specifying the default edit language




Distributing a project

Settings before distributing a project

To distribute a created VIP Widget project to TVs in VIP rooms, connect the TVs to LSS first.

Configure the required TV connection settings.

Note

For details on TV settings, refer to the following:  » TV settings

Creating a recipient TV group to distribute a project

Projects are distributed by TV group.

Create a recipient group of TVs in VIP rooms to distribute a VIP Widget project to.

1 Click Group > Project Group from the menu bar at the top.

) Click Add below the list of project recipient groups.

3 Configure the settings required to add a group from the displayed window.

Add Project Group X

Group Name : | VIP Group |
() 2011 TV Models (®) 2012-2013 TV Models () 2014-2016 TV Models
&; 0
nselected IP: 1 Selected IP: 1
0 Pv Room w Py Room »
[ 192.168.0.12 2012 192.168.0.13 2013
< >
i Description : | The Project group for the VIP room's TVs |




Tutorial

Enter a group name for the TVs in VIP rooms.

Select the widget type (Other TV models) used on the TVs in VIP rooms.

To add a VIP room TV to the group, select a TV checkbox and click (3]

To delete a TV from the group, select a TV checkbox and click El

®@® 6 © © @©

Enter a brief description of VIP Group.

4 After configuring the required settings, click OK.
— VIP Group will be added to the list of project recipient groups.

Project Group || ot
| No Group Name - Description ~ | Deployed Project ~ | Deployed Date - | Widget Type -
2 VIP Group The project group for .. - - 2012
a 1 Standard Group The project group for ... DefaultHotel 2013-07-25 14:26 2012

1
s [

Distributing a project

Distribute a VIP Widget project to VIP Group, which is a group of TVs in VIP room:s.
1 Click Deploy > Deploy Project at the top left.

) Select VIP Widget from the displayed project list. Click Next.

Deploy Project [ Select Project > Select Group & Deploy

@ Select one of projects and dick next button.

Total (6) Project Title: l:l ﬂ
No Project Title + | widget Type | Date ~ | Deployed Date ~ ‘Group Name +
@ 6 CEO Widget Widget 2012 [01] 2013.07.25 14:32:20
@ 5 Standard Widget Widget 2012 [01] 2013.07.25 14:29:49
@ 4 VIP Widget Widget 2012 [01] 2013.07.25 13:41:21
(5] 3 2012 B_Type Widget 2012 [02] 2013.01.23 23:47:09
[ 2 2012_A_Type Widget 2012 [01] 2012.01.19 09:14:01
@ 1 DefaultHotel Widget 2011 [01] 2012.01.1821:19:55  2013.07.25 14:26:28 Standard Group

1

iy




Tutorial

3 Select VIP Group from the displayed TV group list. Click Deploy.
— The VIP Widget project can be used as a widget on all TVs in VIP rooms.

— The Deploy button will not appear until a recipient TV group is selected.

Deploy Project [ Selact Project » Select Group & Deploy

@ Click deploy button, then the project wil be deployed to the selected group.

Project title | Widget Type Deploy Status.
VIP Widget Widget 2012
. I —
| mo | Group Name | Deployed Date Deployed Project
2 ‘Standard Group 2013.07.25 14:26:28 Defaulttiotel b

1 WIP Group

Note
Check to make sure that the project has been distributed properly, using the following methods:
- Click Deploy > Project Deploy List on the left side of the page. Check that the VIP Widget project is in the list of distributed projects.

+ Turnon theTVsin VIP rooms and check that the main page of the VIP Widget project is displayed on the TVs.



-

IPTV news channel group settings and distribution

Explore the process to add and distribute a news channel or channel group to TVs.
Note

To distribute an IPTV news channel group to TVs, make sure the TVs are registered in PMS.

Registering IPTV channels

Register a news channel.

1 Click TV Management > Channel Management > Channels from the menu bar at the top.

) Click Add below the channel list.

Channel Management

Comnel it honnel o

J | No | channello~ |

[Gramaram 7] | [a]
Load

| Channel category « | Language |
50 Sports

Channel Name v

Englh

News English

(SRR i R ]

2 48
1 News

English Default

Total (3)

1
- | T I




3 Configure the settings required to add a channel from the displayed window.

3 Add Channel

1 1. Channel Number * 48

V2> Channel Name * BBF

K. Channel 17 10 || 10|, | 10|, |123
4 4. Channel Port * 8201

LY)s. Channel Categary * News v
6 6. Channel Language * English v
[D):. 2udio Delay * 100

8 3. Channel Payment * ® Free Pay

D). select EPG EPG

Enter an IPTV channel number.

Enter an IPTV channel name.

Enter the IP address of the IPTV channel.

Enter the port number of the IPTV channel.

Select News as the IPTV channel type from the dropdown list.

Select an IPTV channel language from the dropdown list.

Select whether to provide the IPTV channel for free or for a charge.

Import EPG info for the IPTV channel.

® ©¢ ©¢ ¢ 6 6 © © o

For details on EPG info, refer to the following: B Creating EPG data

4 After configuring the required settings, click OK.
— The channel will be added.

Specify the Audio Delay value used to manually sync the IPTV audio and video.



Tutorial

IPTV channel group settings

Make a group of news channels.
1 Click TV Management > Channel Management > Channel List from the menu bar at the top.

) Click Add below the channel list.

Channel Management |Mwm“mmwm“ Remote Control || 1v il Hanagement |
e — - |
O | N | List Name w | Channels | Register Datew Deploy Status v | Deployed Datew | EPG view
(J 2 IPTV Channel 002 2 2014-04-23 00:32 - - EPG
1 IPTV Channel 001 2 2014-04-22 09:30 Channel_Group001 2014-04-22 09:33 EPG
1
i ==

3 Configure the settings required to add a group from the displayed window.

Channel Management I Message Management “ Information Management “ Remote Control “ TV File Management ‘
List Name : ﬂNews ‘
L2 3 o
Number + Name « Number = Mame «
1 i - 5 CNEMNe.,
0 ACE 48 BEF
-—— -
(1) Enter News as the IPTV channel group name.
0 To add a news channel to the group, select a channel from the list and click .
(3] To delete a news channel from the group, select a channel and click [<].

4 After configuring the required settings, click OK.

— A new IPTV channel group named News will be added.



Creating a recipient TV group to distribute an IPTV channel group

Channel groups are distributed by TV group.

Create a recipient group of TVs to distribute a news channel group to.
1 Click Group > Channel Group from the menu bar at the top.

) Click Add below the list of IPTV channel recipient groups.

Channel Group rosscon | o maenns o ([RERERIR
O | ne Group Name Description v Deployed Project = Deployed Date v
a 1 Channel_Group0d01 Channel Group 001

1
i ——

3 Configure the settings required to add a group from the displayed window.

Add Channel Group X
?Smup Name | News Group |

(2011 TV Models (@ 2012-2013 TV Models (0 2014-2016 TV Models

gnselected IP: 1 eelected ;p:1
| Py Room - g Py Room ~
[ 192.168.0.12 2012 = 182.168.0.13 2013
< >
?Description | News Group for buisiness rooms |

o Enter News Group as the IPTV channel recipient group name.

6 To add a TV to the group, select the IP address of a TV and click | /.



Tutorial

9 To delete a TV from the group, select the IP address of a TV and click El

9 Enter a description of the IPTV channel recipient group.

4 After configuring the required settings, click OK.

— A new IPTV channel recipient group named News Group will be added.

Distributing an IPTV channel group

Distribute a news channel group to News Group.
1 Click Deploy > Deploy Channel from the menu bar at the top left.

) Select News from the displayed IPTV channel group list. Click Next.

- Click a channel group name from the list to proceed to the next step.

Deploy Channel [ Select Project > Seiact Group & Deploy.

@ Select a channel, then dick Next button.

Total (2) e |
No Channel List ~ | Channels + | Register Date ~ Group Name + | Deployed Date ~

Le] 2 Sports 3 2013-07-24 10:34

@ 1 News 3 2013-07-24 09:44

=y

3 Select News Group from the displayed IPTV channel recipient group list. Click Deploy.

— The channels in the distributed channel group are accessible from all the TVs under the selected IPTV channel recipient
group.

— The Deploy button will not appear until an IPTV channel recipient group is selected.

Deploy Channel [ Select Project > Select Group & Deploy

@ Cick deploy button, then the Channel will be deployed to the selected group.

Channel List | Register Date Group Name
News 2013-07-24 09:44
Tota ) o I |
| Mo | Group Name v Deployed Date v | Deployed Channel List v

o 2 Sports Group

@ 1 News Group

=




Note

Check to make sure that the IPTV channel group has been distributed properly, using the following methods:
+ Click Deploy > Channel Deploy List on the left side of the page. Check that the News channel group is in the list of distributed channel groups.

« Turn off the TVs in VIP rooms and then turn on again. Check that the distributed news channels are displayed on the TVs. TVs update TV
information, such as the channel list and firmware version, while the power is turning on. Make sure to turn off the power and then on again.

Weather application auto-run menu settings

Using the MyApp Type layout, create an auto-run menu page to make a specified TV application run automatically.

In this section, learn how to make the weather application run automatically by creating a menu page named Apps and then
selecting the created menu from a TV widget.

First, information on the application list saved on a TV will need to be registered in LSS and then distributed to the other TVs.

Note

The menu to automatically run a TV application using MyApp Type is only available on TVs released in 2013.

Copying application list info saved ona TV

1 Connect a destination USB memory device to the TV.
) TurnontheTV.

3 Press Mute > 1>1>9>ENTER on the Samsung remote control to enter factory mode.

— Inreset mode, the initial TV settings menu appears.
4 Select Network > Apps Edit from the TV default settings menu.
5 When alist of applications appears, select More Apps.

6 When the application configuration page appears, select Options > Clone TV to USB.
— Files that contain information on the TV application list will be copied to the USB memory device.

— Remember the location of the weather application on the list. The location is needed when configuring auto-run settings.

Note

Assume that the weather application is the second item on the list.

7 After the information is copied, turn off the TV and then on again.



Tutorial

Uploading copied TV application list info to LSS

1 Connect the USB memory device that contains copied information on the TV application list to the computer.
Access the LSS webpage.
Click TV Management > TV File Management > TV Configuration from the menus at the top of the LSS page.

Click Add below the list of TV configuration files.

o AW N

Configure the settings required to add a TV configuration file from the displayed window.

— Using the file upload option, upload the files that contain information on the TV application list.

Note

For details on how to configure settings from the window used to add TV configuration files, refer to the following: ~ » Adding TV configuration files

6 After configuring the required settings, click OK.

— After files are uploaded successfully, the TV application list information will be automatically distributed to the TV models
that were specified in the window used to add configuration files.

"g Note

Using LSS logs, check to ensure that the files have been distributed successfully to TVs. For details on how to view distribution logs for TV
configuration files, refer to the following: B Checking the result of TV configuration file distribution




Tutorial

Creating a TV application auto-run menu

1 Import a project to create an auto-run menu to the LSS page.
Note
For details on how to import a project, refer to the following:  » Loading/deleting a project
) Create a new menu page named Apps.
— To use a previously created menu page, select the desired menu page.
Note

5
6

For details on creating and editing a menu page, refer to the following: ~ » Managing user menus

Select MyApp Type from the page layouts found in the menu page configuration screen.

- Template type where MyApp Type is found varies for each widget type.

Select 2nd from the dropdown list showing the arrangement of TV applications.

- The weather application that is the second item on the TV application list will be set to run automatically.

Select Template | EMenutistiye | | B Rl | | D Othertipe |
Menu Contents Type Bill Type MyApp Type
4 3 3 - = P P i
i T H — H — i
< T I ‘s I T T | | B E
] g | E T r | H g
® © 5} ) 5} ) e [ e i e

umsemnw

To save the changes, click Save.

Distribute the project.

Note

7 Select Apps from the widget menus on the TV to check to ensure that the weather application runs automatically.

For details on how to distribute a project, refer to the following: ~ » Distributing a project




Changing the arrangement of TV applications

Customize the arrangement of TV applications according to your preference.

"g Note

+ To apply a new arrangement of applications to the application auto-run menu, copy and then distribute the list information again.

« The arrangement of applications shown in the application section of the default page will also be updated according to the customized order.

e 7 =

WESHILLA
|

THESHILLA

Hotel Guest
Information Service

Attractions

Icon6

Appé
Left/Right Enter

1 TurnontheTV.

) Press Mute > 1>1>9 > ENTER on the Samsung remote control to enter factory mode.

— Inreset mode, the initial TV settings menu appears.

Select Network > Apps Edit from the TV default settings menu.

S~ w

When a list of applications appears, select More Apps.
When the application configuration page appears, select Options > Edit My Apps.
Select an application to rearrange from the displayed My Apps list.

Move the application to the desired location using the arrow buttons on the remote control and then press ENTER.

coO N oy o

After rearranging applications as desired, turn off the TV and then on again.



Using the IPTV function only

To only use the IPTV function without creating a project in LSS, obtain a free license to access the IPTV channel-related menus
and the function to distribute channels without time limits.

1 Onthe LSS screen, click License > License List > Free License and obtain a IPTVOnly type free license.

@ Note

For further details on obtaining a free license, refer to the following:  » Using a free license

7 Turn on the TV where you will use the IPTV function, then connect a USB storage device to the TV.

3 Press Mute > 1>1>9>ENTER on the Samsung remote control to enter factory mode.

— Inreset mode, the initial TV settings menu appears.
4 Select Widget from the TV default settings menu.
5 Select ServerURL Setting from the widget settings menu.
When the LSS IP configuration screen appears, delete all the address input fields. Next, select Done.
Press Return on the Samsung remote control to return to the initial TV setup menu.

Select Cloning from the TV default settings menu.

O o0 N O

Select Clone USB to TV to save TV information onto the USB storage device.
10 Connect the USB storage device containing the saved TV information to the LSS.
11 Onthe LSS screen, click TV Management > Channel Management > Channel List.

12 Select a channel and click Clone To USB.

— Information about the selected IPTV channel group will be saved as a zipped file.

13 Unzip the downloaded IPTV channel group information file.

— The HospitalityBrowser folder will appear.
14 Copy the HospitalityBrowser folder as a child folder under the TV information folder on the USB storage device.
15 Connect the USB storage device containing the copied IPTV channel group information to the TV.
16 Press Mute > 1> 1> 9> ENTER on the Samsung remote control to enter factory mode.
17 Select Cloning from the TV default settings menu.

18 Select Clone USB to TV to save the channel information from the USB storage device to the TV.

— Use the IPTV channel function on the TV.



Data backup

Back up database and data files in LSS.

Database backup and restore

Back up or restore database in LSS using the CUBRID manager program.

Database backup

1 Download and install the latest version of the CUBRID manager install file from the following path:

- http://ftp.cubrid.org/CUBRID_Tools/CUBRID_Manager/
) After the installation is complete, run the program.

3 Right-click on the HOTELTV database name and select Manage Database > Backup Database.

< CUBRID Manager - s T ON]icharset=UTF-8 = | B )
File Edit Tools Action Help
- . -
L [<al <
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Data backup

4 Select the Delete unnecessary log-archives checkbox. Click OK.

2
< o ol s
Backup Information Back Ewhﬂnﬂnaﬁnnl

Database name:  hoteltw

Volume name: hoteltv_backup_h{

Backup level:  [Leveld -
Backup directory:  C:\CUBRID! databases\hotelt\backup Browse...

Parallel backup: 0 E

[#] Check the database consistency

[] Delete unnecessary log-archives

Compress backup volumes

| OK I Cancel

5 Specify the destination backup folder. Click OK.
— The HOTELTV database will start the backup process.

Database restore

1 Torestore the HOTELTV database, run the CUBRID manager.

) Right-click on the HOTELTV database name and select Stop Database.

< CUBRID Manager - admin@Iocalhost8001 / dba@hoteltviquery_editor[30000/ON]:charset=UTF-8. o=l
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£l Import Schema on ERwin XML... - 1B0% 442667 273288
o Import..
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Data backup

3 Go to the path C:\CUBRID\databases\hoteltv and delete all files except the lob folder. The path is created in the C drive when
CUBRID is installed.

Note
Assume that the path to the CUBRID folder is the C drive.

4 Right-click on the HOTELTV database name and select Manage Database > Restore Database.

e
T e
File Edit Tools Action Help
. % . &. . % . @ _| Searchin cUBRID0rg IEY
Add Host... | Start | Ouery Editor Data Pro Tools Users  Datsbase Help ‘Search the CUBRID Site:
MDashhm.d] ¥ = O)(@ Notice Dashboard localhost £2 =0
[ JCOG® B Hut-leuho Culio
4 E] localhost Database Volumes |
“ 'ﬁ'élﬂ":’“’zh Database Data (U/T/F) Index (UFT/F) Temp (U/T/F) Generic (U/T/F)
emor
= Rt - 0.7M/22.5M / 96% 11IM/128M /91,
4 'E4 Brokers 1 Login Database l
i v
> &8 brok (1] Edit Database Login...
-':ﬁ “:‘ %' Export Connections to JDBC/CCIURL...
< filq Honeol ORT AS JQ REQ TPS QPS LONG-T LONG-Q ERR-Q
> iilla Stat{ 7] New Query Editor CrlsT sTolo 1o To  lo . N
o il Syst 50000} 0/60000
. &;y 7] Show Database Dashboard §) | Lowd Database.. 20 0/60000 0/60000 O
b 43 Brok __ .
» v P@ Schema CnmpﬂlTWrzﬂld... {5 Unload Database... Ty T——— -
» [ sery BB Data Compare Wizard... Optimize Database... Tps s
EN  Export Schema to ERwin XML... It} Compact Database... S0 3103 =
Eff Import Schema on ERwin XML... [§ Check Database... 442667 273288
i fdiy —
. Import {8 Rename Database...
| Bxporting table definitions to excel.. |3 Backup Database...
Ll @ st Table Descriptions % Restore Database...
[ coay) :ﬂ |/} Manage Database ¥ | [ Delete Datsbase...
e [§} Start Database
PK  Column Na [ Databaselnfo 3
41.1018) (32bit release build for Windows_NT) (Feb 26 2012 13:06:24)
° Properties ALT+ENTER
es
g | C Refreh 5 I
il
‘ | edi..ONJ:charset=! ECEL

Deselect the Select restore date and time checkbox in the database restore window.
Select the Select available backup information checkbox.

Select Level O file.

Click Browse... to select a backup file to be restored.

Click OK to start database restore.
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Data backup

LSS data file backup

Back up channel information, content files, TV firmware and TV license data files saved in LSS.
1 Goto C:\HotelTV\htdocs\data, which is the destination folder created in the C drive when LSS is installed.

Note

Assume that the path to the HOTELTV folder is the C drive.

'\ channel
W files

L firm

! license
channel This folder holds channel setting files including the ChannelMap.xml file.
files This folder holds content files that are used when editing a project.
firm This folder holds TV firmware files.

license This folder holds TV License Key files.

) Zip the folders you want to back up and save the folders to the desired location.



Troubleshooting

In the occurrence of a problem when using LSS, resolve the problem according to the troubleshooting guide below.

Resolving a failure involving message transmission, TV
power control or channel list transmission

If the function to send messages, control the power supply to TVs or send channel lists does not work properly, restart Socket,
register the Apache in firewalls or disable firewalls to resolve the issue.

Restarting Socket monitoring

1 Torestart Socket monitoring, right-click on the ' = icon on the computer task bar.

AutoReStart

E,I._.I,._. ':"“I'
SENVILE Slall

Service Restart

Service Stop

E  Exit

) If the Service Start item is active, click Service Restart.

— Socket monitoring will restart.



Troubleshooting

When the Socket monitoring icon is not found on the task bar

1 Go to C:\HotelTVAhtdocs\bin, which is the destination folder created in the C drive when LSS is installed.

Note

Assume that the path to the HOTELTV folder is the C drive.

7 Double-click HotelCMSMonitor.exe.

— When the icon appears on the task bar, restart Socket monitoring.

Registering the Apache server in firewalls

If there is an issue with transmitting messages/channel lists or a problem with TV power control persists after restarting Socket
monitoring, register the Apache server in the inbound and outbound rules of Windows Firewall.

Adding inbound rules

1 Onthe computer, select Start > Control Panel > Windows Firewall > Advanced settings.

Note

The Control Panel path is based on the icon view mode.

) Select Inbound Rules, and click New Rule.

e S 1~

File Action View Help

=260 = 86

o h e Actons
= e Group . Profle  Ensbled  Action *
che erver Private  Yes Alow |7 e v
Al Yes Allow
Al Yes Allow T Filter by State >
All Yes Allow W Filter by Group 4
Al Yes Allow View »
Al Yes Allow
i Yes Allow Refresh
Private  Yes Alow || BportList..
Private  Ves Allow Help
Private Mo Allow
@ Dacmonu.exe Private  No Allow
Java(TM) platform SE binary Al Yes Allow
Java(TM) Platform SE binary Private  Yes Allow
Java(TM) Platform SE binary Private  Yes Allow
oo Al Yes Allow
i Private  Ves Allow
Private  Ves Allow
Preview Private  Ves Allow
Preview Private  es Allow
Player Private  Ves Allow
Player t Private  Yes Allow
Player ran... Private  Ves Allow
Player - DLFileTran... Private  Ves Allow
Private  Ves Allow
Private  es Allow
I Private  VYes Alow
<l 3 ki o M




Troubleshooting

3 Select Program, and click Next.

Rule Type
Select the type of firewall rule 1o crate.

Steps:
o Fule Tyne What type of rule would you like fo create?
@ Program
@ Action Program
Rule that sontrals connestions for a program.
o Profie
Port
@ MName Rule that controls connections for a TCP or UDP port,
© Predefined:
[BranchCache - Content Retreval Uses HTTP) =
Fule that contrals connections for a Windows experience.
© Custom
Customn rule.

Learn more about rule tupes

[ <Back |[CNext> J [ Cancel ]

4 Select This program path, and click Browse.

|

Program
Specify the full program path and executable name of the program that this rule matches,

Steps:
» Fule Type Does this rule apply to all programs or a specific program?
» Program
@ Action Al programs

Rule applies 1o all connections on the computer that match ather rule properties,
@ Profile
@ Name © This proaram path:

| S
Example ::WpathEmgram‘ExE
#ProgramFiles %Whrowseritbrowser exe

Learn more about specifying programs

[ Back | [ Mest> ] [ Cancel ]

5 Goto C:\HotelTW\Server\Apache\bin, which is the destination folder of Apache when LSS is installed.

Note

Assume that the path to the HOTELTV folder is the C drive.



Troubleshooting

6  Select httpd.exe, and click Next.

Program
Specity the full pragram path and executable name of the program that this rule matches

Steps:
@ Fule Type Daes this rule apply to all programs or @ specific program?
@ Program
@ fction © Al procrams
Fule applies to all connections on the computer that match other rule properties,
@ Profile
@ Name (@ This proaram path:
%Sy stemDrive % WHolel TV S arve i Ap inhitpd, exe [Browse
Example citpathitprogram exe

#ProgramFiles %Whrowseribrowser, exe

Learn more about specifying programs

[ Back | Mext> | [ Cancel ]

7 Select Allow the connection, and click Next.

Action
Specify the action 10 be taken when a connection matches the conditions specified in the nle,

Steps:

@ Fule Type What action should be taken when a connection matches the specified conditions?

o Frogram

- © Allow the connection
@ Action This includes connections that are protected with IPssc as well as those are not
o Profi
roe (©) Allow the connection if it is secure

o MName This includes enly connections that have been authenticated by using IPsec, Connections

il be sccured using fe sefings n Psec praperties and ies n e Cannection Securty
Ule node

©) Block the connection

Learn more about actions

[ Back | [ Mest> ] [ Cancel |

§ Select the Domain, Private and Public checkboxes. Click Next.

Profile
Specify the profiles for which this rule applies,

Steps:
o Fule Type When does this rule apply?
» Program
o fction ] Domain
) Applies when a computer is connected to its corporate damain
w Profile
@ Mame iz
Applies when a computer Is connected to a private network location,
Public

Applies when a computer is connected to a public netwark lncation,

Learn more about profiles




Troubles

hooting

O Enter a rule name and description. Click Finish.

Steps:

Fule Type
Program
Action

Profile

Narne

Specify the name and description of this mle,

Mame!

Apache_Inbound_Rule

Description {optional):

Inbound rule for firewsall,

[

< Back

J[_Finish_] [

Cancel

]

Name

Adding outbound rules

1 Onthe computer, select Start > Control Panel > Windows Firewall > Advanced settings.

7 Select Outbound Rules, and click New Rule.

3

Fil

Action View Help

g i )

m Security Rules
» &, Monitoring

1@ BranchCache Content Retrieval (HTTP-O...

1@ Connect to o Network Projector (WSD
1@ Connect to o Network Projector (WSD
1@ Connectto s Network Projector (WSD

Name

ranchCache Hosted Cache Client (HTT...
ranchCache Hosted Cache Server(HTTP...

1@ BranchCache Peer Discovery (WSD-Out)

Connectto 2 Network Projector (TCP-Out)
Connectto 2 Network Projector (TCP-Out)
Connectto a Network Projector (WSD Ev...

Connectto a Network Projector (WSD-Ohu.

Group . Profile
BranchCache - Content Retr.
BranchCache - Hosted Cach,
BranchCache - Hosted Cach...
Branchtache - Pesr Discove..
Connect to a Netuork Proje
Connect to a Netuork Proje
Connect to a Netuork Proje
Connect to a Netuork Proje
Connect to a Netuork Proje
Connect to a Netwark Pr
Connect to a Network Proje.. Al
s .

Core

9
Core Networking -
Core Networking -
Core Networking -
Core Networking -
Core Networking -
Core Netwarking -
Core Networking -
Core Networking -
Core Networking -
Core Networking -
Core Networking -
Core Netwarking -
Core Networking -
Core Networking -
Core Networking -

Dynamic Host Config..

Dynamnic Host Cont
Group Policy (LSASS-...
Group Policy (NP-Out)
Group Policy (TCP-0...
Intemet Group Mana...
TPHTTPS (TCP-Out)
1Pu6 ([Pr6-Out)
Multicast Listener Do...
Multicast Listener Q
Multicast Listener Rep.
Multicast Listener Rep.
Neighbor Discovery A.
Neighbor Discovery

Packet Too Big (ICMP...

Al
Core Networking Al
Core Netwerking Al
Core Networking Domain
Core Networking Domain
Core Netwarking Domain
Core Networking Al
Core Networking Al
Core Networking Al
Core Netwerking Al
Core Networking Al
Core Networking Al
Core Networking Al
Core Networking Al
Core Networking Al
Core Netwerking Al

Enabled
Mo

P Windows Firewall with Advanc] [ ]

Action
Allow
Allow
Allow
Allow
Allow
Allow
Allow
Allow
Allow
Allow
Allow
Allow
Allow
Allow
Allow
Allow
Allow
Allow
Allow
Allow
Allow
Allow
Allow
Allow
Allow
Allow
Allow

D

Filter by Profile
T Fiter by State
T Filter by Group.

View
Refrech
[ ExportList...

Help

=

From this step, the same instructions used when adding inbound rules apply. Go to step 3 in the instructions on how to add

inbound rules.




Troubleshooting

Registering communication ports

Registering a TCP port

1 Onthe computer, select Start > Control Panel > Windows Firewall > Advanced settings.

Note

The Control Panel path is based on the icon view mode.

) Select Inbound Rules, and click New Rule.

N
N T Filter by Profile »
Piate Vs Alow N 00t [ @ e orsine .
Prte s Alow N Crpror
Prite Vs Alow N Cuvon || 7 Fiterby Group. >
Prvte Yo Alow N s View y
A v Alow N oo || @ Reben
Prte Yo Alow N Chuser ]
b Ve Mlow No s :’“"““
Fwerid Private Ves Alow N CAprod o
FWGrid Private  Ves Alow N Capros
Piate Yo Alow N o
Prste s Alow N Crpror
A Ye  Alow N g
Al e Alow N oo,
Prite Vs Alow N apror
Privste Yer  Alow  No Chpror
Prite Vs Alow N Capror
Prte Yer  Alow N Chpror
Privte Yes  Alow N oo
P Ve Alow N Crpron
Prste Ve Bock N Cuuser
Prate Yo Bock M Chuser
A Ve Alw N Ay
A ve  Alow N any
Al e Alow N Ay
A v Alow N any
A e Alow N Ay
A v Alow N any
A Ve Alow N Ay
A v Alow N any
] ink HTTP. . Al Yes Alow N Ao

3 Select Port and then click Next.

(Cmrrr= S o

Rule Type
Select the type of firewall rule 1o crate.

Steps:

> b T What type of rule would you like to create?
@ Protocol and Paris
@ Action Program

Rule that controls connections for a program.
o Frofile

Port
@ MName Rule that controls connections for a TCP or UDP port,

@ Predefined:
[BranchCache - Content Retrieval (Uses HTTP) ~
Rule that contrls connections for @ Windows experience.

© Custom
Customn rule

Learn more about rule tupes

[ <Back  |[LMest> J [ Cancel ]
le

4 Select TCP and then enter 444, 30000-30005 in the Specific local ports field.



Troubleshooting

5 Click Next.

Protocol and Ports

Specify the protocols and ports ta which this rule applies

Steps:

o Fule Type Does this rule apply ta TCP or UDP?

@ Protecel and Ports © TCP

@ fction © uop

o Frofile

® Mame Does this rule apply to all local ports or specific local ports?

© Al local ports.

© Specific local ports: 444 30000-30008
Example: 80, 443, 5000-5010

Learn more about protocol and ports

[ Back | [ Hext Iri( Cancel |

f  Select Allow the connection, and click Next.

@ rcrmorins N

Action
Specify the action 10 be taken when a connection matches the conditions specified in the nle,

Steps:
@ Fule Type What action should be taken when a connection matches the specified conditions?
@ Protocol and Peris
. © Allow the connection |
@ Action This includes connections that are protected with IPssc as well as those are not
o Profi
roe (©) Allow the connection if it is secure

o MName This includes enly connections that have been authenticated by using IPsec, Connections

il be sccured using fe sefings n Psec praperties and ies n e Cannection Securty

Ule node

©) Block the connection

Learn more about actions

[ Back | ggggd( Cancel |

7 Select the Domain, Private and Public checkboxes. Click Next.

Profile
Specify the profiles for which this rule applies,

Steps:
o Fule Type When does this rule apply?
@ Protocol and Ports
o fction ] Domain
) Applies when a computer is connected to its corporate damain
w Profile
@ Name Private
Applies when a computer Is connected to a private network location,
Public

Applies when a computer is connected to a public netwark lncation,

Learn more about profiles

Jﬁﬁ_%duﬂl_




Troubleshooting

8  Enterarule name and description. Click Finish.

(Commrr= s

Name
Specify the name and description of this mle,

Steps:

@ Fule Type

@ Pratocal and Perts
Action

-
o Frofie Lz
-

TCP_Port LSS
Narne

Description toptional):
TCP Portfor LSS

[ Back | FEinish I.i( Cancel |

Registering a UDP port

1 Onthe computer, select Start > Control Panel > Windows Firewall > Advanced settings.

Note

The Control Panel path is based on the icon view mode.

) Select Inbound Rules, and click New Rule.

Windows Firewall with Advanced
Jaiiemictionmyvie gt i
e 2@ = BE
8 ool Advenc]
Name. Group Pofie  Ensbied  Action  Overide Prog
5 = A v Mew N cus
+ % Monitoring Al e Alw Mo CAse|=|[F7 Fiter by profie »
Piste Ve Alow N 0ol 1l 7 sy sene )
Piate Ve Alow N el | e "
Pt Yes  Alow N ot iter by Group
Piate Ve Alow N Cihon View »
Al Ve Alw N Crpror Refresh
Pigte Ve Alow N Chuser .
b
FWGrid Private  Yes Alow N Capror °
PGrid Piate Ve Alow N Cipror
Piate Ve Alow  No Chpror
Piate Ve Alow N Cipror
Al e Alw N Mg
Al Ve Alow N Crpror
Piste Ve Alow N Capror
Piate Ve Alow N Cipror
Pite Ves  Alow  No Capror
Piate Ve Alow N Cipror
Pite Ves  Alow N Capror
Piate Ve Alow N Cipror
Piate Yes  Bock N Chuser
Pite Ve Bock  No Chuse
Al Ve Alow N Any
A Ve Alw N Ay
Al e Alow N any
A Ve Alow N Ay
Al Ve Alow N Any
Al Ve Alow N Ay
R Any
Al Ve Mlow N Ay
: @ . Al e Mlow N Ao




Troubleshooting

3 Select Port and then click Next.

Rule Type
Select the type of firewall rule 1o crate.

Steps:
» Fule Type What type of rule would you like to create?
@ Pratocel and Perts
@ Action
Profile

Proaram
Rule that sontrals connestions for a program.
-
© Port
@ MName Rule that controls connections for a TCP or UDP port,
© Predefined:
[BranchCache - Content Retreval Uses HTTP) =
Fule that contrals connections for a Windows experience.

© Custom
Customn rule

Learn more about rule tupes

[ <Back  |[LMext> J [ Cancel ]
5]

4 Select UDP and then enter 30000-30005 in the Specific local ports field.

5 Click Next.

Protocol and Ports
Specify the protocols and parts 1o which this rule applies.

Steps:

o Fule Type Does this rule apply ta TCP or IDP?

& Protacel and Ports © TcP

& Action © upp

@ Prafile

@ Name Does this rule anply ta al local ports o specific local ports?
© Al local ports
® Specific local ports: 30000-30005

Example: 80, 443, 5000-5010

Learn more about protocel and ports

[ Back | ggégtl Cancel |

f  Select Allow the connection, and click Next.

Action
Specify the action 1o be taken when a connection matches the conditions specified in the rule.

Steps:
@ Rule Type

@ Pratocel and Ports
N @ Allow the connection
@ fction This includes connections that are protected with IPsec as well as these are not,

What action should be taken when a connection matches the specified conditions?

@ Frofle (©) Allow the connection if it is secure

@ Mame This includes gnly connections that have been authenticated by using IPsec, Connections

;\/HI\ be Eﬂ&:uv!d uzing the settings in IPsec properties and rules in the Connection Security
Ule node

©) Block the connection

Learn more about actions

[ Back | [ Hext> ([ Cancel |




Troubleshooting

7 Select the Domain, Private and Public checkboxes. Click Next.

Profile
Specify the profiles for which this rule applies.

Steps:

@ Fule Type \then does this rule apply?

@ Proweol and Paris

@ Aion oijDocse)

; Applies when a computer is connected to its corporate domain

o Profile
[7] Private

@ Mame Applies when a computer is connected to a private network location
[¥] Public

Applies when a computer is connected to  public network location

Learn more about profiles

8  Enterarule name and description. Click Finish.

Name
Specify the name and description of this nule,

Steps:

@ FRule Type
Frotocol and Ports
Action

-
-

o Frofie ames
-

UDP_Port LSS

Narne
Description (optional):
UDP Paort For LSS

[ cBack J[_Ewish I [ Cancel ]




Troubleshooting

Disabling firewalls

1 From the PC, go to Start > Control Panel > Windows Firewall > Turn Windows Firewall on or off.

) Select Turn off Windows Firewall (not recommended) under Home or work (private) network location settings.

@ » ContiolPonel » , » Customize et < [ | Scarch Contrt panet 5

Customize settings for each type of network

What are network locations?

Home orwork private) netwerk location setings
@ O Tum on Windoves Frswsl

i ]
Notify me when Windows Firewal blocks a new program

) © Tum it Windows Freal ot ecommended)

@ © TumonWindows Freval

al
(9] Notity me when Windows Firewal blocks a new program
O Tumoft Windows Frewl (ot ecommended)

[k [ G ]




If aTV cannot turn on or off, resolve the issue following the steps below.

To use the remote power control function, first enable the Virtual Standby function on the TV while in factory mode.

To enter factory mode, press Mute > 1 > 1 > 9 > Enter on the TV remote control.

— Inreset mode, the initial TV settings menu appears.

Set Widget > Virtual Standby to On from the TV default settings menu.

MAIN:Option, MODE:NONE, RES:NOSIGNAL, Standalone Menu

Widget Mode OFF
Solution Type SINC Server
ServerURL Setting

License Server IP Setting

IPTV Mode

Room Num Setting

When complate, power down TV.

Turn off the TV.

— The changes will be saved.

The remote power-on function (Wake On Lan, hereinafter WOL) is used to control a device by sending a magic packet to a
network via a UDP port.

Generally, the WOL packet operates when the network addresses of a sender device (LSS) and recipient device (TV) are set to

Class C Subnet of the same Gateway. To send the WOL packet to Class C Subnet of a different Gateway, enable UDP port forward
from the router.

If the function to turn on TVs does not work properly, contact the network administrator.

Example [f the IP address is "192.168.10.122", configure the subnet according to the following subnet addresses for each class:
= (Class A Subnet: 0.0.0.0 ~ 127.255.255.255
= (Class B Subnet: 128.0.0.0 ~ 191.255.255.255
= (Class C subnet: 192.0.0.0 ~ 233.255.255.255



Resolving a project distribution failure

If a project created in LSS cannot be distributed to TVs, resolve the issue following the steps below.

Resolve a project distribution issue by changing TV settings while in factory mode.
Press Mute > 1 > 1> 9 > Enter on a Samsung remote control to enter factory mode.

= Inreset mode, the initial TV settings menu appears.

In factory mode, select Network > Network Setup.

MAIN:Opin, MODE:NONE, RES:NOSIGNAL, Standalone Menu

SI Vendor OFF Widget

Power On Sevice
Channel

Menu 0SD

Operation

Clock

Music Mode

External Device

External Source

Bathroom Speaker

lution

When Complate, power down TV.

Select Network > Network Settings from the displayed network settings menu.

Network

Network Status
Network Settings

soft AP

AllShare Settings

Device Name [TV] Samsung




From the network settings page, select a network type (wired/wireless) and click Connect.
Select IP Settings from the displayed network connection information page.
Configure the IP settings including the IP address and subnet mask.

Select OK to save the configured IP settings.

In factory mode, select Widget > License Server IP Setting.

MAIN:Opin, MODE:NONE, RES:NOSIGNAL, Standalone Menu

Hospitality Mode Standalone  Network
SI Vendor OFF

Power On Sevice
Channel

Menu OSD

Operation

Clock

Music Mode

External Device

External Source

Bathroom Speaker

Eco Solution

Logo/Message

When Complate, power down TV.

Enter the IP address and port number of LSS. Press Enter on the remote control.

Turn off the TV.

— The changes will be saved.

After configuring the network and widget settings, check to make sure that the TV has been added to TV List in LSS.



Resolving a content file upload failure

The content file upload function uses Adobe Flash Player.

To install Flash Player on the computer, download and install the latest install file from the following website:
» http://get.adobe.com/kr/flashplayer/

Resolving a PMS info transmission failure

If a data transfer failure message appears with a delay of three seconds or longer during communication between LSS and PMS,
resolve the issue according to the following steps.

"g Note

PMS (Property Management System) refers to a hotel room management system. The system connects to LSS to provide necessary information for

hotel room management.

1 Go to C:\HotelTVAhtdocs, which is the destination folder created in the C drive when LSS is installed.

#] Note
Assume that the path to the HOTELTV folder is the C drive.

) Double-click the cms.config file, or open the file in a memo pad.

3 Set pmswaittime and widgetwaittime to a value larger than 3, which is the default value. Save the file.

— The settings will be updated.

pmswaitt ime=3
widgetwaittime=3




Resolving a port conflict

If access to LSS is not available due to a port conflict, resolve the issue according to the following steps:
1 Goto C:\HotelTW\Server\Apache\conf, which is the destination folder created in the C drive when LSS is installed.

] Note
Assume that the path to the HOTELTV folder is the C drive.

) Double-click the httpd.conf file, or open the file in a memo pad.

Listen: &llows vou to bind &pache to specific |P addresses and/or
ports, instead of the default. See also the <¥irtualHost=
directive,

Change this to Listen on specific |P addresses as shown below to
prevent dpache from glomming onto all bound |P addresses.

#l {sten 34,56, 73:80

#
# Dynamic Shared Object (D50) Support

St

3 Change the Listen 80 value on row 46.

— Avalue within the range of 81 - 3029 can be entered.

4 Save the file, and restart the Apache server.

— The settings will be updated.

Speeding up the TV boot time

The TV boot speed may vary depending on the size of content included in LSS projects. If the boot speed is slow, enable the
Virtual Standby function on the TV while in factory mode. This will speed up the boot time. For details on Virtual Standby
settings, refer to the following:  » Checking the Virtual Standby settings

@ Note

If the Virtual Standby function is set to ON, power consumption can increase.



Resolving aTV time error

1 Goto C:\HotelTV, which is the destination folder created in the C drive when LSS is installed.

#) Note
Assume that the path to the HOTELTV folder is the C drive.

) Open the php.ini file.

3 Change "date.timezone="under [Date] to "date.timezone=continent/city" in the file.

nn

— Remove ";" in front of date.timezone.

fvﬁ Note

To find the time zone name for a continent/city, go to the following link. Select a continent from the link, and then select a city to set the time
zone. http://www.php.net/manual/en/timezones.php

Example The following is an example of the time zone set to Asia/Hong Kong.

:::::::::::::::::::

:::::::::::::::::::

[Date]

.J_D&u.uﬁ_t.hu.&ml_t_tmmu.el used by the date functions
date.timezone =AsiasHona_Kong

;date.default_latitude = 31.7EET
;date.default_longitude = 35, 2333

;date.sunrise_zenith = 90,583333
;date. sunset_zenith = 90, 583333

[
o f
it

ilter]
ilter.default = unsafe_raw
ilter.default_flags =

4 Save the php.ini file. Restart the computer or Apache to update the settings.



Troubleshooting

Resolving weather info errors

If the message "Network Not Available" appears after you save weather info settings, follow the below steps to resolve the issue:
1 Onthe PC, click the Start button, enter "cmd" in the run box, and then press Enter on the keyboard.

7 Enter "ping -n 1-w 1000 samsungmobile.accu-weather.com" in the cmd window.

3 Ifamessage appears that the requested time has expired or if the loss rate appears to be high, contact the Internet service
provider or check the Internet cable connections on your computer.

Resolving errors when running EPG Broker

If an issue occurs when you run EPG Broker, it is possible an anti-virus program caused a registry conflict when the LSS program
was installed. Disable firewalls, close anti-virus programs, and then install the LSS program again.

Disabling firewalls
1 From the PC, go to Start > Control Panel > Windows Firewall > Turn Windows Firewall on or off.

7 Select Turn off Windows Firewall (not recommended) under Home or work (private) network location settings.



Open Source
Announcement

To send inquiries and requests for questions regarding open sources, contact Samsung via Email (oss.request@samsung.com).

m This product uses some software programs which are distributed under the GPL/LGPL.

m This product uses some software programs which are distributed under the Codelgniter License.

GPL software: CUBRID
LGPL software : PHPExcel

GNU GENERAL PUBLIC LICENSE

Version 2, June 1991

Copyright (C) 1989, 1991 Free Software Foundation, Inc.
51 Franklin St, Fifth Floor, Boston, MA 02110-1301 USA

Everyone is permitted to copy and distribute verbatim copies of this license document, but changing it is not allowed.

Preamble

The licenses for most software are designed to take away your freedom to share and change it. By contrast, the GNU General
Public License is intended to guarantee your freedom to share and change free software--to make sure the software is free for all
its users. This General Public License applies to most of the Free Software Foundation's software and to any other program whose
authors commit to using it. (Some other Free Software Foundation software is covered by the GNU Library General Public License
instead.) You can apply it to your programs, too.

When we speak of free software, we are referring to freedom, not price. Our General Public Licenses are designed to make sure
that you have the freedom to distribute copies of free software (and charge for this service if you wish), that you receive source
code or can get it if you want it, that you can change the software or use pieces of it in new free programs; and that you know you
can do these things.

To protect your rights, we need to make restrictions that forbid anyone to deny you these rights or to ask you to surrender the
rights. These restrictions translate to certain responsibilities for you if you distribute copies of the software, or if you modify it. For
example, if you distribute copies of such a program, whether gratis or for a fee, you must give the recipients all the rights that you
have. You must make sure that they, too, receive or can get the source code. And you must show them these terms so they know
their rights.



We protect your rights with two steps:

(1) copyright the software, and (2) offer you this license which gives you legal permission to copy, distribute and/or modify
the software. Also, for each author's protection and ours, we want to make certain that everyone understands that there is no
warranty for this free software.

If the software is modified by someone else and passed on, we want its recipients to know that what they have is not the original,
so that any problems introduced by others will not reflect on the original authors' reputations.

Finally, any free program is threatened constantly by software patents.

We wish to avoid the danger that redistributors of a free program will individually obtain patent licenses, in effect making the
program proprietary. To prevent this, we have made it clear that any patent must be licensed for everyone's free use or not
licensed at all.

The precise terms and conditions for copying, distribution and modification follow.

TERMS AND CONDITIONS FOR COPYING, DISTRIBUTION AND MODIFICATION

0) This License applies to any program or other work which contains a notice placed by the copyright holder saying it may be
distributed under the terms of this General Public License. The “Program’, below, refers to any such program or work, and a “work
based on the Program” means either the Program or any derivative work under copyright law: that is to say, a work containing the
Program or a portion of it, either verbatim or with modifications and/or translated into another language. (Hereinafter, translation
is included without limitation in the term “modification”) Each licensee is addressed as “you".

Activities other than copying, distribution and modification are not covered by this License; they are outside its scope. The act of
running the Program is not restricted, and the output from the Program is covered only if its contents constitute a work based on
the Program (independent of having been made by running the Program). Whether that is true depends on what the Program
does.

1) You may copy and distribute verbatim copies of the Program’s source code as you receive it, in any medium, provided that you
conspicuously and appropriately publish on each copy an appropriate copyright notice and disclaimer of warranty; keep intact all
the notices that refer to this License and to the absence of any warranty; and give any other recipients of the Program a copy of
this License along with the Program. You may charge a fee for the physical act of transferring a copy, and you may at your option
offer warranty protection in exchange for a fee.

2) You may modify your copy or copies of the Program or any portion of it, thus forming a work based on the Program, and
copy and distribute such modifications or work under the terms of Section 1 above, provided that you also meet all of these
conditions:

a) You must cause the modified files to carry prominent notices stating that you changed the files and the date of any change.

b) You must cause any work that you distribute or publish, that in whole or in part contains or is derived from the Program or any
part thereof, to be licensed as a whole at no charge to all third parties under the terms of this License.

c) If the modified program normally reads commands interactively when run, you must cause it, when started running for such
interactive use in the most ordinary way, to print or display an announcement including an appropriate copyright notice and a

notice that there is no warranty (or else, saying that you provide a warranty) and that users may redistribute the program under
these conditions, and telling the user how to view a copy of this License. (Exception: if the Program itself is interactive but does

not normally print such an announcement, your work based on the Program is not required to print an announcement.)



These requirements apply to the modified work as a whole.

If identifiable sections of that work are not derived from the Program, and can be reasonably considered independent and
separate works in themselves, then this License, and its terms, do not apply to those sections when you distribute them as
separate works. But when you distribute the same sections as part of a whole which is a work based on the Program, the
distribution of the whole must be on the terms of this License, whose permissions for other licensees extend to the entire whole,
and thus to each and every part regardless of who wrote it.

Thus, it is not the intent of this section to claim rights or contest your rights to work written entirely by you; rather, the intent is to
exercise the right to control the distribution of derivative or collective works based on the Program.

In addition, mere aggregation of another work not based on the Program with the Program (or with a work based on the
Program) on a volume of a storage or distribution medium does not bring the other work under the scope of this License.

3) You may copy and distribute the Program (or a work based on it, under Section 2) in object code or executable form under the
terms of Sections 1 and 2 above provided that you also do one of the following:

a) Accompany it with the complete corresponding machine-readable source code, which must be distributed under the terms of
Sections 1 and 2 above on a medium customarily used for software interchange; or,

b) Accompany it with a written offer, valid for at least three years, to give any third party, for a charge no more than your cost
of physically performing source distribution, a complete machine-readable copy of the corresponding source code, to be
distributed under the terms of Sections 1 and 2 above on a medium customarily used for software interchange; or,

¢) Accompany it with the information you received as to the offer to distribute corresponding source code. (This alternative is
allowed only for noncommercial distribution and only if you received the program in object code or executable form with such
an offer, in accord with Subsection b above.)

The source code for a work means the preferred form of the work for making modifications to it. For an executable work,
complete source code means all the source code for all modules it contains, plus any associated interface definition files, plus
the scripts used to control compilation and installation of the executable. However, as a special exception, the source code
distributed need not include anything that is normally distributed (in either source or binary form) with the major components
(compiler, kernel, and so on) of the operating system on which the executable runs, unless that component itself accompanies
the executable.

If distribution of executable or object code is made by offering access to copy from a designated place, then offering equivalent
access to copy the source code from the same place counts as distribution of the source code, even though third parties are not
compelled to copy the source along with the object code.

4) You may not copy, modify, sublicense, or distribute the Program except as expressly provided under this License. Any attempt
otherwise to copy, modify, sublicense or distribute the Program is void, and will automatically terminate your rights under this
License. However, parties who have received copies, or rights, from you under this License will not have their licenses terminated
so long as such parties remain in full compliance.

5) You are not required to accept this License, since you have not signed it. However, nothing else grants you permission to
modify or distribute the Program or its derivative works. These actions are prohibited by law if you do not accept this License.
Therefore, by modifying or distributing the Program (or any work based on the Program), you indicate your acceptance of this
License to do so, and all its terms and conditions for copying, distributing or modifying the Program or works based onit.

6) Each time you redistribute the Program (or any work based on the Program), the recipient automatically receives a license
from the original licensor to copy, distribute or modify the Program subject to these terms and conditions. You may not impose
any further restrictions on the recipients’ exercise of the rights granted herein. You are not responsible for enforcing compliance
by third parties to this License.

7) If, as a consequence of a court judgment or allegation of patent infringement or for any other reason (not limited to patent
issues), conditions are imposed on you (whether by court order, agreement or otherwise) that contradict the conditions of this
License, they do not excuse you from the conditions of this License.



If you cannot distribute so as to satisfy simultaneously your obligations under this License and any other pertinent obligations,
then as a consequence you may not distribute the Program at all. For example, if a patent license would not permit royalty-free
redistribution of the Program by all those who receive copies directly or indirectly through you, then the only way you could
satisfy both it and this License would be to refrain entirely from distribution of the Program.

If any portion of this section is held invalid or unenforceable under any particular circumstance, the balance of the section is
intended to apply and the section as a whole is intended to apply in other circumstances.

It is not the purpose of this section to induce you to infringe any patents or other property right claims or to contest validity

of any such claims; this section has the sole purpose of protecting the integrity of the free software distribution system, which

is implemented by public license practices. Many people have made generous contributions to the wide range of software
distributed through that system in reliance on consistent application of that system; it is up to the author/donor to decide if he or
she is willing to distribute software through any other system and a licensee cannot impose that choice.

This section is intended to make thoroughly clear what is believed to be a consequence of the rest of this License.

8) If the distribution and/or use of the Program is restricted in certain countries either by patents or by copyrighted interfaces,
the original copyright holder who places the Program under this License may add an explicit geographical distribution limitation
excluding those countries, so that distribution is permitted only in or among countries not thus excluded. In such case, this
License incorporates the limitation as if written in the body of this License.

9) The Free Software Foundation may publish revised and/or new versions of the General Public License from time to time. Such
new versions will be similar in spirit to the present version, but may differ in detail to address new problems or concerns.

Each version is given a distinguishing version number. If the Program specifies a version number of this License which applies to
it and “any later version’, you have the option of following the terms and conditions either of that version or of any later version
published by the Free Software Foundation.

If the Program does not specify a version number of this License, you may choose any version ever published by the Free
Software Foundation.

10) If you wish to incorporate parts of the Program into other free programs whose distribution conditions are different, write to
the author to ask for permission. For software which is copyrighted by the Free Software Foundation, write to the Free Software
Foundation; we sometimes make exceptions for this. Our decision will be guided by the two goals of preserving the free status of
all derivatives of our free software and of promoting the sharing and reuse of software generally.

NO WARRANTY

11) BECAUSE THE PROGRAM IS LICENSED FREE OF CHARGE, THERE IS NO WARRANTY FOR THE PROGRAM, TO THE EXTENT
PERMITTED BY APPLICABLE LAW. EXCEPT WHEN OTHERWISE STATED IN WRITING THE COPYRIGHT HOLDERS AND/OR OTHER
PARTIES PROVIDE THE PROGRAM “AS IS"WITHOUT WARRANTY OF ANY KIND, EITHER EXPRESSED OR IMPLIED, INCLUDING, BUT
NOT LIMITED TO, THE IMPLIED WARRANTIES OF MERCHANTABILITY AND FITNESS FOR A PARTICULAR PURPOSE. THE ENTIRE
RISK AS TO THE QUALITY AND PERFORMANCE OF THE PROGRAM IS WITH YOU. SHOULD THE PROGRAM PROVE DEFECTIVE, YOU
ASSUME THE COST OF ALL NECESSARY SERVICING, REPAIR OR CORRECTION.

12) IN NO EVENT UNLESS REQUIRED BY APPLICABLE LAW OR AGREED TO IN WRITING WILL ANY COPYRIGHT HOLDER, OR

ANY OTHER PARTY WHO MAY MODIFY AND/OR REDISTRIBUTE THE PROGRAM AS PERMITTED ABOVE, BE LIABLE TO YOU FOR
DAMAGES, INCLUDING ANY GENERAL, SPECIAL, INCIDENTAL OR CONSEQUENTIAL DAMAGES ARISING OUT OF THE USE OR
INABILITY TO USE THE PROGRAM (INCLUDING BUT NOT LIMITED TO LOSS OF DATA OR DATA BEING RENDERED INACCURATE OR
LOSSES SUSTAINED BY YOU OR THIRD PARTIES OR A FAILURE OF THE PROGRAM TO OPERATE WITH ANY OTHER PROGRAMS), EVEN
IF SUCH HOLDER OR OTHER PARTY HAS BEEN ADVISED OF THE POSSIBILITY OF SUCH DAMAGES.

END OF TERMS AND CONDITIONS



How to Apply These Terms to Your New Programs

If you develop a new program, and you want it to be of the greatest possible use to the public, the best way to achieve this is to
make it free software which everyone can redistribute and change under these terms.

To do so, attach the following notices to the program. It is safest to attach them to the start of each source file to most effectively
convey the exclusion of warranty; and each file should have at least the “copyright” line and a pointer to where the full notice is
found.

<one line to give the program's name and a brief idea of what it does.>

Copyright (C) <year> <name of author>

This program is free software; you can redistribute it and/or modify it under the terms of the GNU General Public License as
published by the Free Software Foundation; either version 2 of the License, or(at your option) any later version.

This program is distributed in the hope that it will be useful, but WITHOUT ANY WARRANTY; without even the implied warranty of
MERCHANTABILITY or FITNESS FOR A PARTICULAR PURPOSE.

See the GNU General Public License for more details.

You should have received a copy of the GNU General Public License along with this program; if not, write to the Free Software
Foundation, Inc., 51 Franklin St, Fifth Floor, Boston, MA 02110-1301 USA.

Also add information on how to contact you by electronic and paper mail.

If the program is interactive, make it output a short notice like this when it starts in an interactive mode:

Gnomovision version 69, Copyright (C) year name of author Gnomovision comes with ABSOLUTELY NO WARRANTY; for details
type ‘show w.

This is free software, and you are welcome to redistribute it under certain conditions; type ‘show c’for details.

The hypothetical commands ‘show w’and ‘show ¢’ should show the appropriate parts of the General Public License. Of course, the
commands you use may be called something other than ‘show w’and ‘show c’; they could even be mouse-clicks or menu items--
whatever suits your program.

You should also get your employer (if you work as a programmer) or your school, if any, to sign a “copyright disclaimer” for the
program, if necessary. Here is a sample; alter the names:

Yoyodyne, Inc., hereby disclaims all copyright interest in the program ‘Gnomovision’ (which makes passes at compilers) written by
James Hacker.

<signature of Ty Coon>, 1 April 1989

Ty Coon, President of Vice



This General Public License does not permit incorporating your program into proprietary programs.

If your program is a subroutine library, you may consider it more useful to permit linking proprietary applications with the library.
If this is what you want to do, use the GNU Lesser General Public License instead of this License

GNU LESSER GENERAL PUBLIC LICENSE

Version 2.1, February 1999

Copyright (C) 1991, 1999 Free Software Foundation, Inc.
51 Franklin Street, Fifth Floor, Boston, MA 02110-1301 USA

Everyone is permitted to copy and distribute verbatim copies of this license document, but changing it is not allowed.

[This is the first released version of the Lesser GPL. It also counts as the successor of the GNU Library Public License, version 2,
hence the version number 2.1.]

Preamble

The licenses for most software are designed to take away your freedom to share and change it. By contrast, the GNU General
Public Licenses are intended to guarantee your freedom to share and change free software--to make sure the software is free for
all its users.

This license, the Lesser General Public License, applies to some specially designated software packages--typically libraries--of

the Free Software Foundation and other authors who decide to use it. You can use it too, but we suggest you first think carefully
about whether this license or the ordinary General Public License is the better strategy to use in any particular case, based on the
explanations below.

When we speak of free software, we are referring to freedom of use, not price. Our General Public Licenses are designed to make
sure that you have the freedom to distribute copies of free software (and charge for this service if you wish); that you receive
source code or can get it if you want it; that you can change the software and use pieces of it in new free programs; and that you
are informed that you can do these things.

To protect your rights, we need to make restrictions that forbid distributors to deny you these rights or to ask you to surrender
these rights. These restrictions translate to certain responsibilities for you if you distribute copies of the library or if you modify it.

For example, if you distribute copies of the library, whether gratis or for a fee, you must give the recipients all the rights that we
gave you. You must make sure that they, too, receive or can get the source code.

If you link other code with the library, you must provide complete object files to the recipients, so that they can relink them with
the library after making changes to the library and recompiling it. And you must show them these terms so they know their
rights.

We protect your rights with a two-step method: (1) we copyright the library, and (2) we offer you this license, which gives you
legal permission to copy, distribute and/or modify the library.

To protect each distributor, we want to make it very clear that there is no warranty for the free library.

Also, if the library is modified by someone else and passed on, the recipients should know that what they have is not the original
version, so that the original author's reputation will not be affected by problems that might be introduced by others.

Finally, software patents pose a constant threat to the existence of any free program. We wish to make sure that a company
cannot effectively restrict the users of a free program by obtaining a restrictive license from a patent holder. Therefore, we insist
that any patent license obtained for a version of the library must be consistent with the full freedom of use specified in this
license.



Most GNU software, including some libraries, is covered by the ordinary GNU General Public License.

This license, the GNU Lesser General Public License, applies to certain designated libraries, and is quite different from the ordinary
General Public License. We use this license for certain libraries in order to permit linking those libraries into non-free programs.

When a program is linked with a library, whether statically or using a shared library, the combination of the two is legally speaking
a combined work, a derivative of the original library. The ordinary General Public License therefore permits such linking only if the
entire combination fits its criteria of freedom. The Lesser General Public License permits more lax criteria for linking other code
with the library.

We call this license the “Lesser” General Public License because it does Less to protect the user's freedom than the ordinary
General Public License. It also provides other free software developers Less of an advantage over competing non-free programs.
These disadvantages are the reason we use the ordinary General Public License for many libraries. However, the Lesser license
provides advantages in certain special circumstances.

For example, on rare occasions, there may be a special need to encourage the widest possible use of a certain library, so that it
becomes a de-facto standard. To achieve this, non-free programs must be allowed to use the library. A more frequent case is that
a free library does the same job as widely used non-free libraries. In this case, there is little to gain by limiting the free library to
free software only, so we use the Lesser General Public License.

In other cases, permission to use a particular library in non-free programs enables a greater number of people to use a large body
of free software. For example, permission to use the GNU C Library in non-free programs enables many more people to use the
whole GNU operating system, as well as its variant, the GNU/Linux operating system.

Although the Lesser General Public License is Less protective of the users’ freedom, it does ensure that the user of a program that
is linked with the Library has the freedom and the wherewithal to run that program using a modified version of the Library.

The precise terms and conditions for copying, distribution and modification follow. Pay close attention to the difference between
a“work based on the library” and a “work that uses the library”. The former contains code derived from the library, whereas the
latter must be combined with the library in order to run.

TERMS AND CONDITIONS FOR COPYING, DISTRIBUTION AND MODIFICATION

0) This License Agreement applies to any software library or other program which contains a notice placed by the copyright
holder or other authorized party saying it may be distributed under the terms of this Lesser General Public License (also called
“this License”). Each licensee is addressed as “you’”.

A“library” means a collection of software functions and/or data prepared so as to be conveniently linked with application
programs (which use some of those functions and data) to form executables.

The “Library’, below, refers to any such software library or work which has been distributed under these terms. A “work based
on the Library” means either the Library or any derivative work under copyright law: that is to say, a work containing the Library
or a portion of it, either verbatim or with modifications and/or translated straightforwardly into another language. (Hereinafter,
translation is included without limitation in the term “modification”)

“Source code” for a work means the preferred form of the work for making modifications to it. For a library, complete source code
means all the source code for all modules it contains, plus any associated interface definition files, plus the scripts used to control
compilation and installation of the library.

Activities other than copying, distribution and modification are not covered by this License; they are outside its scope. The act of
running a program using the Library is not restricted, and output from such a program is covered only if its contents constitute

a work based on the Library (independent of the use of the Library in a tool for writing it). Whether that is true depends on what
the Library does and what the program that uses the Library does.

1) You may copy and distribute verbatim copies of the Library’s complete source code as you receive it, in any medium, provided
that you conspicuously and appropriately publish on each copy an appropriate copyright notice and disclaimer of warranty; keep
intact all the notices that refer to this License and to the absence of any warranty; and distribute a copy of this License along with



the Library.

You may charge a fee for the physical act of transferring a copy, and you may at your option offer warranty protection in exchange
for a fee.

2) You may modify your copy or copies of the Library or any portion of it, thus forming a work based on the Library, and copy and
distribute such modifications or work under the terms of Section 1 above, provided that you also meet all of these conditions:

a) The modified work must itself be a software library.
b) You must cause the files modified to carry prominent notices stating that you changed the files and the date of any change.
¢) You must cause the whole of the work to be licensed at no charge to all third parties under the terms of this License.

d) If afacility in the modified Library refers to a function or a table of data to be supplied by an application program that uses
the facility, other than as an argument passed when the facility is invoked, then you must make a good faith effort to ensure that,
in the event an application does not supply such function or table, the facility still operates, and performs whatever part of its
purpose remains meaningful. (For example, a function in a library to compute square roots has a purpose that is entirely well-
defined independent of the application. Therefore, Subsection 2d requires that any application-supplied function or table used
by this function must be optional: if the application does not supply it, the square root function must still compute square roots.)
These requirements apply to the modified work as a whole. If identifiable sections of that work are not derived from the Library,
and can be reasonably considered independent and separate works in themselves, then this License, and its terms, do not apply
to those sections when you distribute them as separate works.

But when you distribute the same sections as part of a whole which is a work based on the Library, the distribution of the whole
must be on the terms of this License, whose permissions for other licensees extend to the entire whole, and thus to each and
every part regardless of who wrote it. Thus, it is not the intent of this section to claim rights or contest your rights to work written
entirely by you; rather, the intent is to exercise the right to control the distribution of derivative or collective works based on the
Library. In addition, mere aggregation of another work not based on the Library with the Library (or with a work based on the
Library) on a volume of a storage or distribution medium does not bring the other work under the scope of this License.

3) You may opt to apply the terms of the ordinary GNU General Public License instead of this License to a given copy of the
Library. To do this, you must alter all the notices that refer to this License, so that they refer to the ordinary GNU General Public
License, version 2, instead of to this License. (If a newer version than version 2 of the ordinary GNU General Public License

has appeared, then you can specify that version instead if you wish.) Do not make any other change in these notices. Once
this change is made in a given copy, it is irreversible for that copy, so the ordinary GNU General Public License applies to all
subsequent copies and derivative works made from that copy.

This option is useful when you wish to copy part of the code of the Library into a program that is not a library.

4) You may copy and distribute the Library (or a portion or derivative of it, under Section 2) in object code or executable form
under the terms of Sections 1 and 2 above provided that you accompany it with the complete corresponding machine-readable
source code, which must be distributed under the terms of Sections 1 and 2 above on a medium customarily used for software
interchange.

If distribution of object code is made by offering access to copy from a designated place, then offering equivalent access to copy
the source code from the same place satisfies the requirement to distribute the source code, even though third parties are not
compelled to copy the source along with the object code.

5) A program that contains no derivative of any portion of the Library, but is designed to work with the Library by being
compiled or linked with it, is called a “work that uses the Library”. Such a work, in isolation, is not a derivative work of the Library,
and therefore falls outside the scope of this License.

However, linking a “work that uses the Library” with the Library creates an executable that is a derivative of the Library (because it
contains portions of the Library), rather than a “work that uses the library”.

The executable is therefore covered by this License. Section 6 states terms for distribution of such executables.

When a “work that uses the Library” uses material from a header file that is part of the Library, the object code for the work may
be a derivative work of the Library even though the source code is not. Whether this is true is especially significant if the work can



be linked without the Library, or if the work is itself a library. The threshold for this to be true is not precisely defined by law.

If such an object file uses only numerical parameters, data structure layouts and accessors, and small macros and small inline
functions (ten lines or less in length), then the use of the object file is unrestricted, regardless of whether it is legally a derivative
work. (Executables containing this object code plus portions of the Library will still fall under Section 6.)

Otherwise, if the work is a derivative of the Library, you may distribute the object code for the work under the terms of Section 6.
Any executables containing that work also fall under Section 6, whether or not they are linked directly with the Library itself.

6) As an exception to the Sections above, you may also combine or link a“work that uses the Library” with the Library to produce
a work containing portions of the Library, and distribute that work under terms of your choice, provided that the terms permit
modification of the work for the customer’s own use and reverse engineering for debugging such modifications.

You must give prominent notice with each copy of the work that the Library is used in it and that the Library and its use are
covered by this License. You must supply a copy of this License. If the work during execution displays copyright notices, you must
include the copyright notice for the Library among them, as well as a reference directing the user to the copy of this License. Also,
you must do one of these things:

a) Accompany the work with the complete corresponding machine-readable source code for the Library including whatever
changes were used in the work (which must be distributed under Sections 1 and 2 above); and, if the work is an executable linked
with the Library, with the complete machine-readable “work that uses the Library", as object code and/or source code, so that the
user can modify the Library and then relink to produce a modified executable containing the modified Library. (It is understood
that the user who changes the contents of definitions files in the Library will not necessarily be able to recompile the application
to use the modified definitions.)

b) Use a suitable shared library mechanism for linking with the Library. A suitable mechanism is one that (1) uses at run time a
copy of the library already present on the user’s computer system, rather than copying library functions into the executable, and
(2) will operate properly with a modified version of the library, if the user installs one, as long as the modified version is interface-
compatible with the version that the work was made with.

¢) Accompany the work with a written offer, valid for at least three years, to give the same user the materials specified in
Subsection 6a, above, for a charge no more than the cost of performing this distribution.

d) If distribution of the work is made by offering access to copy from a designated place, offer equivalent access to copy the
above specified materials from the same place.

e) Verify that the user has already received a copy of these materials or that you have already sent this user a copy. For an
executable, the required form of the “work that uses the Library” must include any data and utility programs needed for
reproducing the executable from it. However, as a special exception, the materials to be distributed need not include anything
that is normally distributed (in either source or binary form) with the major components (compiler, kernel, and so on) of the
operating system on which the executable runs, unless that component itself accompanies the executable.

It may happen that this requirement contradicts the license restrictions of other proprietary libraries that do not normally
accompany the operating system. Such a contradiction means you cannot use both them and the Library together in an
executable that you distribute.

7) You may place library facilities that are a work based on the Library side-by-side in a single library together with other library
facilities not covered by this License, and distribute such a combined library, provided that the separate distribution of the work
based on the Library and of the other library facilities is otherwise permitted, and provided that you do these two things:

a) Accompany the combined library with a copy of the same work based on the Library, uncombined with any other library
facilities. This must be distributed under the terms of the Sections above.

b) Give prominent notice with the combined library of the fact that part of it is a work based on the Library, and explaining where
to find the accompanying uncombined form of the same work.

8) You may not copy, modify, sublicense, link with, or distribute the Library except as expressly provided under this License. Any
attempt otherwise to copy, modify, sublicense, link with, or distribute the Library is void, and will automatically terminate your
rights under this License. However, parties who have received copies, or rights, from you under this License will not have their
licenses terminated so long as such parties remain in full compliance.



9) You are not required to accept this License, since you have not signed it. However, nothing else grants you permission to
modify or distribute the Library or its derivative works. These actions are prohibited by law if you do not accept this License.
Therefore, by modifying or distributing the Library (or any work based on the Library), you indicate your acceptance of this
License to do so, and all its terms and conditions for copying, distributing or modifying the Library or works based on it.

10) Each time you redistribute the Library (or any work based on the Library), the recipient automatically receives a license from
the original licensor to copy, distribute, link with or modify the Library subject to these terms and conditions. You may not impose
any further restrictions on the recipients’ exercise of the rights granted herein. You are not responsible for enforcing compliance
by third parties with this License.

11) If, as a consequence of a court judgment or allegation of patent infringement or for any other reason (not limited to patent
issues), conditions are imposed on you (whether by court order, agreement or otherwise) that contradict the conditions of this
License, they do not excuse you from the conditions of this License. If you cannot distribute so as to satisfy simultaneously your
obligations under this License and any other pertinent obligations, then as a consequence you may not distribute the Library
at all. For example, if a patent license would not permit royalty-free redistribution of the Library by all those who receive copies
directly or indirectly through you, then the only way you could satisfy both it and this License would be to refrain entirely from
distribution of the Library. If any portion of this section is held invalid or unenforceable under any particular circumstance, the
balance of the section is intended to apply, and the section as a whole is intended to apply in other circumstances.

It is not the purpose of this section to induce you to infringe any patents or other property right claims or to contest validity

of any such claims; this section has the sole purpose of protecting the integrity of the free software distribution system which

is implemented by public license practices. Many people have made generous contributions to the wide range of software
distributed through that system in reliance on consistent application of that system; it is up to the author/donor to decide if he or
she is willing to distribute software through any other system and a licensee cannot impose that choice. This section is intended
to make thoroughly clear what is believed to be a consequence of the rest of this License.

12) If the distribution and/or use of the Library is restricted in certain countries either by patents or by copyrighted interfaces,
the original copyright holder who places the Library under this License may add an explicit geographical distribution limitation
excluding those countries, so that distribution is permitted only in or among countries not thus excluded. In such case, this
License incorporates the limitation as if written in the body of this License.

13) The Free Software Foundation may publish revised and/or new versions of the Lesser General Public License from time
to time. Such new versions will be similar in spirit to the present version, but may differ in detail to address new problems or
concerns.

Each version is given a distinguishing version number. If the Library specifies a version number of this License which applies to

it and “any later version’, you have the option of following the terms and conditions either of that version or of any later version
published by the Free Software Foundation. If the Library does not specify a license version number, you may choose any version
ever published by the Free Software Foundation.

14) If you wish to incorporate parts of the Library into other free programs whose distribution conditions are incompatible with
these, write to the author to ask for permission. For software which is copyrighted by the Free Software Foundation, write to the
Free Software Foundation; we sometimes make exceptions for this. Our decision will be guided by the two goals of preserving
the free status of all derivatives of our free software and of promoting the sharing and reuse of software generally.

NO WARRANTY

15) BECAUSE THE LIBRARY IS LICENSED FREE OF CHARGE, THERE IS NO WARRANTY FOR THE LIBRARY, TO THE EXTENT PERMITTED
BY APPLICABLE LAW. EXCEPT WHEN OTHERWISE STATED IN WRITING THE COPYRIGHT HOLDERS AND/OR OTHER PARTIES PROVIDE
THE LIBRARY “AS IS"WITHOUT WARRANTY OF ANY KIND, EITHER EXPRESSED OR IMPLIED, INCLUDING, BUT NOT LIMITED TO, THE
IMPLIED WARRANTIES OF MERCHANTABILITY AND FITNESS FOR A PARTICULAR PURPOSE. THE ENTIRE RISK AS TO THE QUALITY
AND PERFORMANCE OF THE LIBRARY IS WITH YOU. SHOULD THE LIBRARY PROVE DEFECTIVE, YOU ASSUME THE COST OF ALL
NECESSARY SERVICING, REPAIR OR CORRECTION.

16) IN NO EVENT UNLESS REQUIRED BY APPLICABLE LAW OR AGREED TO IN WRITING WILL ANY COPYRIGHT HOLDER, OR ANY
OTHER PARTY WHO MAY MODIFY AND/OR REDISTRIBUTE THE LIBRARY AS PERMITTED ABOVE, BE LIABLE TO YOU FOR DAMAGES,



INCLUDING ANY GENERAL, SPECIAL, INCIDENTAL OR CONSEQUENTIAL DAMAGES ARISING OUT OF THE USE OR INABILITY TO USE
THE LIBRARY (INCLUDING BUT NOT LIMITED TO LOSS OF DATA OR DATA BEING RENDERED INACCURATE OR LOSSES SUSTAINED
BY YOU ORTHIRD PARTIES OR A FAILURE OF THE LIBRARY TO OPERATE WITH ANY OTHER SOFTWARE), EVEN IF SUCH HOLDER OR
OTHER PARTY HAS BEEN ADVISED OF THE POSSIBILITY OF SUCH DAMAGES.

END OF TERMS AND CONDITIONS

How to Apply These Terms to Your New Libraries

If you develop a new library, and you want it to be of the greatest possible use to the public, we recommend making it
free software that everyone can redistribute and change. You can do so by permitting redistribution under these terms (or,
alternatively, under the terms of the ordinary General Public License).

To apply these terms, attach the following notices to the library. It is safest to attach them to the start of each source file to most
effectively convey the exclusion of warranty; and each file should have at least the “copyright”line and a pointer to where the full
notice is found.

one line to give the library’s name and an idea of what it does.

Copyright (C) year name of author

This library is free software; you can redistribute it and/or modify it under the terms of the GNU Lesser General Public License as
published by the Free Software Foundation; either version 2.1 of the License, or (at your option) any later version.

This library is distributed in the hope that it will be useful, but WITHOUT ANY WARRANTY; without even the implied warranty of
MERCHANTABILITY or FITNESS FOR A PARTICULAR PURPOSE.

See the GNU Lesser General Public License for more details.

You should have received a copy of the GNU Lesser General Public License along with this library; if not, write to the Free Software
Foundation, Inc., 51 Franklin Street, Fifth Floor, Boston, MA 02110-1301 USA.

Also add information on how to contact you by electronic and paper mail.

You should also get your employer (if you work as a programmer) or your school, if any, to sign a “copyright disclaimer” for the
library, if necessary. Here is a sample; alter the names:

Yoyodyne, Inc., hereby disclaims all copyright interest in the library ‘Frob’ (a library for tweaking knobs) written by James Random
Hacker.

Signature of Ty Coon, 1 April 1990 Ty Coon, President of Vice

That's all there is to it!

Codelgniter License Agreement



Copyright (c) 2008 - 2014, EllisLab, Inc.

All rights reserved.

This license is a legal agreement between you and EllisLab Inc. for the use of Codelgniter Software (the "Software"). By obtaining
the Software you agree to comply with the terms and conditions of this license.

Permitted Use

You are permitted to use, copy, modify, and distribute the Software and its documentation, with or without modification, for any
purpose, provided that the following conditions are met:

A copy of this license agreement must be included with the distribution.
Redistributions of source code must retain the above copyright notice in all source code files.

Redistributions in binary form must reproduce the above copyright notice in the documentation and/or other materials provided
with the distribution.

Any files that have been modified must carry notices stating the nature of the change and the names of those who changed
them.

Products derived from the Software must include an acknowledgment that they are derived from Codelgniter in their
documentation and/or other materials provided with the distribution.

Products derived from the Software may not be called "Codelgniter", nor may "Codelgniter" appear in their name, without prior
written permission from EllisLab, Inc.

Indemnity

You agree to indemnify and hold harmless the authors of the Software and any contributors for any direct, indirect, incidental, or
consequential third-party claims, actions or suits, as well as any related expenses, liabilities, damages, settlements or fees arising
from your use or misuse of the Software, or a violation of any terms of this license.

Disclaimer of Warranty

THE SOFTWARE IS PROVIDED "AS IS", WITHOUT WARRANTY OF ANY KIND, EXPRESSED OR IMPLIED, INCLUDING, BUT NOT LIMITED
TO, WARRANTIES OF QUALITY, PERFORMANCE, NON-INFRINGEMENT, MERCHANTABILITY, OR FITNESS FOR A PARTICULAR
PURPOSE.

Limitations of Liability

YOU ASSUME ALL RISK ASSOCIATED WITH THE INSTALLATION AND USE OF THE SOFTWARE. IN NO EVENT SHALL THE AUTHORS
OR COPYRIGHT HOLDERS OF THE SOFTWARE BE LIABLE FOR CLAIMS, DAMAGES OR OTHER LIABILITY ARISING FROM, OUT OF, OR
IN CONNECTION WITH THE SOFTWARE. LICENSE HOLDERS ARE SOLELY RESPONSIBLE FOR DETERMINING THE APPROPRIATENESS
OF USE AND ASSUME ALL RISKS ASSOCIATED WITH ITS USE, INCLUDING BUT NOT LIMITED TO THE RISKS OF PROGRAM ERRORS,
DAMAGE TO EQUIPMENT, LOSS OF DATA OR SOFTWARE PROGRAMS, OR UNAVAILABILITY OR INTERRUPTION OF OPERATIONS.
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